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Preface

Congratulations on buying this bool. Oh, wait a minute—perhaps you haven’t
yet. Perhaps you’ve just picked up the book in your local bookshop, and are trying
to decide whether it’s right for you. Why should this be the book that makes it
into your shopping basket? The answer can be found in the title of the book: it’s
all about getting things right the first time, not learning bad habits—bad habits
that you have to un-learn at a later date—for the purposes of getting a quick
result.

Let’s take a step back for a moment, and look at another skill that many people
learn at some point in their lives: learning to drive. Apologies if that particular
experience is also new to you, but stick with me. For many people, first driving
lessons can be very confusing—you’ve got to figure out which pedals to press, in
what order, and manage to get out of the driving school car park without hitting
the other students. Meanwhile, other more experienced people just get into their
cars, start the engine, and drive from A to B without even really thinking about
what they’re doing. These drivers may have picked up a few bad habits along the
way, but if they learned with a proper driving instructor, the chances are that
they were taught properly from the beginning, following a strict set of rules and
guidelines to ensure they stay safe.

The driving instructor tells you to check your mirrors diligently, observe speed
limits, and avoid cutting corners (literally as well as metaphorically!). Imagine,
though, if the instructor told you not to worry about the speed limit signs, to
“put your foot down” because the road is clear, or told you that the one-way sign
“wasn’t all that important at that time of night.” It’d be a miracle if you passed
your driving test, and the chances are that those bad habits would stay with you
(so long as you could manage to keep your license).

Learning to build web pages can be a bit like that.

I've been designing and building web sites for around eight years now, but I can
clearly remember the joy of creating my first site. Admittedly, in hindsight, it
was a pretty nasty-looking web site, but it achieved the goal at the time—I had
published something, and I was able to create it with the bare minimum of tools.
It gave me an enormous sense of achievement, and made me want to learn more
and create even better web sites.

At the time, there weren’t that many books that really seemed to what I wanted,
but I lapped up everything I could find, learning some tricks from books, and
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getting other ideas from visiting web sites. But then I discovered that I'd been
doing it all wrong. The books I had learned from had given me what later turned
out to be poor advice, and the web sites I’d visited had themselves learnt from
the same sources and made use of similar bad techniques. So, what had gone
wrong?

In the early days of the web, when people first started properly to embrace the
technology, to publish homepages, and to develop online corporate presences for
their companies, they all realized fairly quickly that the medium was quite limiting.
Necessity is the mother of invention, though. People began to coax out of their
web pages tricks and displays that were never intended by the technologies they
used, and the browsers helped them along the way by adding features that offered
even more opportunities for this kind of behavior.

Numerous books have been written on the topics of web design and programming,
as have many free tutorials that you can read on the 'Net. Many of them were
written during those heady years, and were based on what seemed like best
practices back then, but their authors were constrained by browsers that often
rendered the same well-designed pages in vastly different ways. This meant that
the tutorials’ authors needed to resort to abusing various features of those
browsers, such as using data tables to lay out pages. This certainly got many
people building their first web pages, but it ensured that bad habits were ingrained
at an early stage, and many people are still using these bad practices years later.

Web developers the world over have learnt bad habits (myself included) and
must now try to un-learn them all. There’s no longer a need for these prac-
tices—they often produce pages that are inflexible, slow to download, and difficult
to maintain, but like the badly taught driver who insists on flouting the rules
because it’s worked for him so far, many developers find those outdated habits
difficult to break.

I saw the light many years ago, and have tried to educate as many people as
possible since. But for the eager beginner, those same old books are still peddling
the same bad old ideas. This just has to stop. And it stops now.

You’re not going to learn any bad habits in this book. Not one.

In this book, you’ll learn the right way to do things. If there’s a wrong way to do
things—a way that cuts corners to save time but encourages bad techniques—we
won’t even tell you about it. Not even as a “by the way, you might try this...”
You won’t need to avert your eyes—we’ll take care of that for you!

xiv Order the print version of this book to get all 500+ pages!
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What is a Browser?

What is a Browser?

If you use Microsoft Windows, the browser is probably what you know as the
“little blue e on the desktop” (shown in Figure 1), but is commonly called Internet
Explorer. The majority of people don’t stray beyond using this program for the
purposes of viewing web pages—for many, Internet Explorer is the Internet.

Figure 1. Internet Explorer—the “little blue e on the desktop”

-

Internet Explorer (or IE, as we’ll refer to it from now on) is the most commonly
used browser, largely because Microsoft included it as part of the Windows oper-
ating system as far back as Windows 95 (this was later to come back and haunt
Microsoft—it became the catalyst for a massive anti-trust trial which ruled that
the company had stifled competition by bundling IE with the operating system
to the exclusion of all others).

However, there are other browsers that you can use instead of IE. Currently riding
an ever-increasing wave of popularity is Firefox,' a small, speedy program that
has a number of attractive features that aren’t available in IE (at the time of
writing), and handles the features of some web pages better than IE can. It’s also
available for Windows, Mac OS X, and Linux, while the latest versions of IE are
only available for Windows. The screen shots you’ll see in this book were taken
using Firefox on Windows XP, unless stated otherwise. We recommend that you
download a copy of Firefox for the purposes of working through the exercises in
this book.

Alternatively, you might like to try another browser that supports web standards
well—check out BrovvseHappy2 for some more ideas.

Not interested in a different browser? Well, you can use IE, as indeed the majority
of web users still do. In fact, you can be sure that everything you read here will
work in all recent browsers without any real hiccups.

! http//www.mozilla.com/firefox/
2 http://browsehappy.com/
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Who Should Read this Book?

Does this sound like you?
[ an absolute beginner—at least as far as creating web pages goes
[ confident with using a computer, but not necessarily a “power user”

@ someone who uses the Web a lot, enjoys other people’s web sites, and would
like to create your own

Perhaps you have a hobby that you want to tell the world about, or you want
to start a web site for a community that you belong to (be that a knitting
circle or remote-control car racing club)

@ quickly put off by the techno-babble that computer people tend to speak

When you have conversations with your more tech-savvy relatives about a
problem you’re having with your computer—perhaps you’ve been struck down
by a computer virus—do you find a lot of the jargon goes over your head?

[ perhaps a little daunted about learning this new skill, but keen to learn (with
some friendly hand-holding)

If any of the above descriptions strikes a chord with you, then this is the book
to put in your shopping cart—we’ll ease you in gently, and have you building
web pages like a pro in no time!

Don’t worry if you don’t understand the terminology that your 15-year-old
nephew (or cousin!) keeps spouting when you ask him about building web sites.
I’'ve assumed no prior knowledge of any of these terms, and I'll be guiding you
all the way through the process of creating a web site from scratch. By the end
of this book, you’ll know how to build the site, how to secure hosting, how to
promote the site, and how to keep it running once it’s live.

The best part is this: what you learn in this book, you’ll never have to un-learn.
You’ll be learning how to build sites the right way from the get-go.
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What you’ll Learn from this Book

By the time that you finish reading this book, and trying out the exercises con-
tained within, you'll be able to build a complete web site—the right way—without
incurring any costs for expensive software or web hosting.

Using an example web site, I'll guide you through the process of developing web
pages from scratch. From these humble beginnings, great things will evolve! By
the end of the book, you’ll be able to create a web site that includes the following
features:

1 easy-to-use navigation

@ a professional-looking site header

[ a regularly updated news/events section

@ a “Contact Us” page

@ tables—the presentation of data in neatly organized grids

[ attractive forms

@ a simple image gallery

@ a search engine that covers our site, as well as related sites

@ simple statistics that you can use to see who’s using your site, how they found
your site (e.g. from search engines), and so on

You’ll also learn how to manage your web site effectively, without it becoming a
chore or getting too technical. I'll show you how you can:

O Get your own dot-com (or dot-net or dot-org) web address.
@ Find somewhere to host your web site.
@ Upload your files to your web site.

[ Get feedback from visitors while avoiding spam emails.

Order the print version of this book to get all 500+ pages! xvii



http://www.sitepoint.com/launch/81f2b9

Preface

How you’ll Learn to Build your Web Site

This book will take you through each new topic using a step-by-step approach.
It provides a mixture of examples and practical exercises that will soon have you
feeling confident enough to try a little HTML for yourself.

HTML, Markup, CSS... Welcome to your First Bits
of Jargon!

From here on in, you’re going to see these phrases more and more. But what do
they mean?

HTML HTML stands for HyperText Markup Language. It’s the primary lan-
guage that’s used to create web pages, so you’ll come to know it very
well through the course of this book. We’ll be using the latest version
of HTML, which is called XHTML.

markup Imagine, if you will, that you’re a newspaper editor. You've been passed
a news story, but the text—from the heading through to the conclu-
sion—is all the same size, and the headings, paragraphs, quotes, and
other features of the text are not clearly indicated. It’s just one big
block of text. For starters, you’d probably want to emphasize the
headline, maybe by displaying it in bold or italic text (or in all caps
with an exclamation mark if you were working for a tabloid). As an
editor, you’d probably grab a pen and start scribbling annotations on
the print-out—an “h” here to signify a heading, “p”s here, there, and

everywhere to show where paragraphs start and end, and “q”s to denote
quotations.

This is essentially what markup is—a set of simple tags that suggest
the structure of a document (this section is a heading, paragraph, a
quote, etc.). We’ll cover the various tags that HITML uses in detail a
little later.

Markup isn’t Computer Code

hote
Markup is not the same thing as “code.” Often, people incorrectly
refer to markup as code, but code goes beyond the basic abilities
of markup. With code, you can create programs, and do more
dynamic things with your web page, while markup simply deals
with the page’s structure. So, if you want to impress your friends
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and relatives, refer to markup rather than code. See, we told you
we’d teach you good habits!

CSS CSS stands for Cascading Style Sheets. We’ll be using a combination
of HTML and CSS to create web sites. CSS is a language that lets you
control how your web pages look, but we’ll get into that in more detail
later. For now, it’s important that you know what the abbreviation
stands for.

Building the Example Site

Each example that’s presented in this book will be backed up with a sample of
the markup you need to write, and a screen shot that shows how the results
should look.

Each example is complete: nothing’s missing. You'll see the picture build gradually,
so you won't be left trying to guess how the example web site got to the point
it’s at. The files we’ll use in all the examples are provided in a separate code
archive (described in more detail in a moment).

What you Can Expect from the Example Web Site

@ a fun web site project that will be built up through the chapters

[ a complete web site that demonstrates all the features you're likely to need
in your own web site

@ all the XHTML and CSS used to progress the site through each chapter—in
a single download

You can pick up the project at any point, so you don’t need to worry about mis-
takes you might have made in previous chapters’ exercises!

What this Book Won’t Tell You

While it might be tempting to cram everything into one book and claim that the
reader will learn everything in 24 hours, the honest truth is that this is not neces-
sarily the right approach for everyone.

Order the print version of this book to get all 500+ pages!
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This book won’t try to force-feed you everything there is to know about creating
web pages; instead, it focuses on the most useful aspects that you’ll find yourself
using over and over again.

This book does not cover:

@ JavaScript

[ other programming languages, such as ASP or PHP
[ advanced CSS techniques

@ search engine optimization techniques

By the time you’ve finished this book and have had a chance to tackle your own
web site, you might want to take the next steps to increasing your site-building
knowledge. We’ll be recommending next steps where appropriate throughout the
book, and suggesting other resources that you might like to check out.

So, this is where the introductory piffle ends and the process of learning be-
gins—learning how to build web sites the right way. So step this way, ladies and
gentlemen...

What’s in this Book?

Chapter 1: Setting Up Shop
In this chapter, we’ll make sure that you have all the tools you’re going to
need to build your web site. I'll explain where you can get the right tools—all
of them for free! By the end of the chapter, you’'ll be ready to get cracking
on your first web site.

Chapter 2: Your First Web Pages
In this chapter, we’ll learn what makes a web page. We’ll explore XHTML,
understand the basic requirements of every web page, and investigate the
common elements that you’ll see on many web pages. Then, you’ll start to
create pages yourself. In fact, by the end of this chapter, you’ll have the be-
ginnings of your first web site.

Chapter 3: Adding Some Style
In this chapter, we’ll start to add a bit of polish to the web pages we created
in Chapter 2. You'll learn what CSS is, and why it’s a good thing, before
putting it into action for yourself. As the chapter progresses, you'll see the
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project web site start to take shape as we apply background and foreground
colors, change the appearance of text, and make web links that have been
visited look different from those that haven’t.

Chapter 4: Shaping Up with CSS

This chapter builds on the previous chapter’s introduction to the color and
text-styling abilities of CSS to reveal what CSS can do for border styles and
page layouts in general. First, we’ll review the full range of border effects that
you can apply to elements such as headings and paragraphs. We’ll experiment
with dotted borders, and big, bold borders, as well as some slightly more
subtle effects. In the second half of the chapter, we’ll learn how it’s possible
to use CSS to position the elements of a web page—including blocks of nav-
igation—anywhere on the screen.

Chapter 5: Picture this! Using Images on your Web Site

As the chapter title suggests, this one’s all about images. We’ll discover the
difference between inline images and background images, and look into the
issue of making images accessible for blind or visually impaired people (blind
people surf too!). We'll also learn how to adjust pictures to suit your web
site using the software that we downloaded in Chapter 1. Then we get prac-
tical, putting all this knowledge together to create a photo gallery for the
project site.

Chapter 6: Tables: Tools for Organizing Data
In this chapter, we’ll learn when tables should be used and, perhaps more
importantly, when they should not be used. Once we’ve got the basics out of
the way, I'll show how you can breathe life into an otherwise dull-looking
table—again, using CSS—to make it much more visually appealing.

Chapter 7: Forms: Interacting with your Audience

In Chapter 7, we learn all about forms—what they’re used for, what’s required
to build a form, and what you can do with the data you collect through your
form. I'll teach you what the different form elements—such as text inputs,
checkboxes, and so on—do, and show you how to use CSS to make a form
look more attractive. Finally—and this is something that other books may
not explain—I"ll show you how you can use a free web service to have the
data that’s entered into your form emailed to you.

Chapter 8: Getting your Web Site Online
It’s all well and good to build a web site for fun, but you need a way for
people to see it—that’s what this chapter is all about. We’ll learn about
hosting plans, discuss the pros and cons of using free services, and look at
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the tools that you'll need in order to transfer your files from your computer
at home to a web server for the world to see.

Chapter 9: Adding a Blog to your Web Site
Blogging’s one of the best ways to keep your web site’s content fresh and
ever-changing. In this chapter, you’ll learn what a blog is (that’s always a
good start), and how you can set one up for yourself. We’ll also spend some
time making sure it looks consistent with the rest of your web site.

Chapter 10: Pimp my Site: Cool Stuff you can Add for Free

You've heard of the MTV program Pimp My Ride, right? No? Well, every
week, the guys on this show take an everyday car and transform it—with
some well-placed and carefully executed cosmetic touches—into a real head-
turner of a vehicle. And that’s this chapter’s aim for your web site! You’ll
discover that there are all kinds of tools, plugins, and add-ons that you can
build into to your web site to make it even more useful for you and your
visitors. Among the tools on offer we’ll find site search facilities, statistics
programs, and online discussion forums.

Chapter 11: Where to Now? What you Can Learn Next
In this final chapter, we summarize the skills that you’ve learned in this book,
then consider your options for learning more. I'll recommend web sites that
I feel can take you to that next level, and books that really should be on your
bookshelf (or rather, open on your desk next to your computer!), in an effort
to ensure that you continue to learn the good stuff once you’ve put this book
down.

Appendix A: XHTML Reference
This appendix lists all of the XHTML elements that are available for use in
your web pages. It’s not intended to replace the official W3C reference, but
it does provide detailed information about each element and how it can be
used. The appendix also includes an example of how each element can be
applied within markup, so you should find it to be a handy reference not just
as you work through this book, but in the web projects you tackle in future.

The Book’s Web Site

Located at http://www.sitepoint.com/books/htmll/, the web site supporting this
book will give you access to the following facilities:
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The Code Archive

As you progress through the text, you’ll note a number of references to the code
archive. This is a downloadable ZIP archive that contains complete code for all
the examples presented in the book. It also includes a copy of the Bubble Under
web site, which we use as an example throughout the book.

Updates and Errata

No book is perfect, and I expect that watchful readers will be able to spot at least
one or two mistakes before the end of this one. The Errata page, at
http://www.sitepoint.com/books/htmll/errata.php on the book’s web site, will
always have the latest information about known typographical and code errors,
and necessary updates for new browser releases and versions of web standards.

The SitePoint Forums

If you’d like to communicate with me or anyone else on the SitePoint publishing
team about this book, you should join theSitePoint Forums.> In fact, you should
join that community even if you don’t want to talk to us, because there are a lot
of fun and experienced web designers and developers hanging out there. It’s a
good way to learn new stuff, get questions answered (unless you really enjoy being
on the phone with some company’s tech support line for a couple of hours at a
time), and just have fun.

The SitePoint Newsletters

In addition to books like this one, SitePoint offers free email newsletters.

The SitePoint Tech Times covers the latest news, product releases, trends, tips, and
techniques for all technical aspects of web development. The long-running SitePoint
Tribune is a biweekly digest of the business and moneymaking aspects of the web.
Whether you're a freelance developer looking for tips to score that dream contract,
or a marketing major striving to keep abreast of changes to the major search en-
gines, this is the newsletter for you. The SitePoint Design View is a monthly com-
pilation of the best in web design. From new CSS layout methods to subtle

3 http:/Awww.sitepoint.com/forums/
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Photoshop techniques, SitePoint’s chief designer shares his years of experience
in its pages.

Browse the archives or sign up to any of SitePoint’s free newsletters at
http://www.sitepoint.com/newsletter;/.

Your Feedback

If you can’t find your answer through the forums, or you wish to contact me for
any other reason, the best place to write is books@sitepoint.com. We have a
well-manned email support system set up to track your inquiries, and if our
support staff are unable to answer your question, they send it straight to me.
Suggestions for improvement as well as notices of any mistakes you may find are
especially welcome.
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Conventions Used in this Book

You’ll notice that we’ve used certain typographic and layout styles throughout
this book to signify different types of information. Look out for the following:

Markup Samples

Any markup—>be that HTML or CSS—will be displayed using a fixed-width font
like so:

File: webpage.html (excerpt)
<h1>A perfect summer's day</h1>

<p>It was a lovely day for a walk in the park. The birds were
singing and the kids were all back at school.</p>

Menus

When you need to select something from a menu, it’ll be written as File > Save;
this means “select the Save option from the File menu.”

Tips, Notes, and Warnings

Hey, you!
Tip@

Tips will give you helpful little pointers.

Ahem, Excuse me...

hote
Notes are useful asides that are related—but not critical—to the topic at
hand. Think of them as extra tidbits of information.
Make Sure you Always...
IMPORTANT ...pay attention to these important points.
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Watch Out!

Warnings will highlight any gotchas that are likely to trip you up along the
way.

XXVi
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Before you dive in and start to build your web site, we need to take a little time
to get your computer set up and ready for the work that lies ahead. That’s what
this chapter is all about: ensuring that you have all the tools you need installed
and ready to go.

Tooling Up

If you were to look at the hundreds of computing books for sale in your local
bookstore, you could be forgiven for thinking that you’d need to invest in a lot
of different programs to build a web site. However, the reality is that most of the
tools you need are probably sitting there on your computer, tucked away some-
where you wouldn’t think to look for them. And if ever you don’t have the tool
for the job, there’s almost certain to be one or more free programs available that
can handle the task.

We’ve made the assumption that you're already on the Internet—your web site
wouldn’t be of much use without it! And, though it’s not essential, it will also be
handy if you have a broadband internet connection. Don’t worry if you don’t
have broadband: it won’t affect any of the tasks we’ll undertake in this book. It
will, however, mean that some of the suggested downloads may take a while to
load onto your computer, but you probably knew that already.
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Planning, Schmanning

At this point, it might be tempting to look at your motives for building a web
site. Do you have a project plan? What objectives do you have for the site?

While you probably have some objectives, and some idea of how long you want
to spend creating your site, we’re going to gloss over the nitty-gritty of project
planning to some extent. This is not to say that project planning isn’t an important
aspect to consider, but we’re going to assume that because you’ve picked up a
book entitled Build Your Own Web Site The Right Way, you probably want to just
get right into the building part.

As this is your first web site, and will be a fairly simple one, we can overlook some
of the more detailed aspects of site planning. Later, once you've learned—and
moved beyond—the basics of building a site, you might feel ready to tackle a
larger, more technically challenging site. When that time comes, proper planning
will be a far more important aspect of the job. But now, let’s gear up to build our
tirst, simple site.

The Basic Tools you Need

As I mentioned earlier, many of the tools you’ll need to build your first web site
are already on your computer. So, what tools do you need?

@ The primary—and most basic—tool that you’ll need is a text editor. You'll
use this to write your web pages.

@ Once you’ve written a web page, you can see how it looks in a web browser.

[ Finally, when you’re happy with your new web page, you can put it on the
Internet using an FTP client. Using FTP can be a little complicated, but
thankfully you won’t need to do it too often. We’ll discuss FTP clients in
detail in Chapter 8.

You've already got most of these programs on your computer, so let’s go find
them.
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Windows Basic Tools
Your Text Editor: Notepad

The first tool we’ll consider is the text editor. Windows comes with a very simple
text editor called Notepad. Many professional web designers who use complicated
software packages first started out many years ago using Notepad; indeed, many
professionals who have expensive pieces of software that should be time-savers
still resort to using Notepad for many tasks. Why? Well, because it’s so simple,
little can go wrong with it. Bells and whistles are definitely not on the menu here.

You can find Notepad in the Start menu: go to Start > All Programs > Accessories.

Shortcut to Notepad
Tip@

To save yourself navigating to this location each and every time you want
to open Notepad, create a shortcut on your desktop. With the Start menu
open to display Notepad’s location, hold down the Ctrl key; click and hold
down the mouse button, then drag the Notepad icon to your desktop. When
you release the mouse button, a shortcut to the application will appear on
your desktop, as in Figure 1.1.

Figure 1.1. Creating a shortcut to Notepad

e
|

Motepad

Notepad is the simplest of simple applications. See Figure 1.2 for a depiction of
its fancy interface (that was sarcasm, by the way).
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Figure 1.2. Notepad: a contender for the world’s ugliest program?

B\ Untitled - Notepad
File Edit Format Yiew Help

Just a simple ol" text editor|

Your Web Browser: Internet Explorer

Once you've created a web page using Notepad, you'll need a way to view the
results of your handiwork. You’ll remember that, in the preface to this book, we
mentioned Internet Explorer. Well, that’s your viewer! As Figure 1.3 shows, In-
ternet Explorer sits right there in the Programs folder, and also lurks on your
desktop.

Figure 1.3. Internet Explorer: there’s no hiding this baby away!
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Mac OS X Basic Tools

Like Windows, the Mac operating system (specifically OS X; we won’t be looking
at previous versions of the Mac OS) has a number of tools that you can use
straight out of the box. These tools are virtually equivalent to the Windows
programs mentioned above.

Your Text Editor: TextEdit

While Windows has Notepad, the Mac has TextEdit, which can be found in the
Applications folder, as Figure 1.4 illustrates.

Figure 1.4. TextEdit comes as part of Mac OS X’s default

installation
806 |4 Applications - |
l Ay l [=i = IIDI [ 'ﬂ"] Q- selection
| JE w R - | A
QOpera 6.02 O5Xvnc Preview '
|
= QuickTime Player ~ TextEdit Sherlock
| L @ U
| _S_tigkies — - .E.'.YStE':" Prefe_r_ence_s . Antarnat Coannact v

S

E 1 of 38 selected, 1.78 GB available

Unlike Notepad, TextEdit works as what we call a “rich text editor” by default,
which means we can work with fonts, make text bold and italic, and so on.
However, we want to work with TextEdit as a plain text editor, so you’ll need to
fiddle with some of TextEdit’s preferences. Start TextEdit, then select TextEdit
> Preferences from the menu to bring up the Preferences screen. Select Plain text
within New Document Attributes, then close the Preferences screen. The next time
you create a new file in TextEdit, it will be a plain text document.
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Your Web Browser: Safari

Internet Explorer is also available for Mac, but was abandoned by Microsoft when
Apple began to make its own web browser, Safari, so it’s considerably outdated.
You can usually find Safari in the dock, but you can also access it through the
Applications folder, as Figure 1.5 illustrates.

Figure 1.5. Internet Explorer and Safari are available via Mac’s
Applications folder

|06 | 4 Applications -
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| i
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; " Safari |  Internet Explorer | iPhoto }
= == = 2 of 38 s.elacte{i:?..?s GB available = i I

Stick it in the Dock
Tip@

Just as you can drag shortcuts to programs onto the Windows desktop, you
can add programs to the dock in Mac OS X (the dock is the bar of icons at
the bottom of your screen). To add a program to the dock, just drag it from
the Applications folder onto the dock, and presto! The application is now
easily accessible whenever you need it.

Beyond the Basic Tools

You can certainly make a good start using the tools mentioned above. However,
once you're dealing with a handful of web pages and other resources, you may
want to go beyond these basic tools. We’ll show you how to use some slightly
more advanced applications later in the book.
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Countless other text editors and web browsers are available for download, and
many of them are free. Obviously, we don’t have time to describe each and every
one of them, so I've settled on a few options that have worked for me in the past,
and which you might like to download and have at your disposal.

Windows Tools

NoteTab

NoteTab’s tabbed interface lets you have many different files open simultaneously
without cluttering up your screen, as Figure 1.6 illustrates. Files that you've
opened are remembered even after you close the program and open it again later
(very useful when you’re working on a batch of files over many days, for instance).
You can download the free NoteTab, or its Light version, from
http://www.notetab.com/.

Figure 1.6. NoteTab Light’s tabbed interface
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Firefox

Firefox is a popular alternative to Internet Explorer, and, as we proceed through
this book, it will be our browser of choice for a number of reasons. As with
NoteTab, Firefox offers a nice tabbed interface that keeps your computer free
from  window  clutter. You can download Firefox from
http://www.mozilla.com/firefox/; the browser is depicted in Figure 1.7.

Figure 1.7. Firefox—this critter is worth hunting down

) Moxzilla Firefox Start Page - Mozilla Firefox
File Edit View Go Bookmarks Tools Help

<;z| - |:> - @ |:| @ | hittp:/fwww. google. com firefox V| @ ao @, (®]

Firefox Start

GOUSIQ Web Images Groups News Local

I
Google Search

Choose from some of the most popular search engines on the Web - they're
i pre-loaded in the Firefox Search bar

Firefox Help & Add-ons About Mozilla Mew! Mozilla Store Get Involved

Done @ N

Mac OS X Tools

It is true that there are fewer free programs available for the Mac operating system
than there are for Windows. However, there are a few programs that you might
like to consider as you move beyond the basics.
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TextWrangler

TextWrangler is a free, simple text editor made by BareBones Software. As with
NoteTab for Windows, TextWrangler can tidy up your workspace by allowing
several text files to be open for editing at the same time (the documents are listed
in a pull-out “drawer” to one side of the interface, rather than in tabs). You can
download TextWrangler, which is shown in Figure 1.8, from the BareBones
Software web site.

Figure 1.8. TextWrangler, a free text editor from BareBones
Software

806 ) index.html =

PIFRIEREIFEIR ® Bt e e [
I

: < r Y index.html % Documents

[
<IDOCTYPE html PUBLIC "-/Ad3C//DT0 XHTHML 1.8 Strict//EN" "http:/fww.wd | % abouthtml
<html smlns="http s/ Ao w3 org/ 1990 Ahkn L >

iakics ?__‘ contact. html

<titledUntitled Document</title> &% index.html

<meta http-equiv="Content-Type" content="text/htmljcharset=utf-g" / _—

</head>

<body>

</body

</himly

« 65 s //—
Firefox

Firefox is gaining popularity not just among Windows users, but among Mac
users too! A web page viewed in Firefox should display the same regardless of
whether the browser is installed on a PC running Windows XP, on a Mac running
OS X, or on Linux (an operating system favored by people who really, really hate
Microsoft products with a vengeance). The predictability of Firefox is a welcome
change from the bad old days of endless browser competition, and is one very

good reason why we will primarily use Firefox in the examples included in this
book.

! httpy/www.barebones.com/products/textwrangler/
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Not Just Text, Text, Text

You can build an entire web site using just the tools mentioned above, but it
won’t be the sexiest site on the Web. The missing element here is images: so far,
the programs we’ve mentioned are used to manipulate plain text or view web
pages. If your web site is going to be visually appealing, you’ll need to be able to
create and manipulate images, either from scratch, using photos you’ve taken,
or using images that you have the legal right to use on your web site.

Unfortunately, when it comes to image editing software, that old saying—“You
get what you pay for”—is alive and well. A professional image editing program,
like Photoshop or Fireworks, costs hundreds of dollars. While these programs
offer some excellent capabilities, we cannot really recommend that you go out
and pay for them unless you are absolutely sure that they’re right for you. If you
already have a copy of one of these, or a similar image editing program, by all
means use it and experiment with it. Programs like Paint Shop Pro or Photoshop
Elements (a cut-down version of Photoshop) are more reasonably priced. However,
for the purposes of this book, we’ll look only at tools that are free to download,
and offer enough functionality to give you an idea of what’s possible.

Keep an eye open for free image editors that are included on disks attached to
the covers of internet, computing, and design magazines. Software vendors often
give away older versions of their software in the hopes that users might be
tempted to upgrade to a new version at a later date. Look out for Paint Shop
Pro, or any image editor that supports “layers.” While we’ll keep our image
editing fairly simple throughout this book, it’s certainly worth keeping an eye
open for free (and full-featured) image editing software, as these offers will not
always be available.

Taking the Big Boys for a Spin
Tip@

The most commonly used image editing packages are available for trial
download. They are large downloads (hundreds of megabytes) and will
probably need to be downloaded overnight, even on a broadband connection.

These trial versions are typically available for 30 days’ use; after that time,
you can decide whether you want to pay for the full software, or stop using
the program. However, those 30 days might just be enough time for you to
use the software while you work through this book.
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Windows Tools

Adobe Photoshop A trial of the latest ver31or1 of Photoshop is
available for download.” If you’d rather try the
lighter Photoshop Elements, tr1a1 versions are
available for Windows® and Mac.*

Macromedia Fireworks  You can download a trial version of Fireworks
from the Macromedia web site.’

Paint Shop Pro Paint Shop Pro is available for Windows only.
To download a trial version, visit the Paint Shop
Pro site,® and click the Try” link on the right.

Windows Tools

A standard Windows install is not exactly blessed with image editing software
(although you might be lucky enough to have bought a PC, scanner, or digital
camera that came bundled with some image editing software; scout around in
your Start > All Programs menu to see what you can uncover). As a general rule,
you’ll have to look elsewhere for useful image manipulation software.

Picasa

Though the Windows default image editing and management tools are distinctly
lackluster, the good news is that there’s an excellent program just begging to be
downloaded and used, and it’s brought to you by those good people at Google.
The program is called Picasa, and it’s extremely well equipped to handle most of
the tasks that you're likely to encounter as you manage imagery for your web
site. Download a copy from the Picasa web site,” and soon enough you’ll be using
this program to crop, rotate, add special effects to, and catalogue the images
stored on your computer. Figure 1.9 gives you an idea of the program’s interface.

2 http J//www.adobe.com/products/photoshop/tryout.html
http J//www.adobe.com/products/photoshopelwin/
* http://www.adobe.com/products/photoshopelmac/
> http //www.macromedia.com/go/tryfireworks/
http //www.corel.com/paintshoppro/
7 http://www.google.com/picasa/
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Figure 1.9. Picasa, Google’s free, fully-featured photo and image
editing and management tool

File Edit View Folder Picture Create Tools Help

": fg»  Import | Slideshow uwm  Timeline = Gift €D \ x
| ¥) Folders on Disk (1) |

2003

# My Pictures (30)

My Pictures
November 2003

Select: All Starred None

30 pictures  November 2003 to August 2005 5.7MB on disk

Mac OS X Tools

The Mac has a reputation for being favored by designers and creative types, and
the platform makes many tools available to the budding artist. However, they
usually come at a price, and often that price is higher than those of the Windows
equivalents! So, what free software can we use on the Mac, assuming that we
want something more permanent than a 30-day trial version of Photoshop or
Fireworks?
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GraphicConverter

GraphicConverter has much greater capabilities than its name suggests. It’s
bundled with most newer Macs, and is also available for download” (you’ll be
encouraged to pay a modest registration fee for the software, but you can try it
out for free). Sure, this is primarily a tool for converting graphic files, but it can
also be used for simple editing tasks. Using GraphicConverter, which is illustrated
in Figure 1.10, you’ll be able to crop, resize, rotate, and add text to any image.

Figure 1.10. GraphicConverter does a lot more than simply convert
graphics!

Information

PowerMacl,1 (0.35GHz)

GraphicConverter X
VS -7 Y373 H

Copyright ©2002-2005 Lermke Software GrmbH
o A Copyright ©1992-2001 Thorsten Lemke
This copy is a1l Rights Reserved Worldwide.
reg istered to: All Cormmercial Distribution Prohibited unless
T permission is obtained in writing from the author.
sese unregistered

VErSion sess

Internet: http:/ fwww.lemkesoft.com
E-Mail: mailto:lemkesoft@aol.com
(  Cancel ) ( Continue,..)

iPhoto

Also included with Mac OS X is a program that probably needs no introduction
to the experienced Mac user: iPhoto. This excellent program is not intended as
a fully-featured image editor; it’s really designed for managing and viewing large
numbers of photos stored on a computer. It’s great for organizing photo albums,
but with recent updates, iPhoto has been given some editing facilities that have
promoted it beyond a mere cataloguing tool. Unfortunately, the latest version of
iPhoto is not available as a free download, and must be purchased as part of
Apple’s iLife suite of programs.

8 http://www.graphicconverter.net/
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iPhoto, pictured in Figure 1.11, can be found in the Applications folder, or in
the dock.

Figure 1.11. The iPhoto 5 image adjustment tools
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Creating a Spot for your Web Site

So far, we’ve looked at some of the tools that you’ll need to create your web site.
We’ve looked at programs that are readily available, and where you can find them
on your computer. And for cases in which the free tools that came with your
computer are not up to the job, we’ve suggested other programs that you can
download and use. The next task we must tick off our to-do list before we go any
further is creating a space for your web site on the hard drive.

Windows

The easiest and most logical place to keep your web site files is in a dedicated
folder within the My Documents folder. There should be a My Documents folder
on your desktop, but don’t worry if it’s not there: it’s easy to get it to appear
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there (see the tip below for details). Double-click on My Documents, then create
a new folder called Web by selecting File > New > Folder.

Displaying the “My Documents” Folder
Tip@

Lost your “My Documents” folder? It’s easily done: in an effort to clean up
your desktop, you may have removed the icon by accident. You can return
the folder to your desktop as follows:

[ From the Start Menu, select Control Panel.

1 Select Appearance and Themes, then select Display (if you don’t see
Appearance and Themes, but do see Display, double click on that). A
Display Properties window will appear.

1 Select the Desktop tab along the top, then click the Customize Desktop...
button at the bottom.

O You'll be presented with the Desktop Items dialog, which will include a
set of Desktop icons checkboxes that allow you to select the icons you’d
like to see on your desktop. Check the My Documents checkbox, then
click OK on both open dialogs.

U Your My Documents folder should now be back on the desktop, as shown
in Figure 1.12.

Figure 1.12. The My Documents folder displaying on the desktop in
XP
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Mac OS X

In Mac OS X, there’s already a handy place for you to store your web site files:
the Sites folder shown in Figure 1.13. Open your home directory (from Finder,
select Go > Home), and there it is!

Figure 1.13. The sites folder displaying in the Mac OS X home
directory

Documents

Pictures

e

1 of 11 selected, 1.54 GB available

It’s easy to add the Sites folder to your sidebar (which you can see in Figure 1.14)
for quick access: just drag the folder to the sidebar in the same way you add items
to the dock.
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Figure 1.14. The sites folder appearing in the sidebar
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Getting Help

Books may be a wonderful way to learn: you're sitting there with a computer
running, a cup of coffee keeping your mind ticking over (you’ve got one there,
right? A coffee, that is, not a mind), and a bookmark signifying your progress to
date. Great. But what if you don’t understand something in the book? What do
you do next? Shouting at the book won’t help (well, it may be therapeutic, but
you won’t get a response)!

Hopefully, you won’t find yourself asking too many questions as you work through
this book, but if you're the curious type—or a quick learner—you might want to
go beyond what we’re going to teach you here.

Whether you’re getting stuck on somethmg, or you want to learn more, your first
stop should be the SitePoint Forums.” It will only take a few moments to register,
and once you’ve done so, you can log in and ask questions in a range of different

? http://www.sitepoint.com/forums/
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forums. Whether you have questions about writing your web site, you need
marketing tips, or you're facing a few tricky graphic design issues, the hundreds
of experts who contribute to and moderate these pages every day will be happy
to help out.

Register at SitePoint’s forums today; then, when we recommend further reading
or research, you’ll be good to go. Oh, and did we mention that all this friendly,
helpful advice is 100% free of charge? I thought that might encourage you!

Summary

Believe it or not, we’ve now got everything we need to build our own web
site—and all without spending a cent! Not only do we have the basic tools—our
text editor (Notepad or TextEdit) and our web browser (Internet Explorer or
Safari)—but we’ve also looked at some alternatives to these.

We’ve reviewed some simple and freely available image editing programs that
can help us spruce up our sites: Picasa for Windows, and GraphicConverter and
iPhoto for Mac. Finally, we mentioned some more capable—and more expens-
ive—options, such as Photoshop and Paint Shop Pro.

Now we’ve got the tools, let’s learn how to use them!

18 Order the print version of this book to get all 500+ pages!
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Your First Web Pages

A wise man once said that a journey of a thousand miles begins with a single
step. In this chapter, you'll take that first metaphorical step on your journey to-
wards web site enlightenment: you’ll create your first web page. By the end of
the chapter, you’ll have duplicated that first page to form the beginnings of a
multi-page web site.

Nice to Meet you, XHTML

In the preface to this book, we touched briefly on what XHTML is. In this chapter,
we’ll learn the basics of XHTML, periodically previewing our progress in a browser,
and steadily building up our knowledge of various XHTML elements. Elements
are the basic building blocks of XHTML; they tell the web browser what a partic-
ular item in the page is: a paragraph, a heading, a quotation, and so on. Elements
contain all the information that the browser requires, as we’ll soon see.

Anatomy of a Web Page

In the preface, we said that learning XHTML was like taking a driving lesson.
To take that analogy a step further, you can imagine a web page as being the car
in which you’re learning to drive. There are some things that are essential to the
process of driving; others are mere fashion items. For instance, the interior might
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have two seats, or it may have four or six; it might have black leather trim, fluffy
dice, or faux leopard-skin door panels. But, while you may dearly love those door
panels, they’re not essential to driving.

You can’t drive the car unless you have a steering wheel to hold onto, four wheels
(at a minimum!), and a place to sit. The car must also have some kind of chassis
to which the bodywork can be bolted. An engine is needed to power the car, as
is bodywork to which your (nonessential, but spiffy) trim can be attached. Any-
thing less, and all you have is a collection of attractive—but useless!—spare parts.

Like the car, your web page also needs to have a chassis: a basic structure upon
which everything else can be built. But what does this hypothetical “chassis” look
like? The best way to find out is to get down on our hands and knees (again,
figuratively speaking) and take a close look under the hood.

Viewing the Source

One of the great things about learning to build web pages is that you and I have
the ability to view the source code of other people’s web pages. You can learn a
lot by simply taking a peek at how someone else’s web page was built ... but how
do you do it?

Although every browser uses slightly different terminology, the variations in the
ways different browsers let us view web page code are so small that the process
doesn’t need to be spelled out for every browser. Here’s the technique you’d use
to view a web page’s source in IE:

O Bring up a page in your browser. (I'd suggest the Web Standards Project’s
homepage The Web Standards Project (WaSP) is a group that promotes
the benefits of building your web site correctly, so you can be pretty sure
they’ve got it right!)

[ Position your cursor somewhere on the page (other than over an image), and
right-click (Ctrl-click on a Mac). You should be presented with the context
menu shown in Figure 2.1.

! http://webstandards.org/
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Figure 2.1. Selecting the View Source command after
right-clicking on a web page
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Encoding »

Print
Refresh

Properties

[ Select View Source, and a new window will appear, displaying all of the page’s
underlying markup.

At this point, we’re not going to analyze the markup that you're looking at, but
this is one of those tricks that’s really useful to know from the beginning. A note
of warning, though: most web pages don’t use best-practice techniques, so avoid
looking at a page’s source unless the web site in question is mentioned in this
book as being a good example.

Basic Requirements of a Web Page

As we've already discussed, in any web page, there are some basic must-have
items (all of which you could pick out if you scanned through the markup that
appeared when you tried to “view source” a moment ago):

O a doctype

1 an <html> tag
U a <head> tag
[ a<title> tag

] a <body> tag

Order the print version of this book to get all 500+ pages! 21
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These requirements make up the basic skeleton of a web page. It’s the chassis of
your car with some unpainted bodywork, but no wheels or seats. A car enthusiast
would call it a “project”—a solid foundation that needs a little extra work to turn
it in to something usable. The same goes for a web page. Here’s what these re-
quirements look like when they’re combined in a basic web page:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Untitled Document</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
</body>
</html>

The markup above is the most basic web page you’ll see here. It contains practic-
ally no content of any value (at least, as far as someone who looks at it in a
browser is concerned), but it’s crucial that you understand what this markup
means. Let’s delve a little deeper.

The Doctype

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"“http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">

This is known as the doctype (short for Document Type Declaration). It must
absolutely be the first item on a web page, appearing even before any spacing or
carriage returns.

Have you ever taken a document you wrote in Microsoft Word 2003 on one
computer, and tried to open it on another computer that ran Word 97? Frustrat-
ingly, without some pre-emptive massaging when the file is saved in the first
place, this just doesn’t work. It fails because Word 2003 includes features that
Bill Gates and his team hadn’t even dreamed of in 1997, and Microsoft needed
to create a new version of its file format to cater to these new features. Just as
Microsoft has many different versions of Word, so too are there different versions
of HTML, the latest of which is XHTML. Mercifully, the different versions of
HTML have been designed so that this language doesn’t suffer the same incom-
patibility gremlins as Word, but it’s still important to identify the version of
HTML that you’re using. This is where the doctype comes in. The doctype’s job
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is to specify which version of HTML the browser should expect to see. The
browser uses this information to decide how it should render items on the screen.

The doctype above states that we’re using XHTML 1.0 Strict, and includes a
URL to which the browser can refer: this URL points to the W3C'’s specification
for XHTML 1.0 Strict. Got all that? Okay: jargon break! There are too many
abbreviations for this paragraph!

Jargon Busting 101

note
URL
URL stands for Uniform Resource Locator. It’s what some (admittedly
more geeky) people refer to when they talk about a web site’s address.
URL is definitely a useful term to learn, though, because it’s becoming
more and more common.

W3C

W3C is an abbreviation of the name World Wide Web Consortium, a
group of smart people spread across the globe who, collectively, come
up with proposals for the ways in which computing and markup lan-
guages that are used on the Web should be written. The W3C defines
the rules, suggests usage, then publishes the agreed documentation for
reference by interested parties, be they web site creators like your good
self (once you’re done with this book, that is), or software developers
who are building the programs that need to understand these languages
(such as browsers or authoring software).

The W3C documents are the starting point, and indeed everything in
this book is based on the original documents. But, trust me: you don’t
want to look at any W3C documents for a long time yet. They’re just
plain scary for us mere mortals without Computer Science degrees. Just
stick with this book for time being—I’ll guide you through!

The html Element

So, the doctype has told the browser to expect a certain version of HTML. What
comes next? Some HTML!

An XHTML document is built using elements. Remember, elements are the bricks
that create the structures that hold a web page together. But what exactly is an
element? What does an element look like, and what is its purpose?
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O An XHTML element starts and ends with tags—the opening tag and the
closing tag.”

[ A tag consists of an opening angled bracket (<), some text, and a closing
bracket (>).

@ Inside a tag, there is a tag name; there may also be one or more attributes.

Let’s take a look at the first element in the page: the html element. Figure 2.2
shows what we have.

Figure 2.2. Constituents of a typical XHTML element

Opening tag
|

<html xmlns="http://www.w3.0rg/1999/xhtml">

Element | |

</html> Attribute

|

Closing tag

Figure 2.2 depicts the opening tag, which marks the start of the element:
<html xmlns="http://www.w3.0rg/1999/xhtml">

Below it, we see the closing tag, which marks its end (and occurs right at the end
of the document):

</html>
Here’s that line again, with the tag name in bold:

<html xmlns="http://www.w3.0rg/1999/xhtml">

2Like any good rule, there are exceptions to this: empty elements, such as meta, use special empty
tags. We'll take a look at empty tags soon.
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And there is one attribute in the opening tag:

<html xmlns="http://www.w3.0rg/1999/xhtml">

What’s an Attribute?

note

HTML elements can have a range of different attributes; the available at-
tributes vary depending on which element you're dealing with. Each attribute
is made up of a name and a value, and these are always written as
name="value". Some attributes are optional, while others are compulsory,
but together they give the browser important information that the element
wouldn’t offer otherwise. For example, the image element (which we’ll learn
about soon) has a compulsory “image source” attribute, the value of which
gives the filename of the image. Attributes appear in the opening tag of any
given element. We’ll see more attributes crop up as we work our way through
this project, and, at least initially, I'll be making sure to point them out, so
that you’re familiar with them.

Back to the purpose of the html element. This is the outermost “container” of
our web page; everything else is kept within that outer container—there are no
exceptions! Let’s peel off that outer layer and take a peek at the contents inside.

There are two major sections inside the html element: the head and the body.
It’s not going to be difficult to remember the order in which those items should
appear, unless you happen to enjoy doing headstands.

The head Element

The head element contains information about the page, but no information that
will be displayed on the page itself. For example, it contains the title element,
which tells the browser what to display in its title bar:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Untitled Document</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
</body>
</html>
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25


http://www.sitepoint.com/launch/81f2b9

Chapter 2: Your First Web Pages

The title Element

The opening <title> and closing </title> tags are wrapped around the words
“Untitled Document” in the markup above. Note that the <title> signifies the
start, while the closing </title> signifies the end of the title. That’s how closing
tags work: they have forward slashes just after the angle bracket.

The “Untitled Document” title is typical of what HTML authoring software
provides as a starting point when you choose to create a new web page; it’s up
to you to change those words. However, if you’re creating a web page from scratch
in a text editor (like Notepad), you will, I hope, remember to type something a
little more useful. But just what is this title? Time for a screenshot: check out

Figure 2.3.

Figure 2.3. “Untitled Document”—not a very helpful title

2 Untitled Document - Microsoft Internet Explorer E]E]
Eile Edit View Favorites Tools Help ".'

Qbak - O = & A /‘:'Search '+ Favorites L 5]

Address |@ C:\Documents and Settings'\Bob Dobalinal V| Go |Links **

@ Done :* My Computer

It really would pay dividends to put something useful in there, and not just for
the sake of those people who visit our web page. The content of the title element
is also used for a number of other purposes:

@ It’s the name that appears in the Windows Taskbar for any open document,
as shown in Figure 2.4. It also appears in the dock on a Mac, as Figure 2.5
illustrates. When you have a few windows open, you’ll appreciate those people
who have made an effort to enter a descriptive title!

Figure 2.4. The title appearing in the Windows Taskbar

3 Bubble Under - The diving dub for the south-west UK - Microsoft Internet Explo

a SitePoint : Mew Artides, Fresh Thinking for Web Developers and Designers - Mic
=

= r e
7, 2 Internet Explorer ~| @ My Documents & Inbox for matthew ...
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Figure 2.5. The title displaying in the Mac dock
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@ If users decide to add the page to their bookmarks (or favorites), the title
will be used to name the bookmark, as Figure 2.6 illustrates.

Figure 2.6. An untitled document saved to IE’s favorites

. I anyie
! Iﬁ Tools  Help
ﬂ Add to Favorites.. .

Qrganize Favoribes, ..

cu ==

=) Links [ 3=
=) Media 3
&) Msn.com

E‘ My Documents
ij Radio Station Guide

2;'] Untitled Document

@ Your title element is used heavily by search engines to ascertain what your
page contains, and what information about it should be displayed in the search
results. Just for fun, and to see how many people forget to type in a useful
title, try searching for the phrase “Untitled Document” in the search engine

of your choice.

meta Elements

Inside the head element in our simple example, we can see a meta element, which
is shown in bold below:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"“http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Untitled Document</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
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<body>
</body>
</html>

meta elements can be used in a web page for many different reasons. Some are
used to provide additional information that’s not displayed on-screen to the
browser or to search engines; for instance, the name of the page’s author, or a
copyright notice, might be included in meta elements. In the example above, the
meta tag tells the browser which character set to use (specifically, UTF-8, which
includes the characters needed for web pages in just about any language).

There are many different uses for meta elements, but most of them will make no
discernible difference to the way your page looks, and as such, won’t be of much
interest to you.

Self-closing Elements
note

The meta element is an example of a self-closing element (or an empty
element). Unlike title, the meta element needn’t contain anything, so
we could write it as follows:

<meta http-equiv="Content-Type"
content="text/html; charset=utf-8"></meta>

XHTML contains a number of empty elements, and the boffins who put
together XHTML decided that writing all those closing tags would get annoy-
ing pretty quickly, so they decided to use self-closing tags: tags that end with
/>. So our meta example becomes:

<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />

The Memory Game: Remembering Difficult Markup
Tip@

If you’re thinking that the doctype and meta elements are difficult to remem-
ber, and you're wondering how on earth people commit them to memory,
don’t worry: most people don’t! Even the most hardened and world-weary
coders would have difficulty remembering these elements exactly, so most
do the same thing—they copy from a source they know to be correct (most
likely from their last project or piece of work). You'll probably do the same
as you work with project files for this book.

Fully-fledged web development programs, such as Dreamweaver, will normally
take care of these difficult parts of coding.

28
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Other head Elements

Other items, such as CSS markup and JavaScript code, can appear in the
headelement, but we’ll discuss these as we need them.

The body Element

Finally, we get to the place where it all happens! The body element of the page
contains almost everything that you see on the screen, including headings, para-
graphs, images, any navigation that’s required, and footers that sit at the bottom
of the web page.

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Untitled Document</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
</body>
</html>

The Most Basic Web Page in the World

Actually, that heading’s a bit of a misnomer: we’ve already showed you the most
basic page (the one without any content). However, to start to appreciate how
everything fits together, you really need to see a simple page with some actual
content on it. Let’s have a go at it, shall we?

Open your text editor and type the following into a new, empty document (or
grab the file from the code archive if you don’t feel like typing it out—I understand
completely!).

File: basic.html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.o0rg/1999/xhtml">
<head>
<title>The Most Basic Web Page in the World</title>
<meta http-equiv="Content-Type"
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content="text/html; charset=utf-8" />
</head>
<body>
<h1>The Most Basic Web Page in the World</h1>
<p>This is a very simple web page to get you started.
Hopefully you will get to see how the markup that drives
the page relates to the end result that you can see on
screen.</p>
<p>This is another paragraph, by the way. Just to show how it
works.</p>
</body>
</html>

Once you've typed it out, save it as basic.html.

If you're using Notepad, select File > Save As... from the menu and find the Web
folder you created inside My Documents. Enter the filename as index.html, select
UTF-8 from the Encoding drop-down list, and click Save.

If you’re using TextEdit on a Mac, first make sure that you're in plain text mode,
then select File > Save As... from the menu. Find the Sites folder, enter index.html,
select Unicode (UTF-8) from the Plain Text Encoding drop-down list, and click Save.
TextEdit will warn you that you're saving a plain text file with an extension other
than .txt, and offer to append .txt to the end of your filename. We want to
save this file with an . html extension, so click the Don’t Append button, and your
file will be saved.

The Importance of UTF-8

If you neglect to select UTF-8 when saving your files, it’s likely that you
won’t notice much of a difference. However, when someone else comes along
to view your web site (say, a Korean friend of yours), they’ll probably end
up with a screen of garbage. Why? Because their computer is set up to read
Korean text, and yours is set up to create English text. UTF-8 can handle
just about any language there is (including some quite obscure ones!) and
most computers can read it, so UTF-8 is always a safe bet.

Next, using Windows Explorer or Finder, locate the file that you just saved, and
double-click to open it in your browser. Figure 2.7 shows how the page displays.
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Figure 2.7. Displaying a basic page

3 The Most Basic Web Papge in the World - Mozilla Firefox
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The Most Basic Web Page in the World

This 15 a very simple web page to get you started. Hopefully you wall get to see how the markup that drives the page relates to the
end result that you can see on screen

This 13 another paragraph, by the way. Just to show how it works.

Done

Analyzing the Web Page

We’ve introduced two new elements to our simple page: a heading element, and
a couple of paragraph elements, denoted by the <h1> tag and <p> tags, respectively.

Figure 2.8. Comparing the source markup with the view presented
in the browser

<body >

[<h1>Tre Most Basic Web Page in the Wc::'_d<,fhl>|

<p=This is a wvery simple web page to get yvou started. Hopefully
you will get to see how the markup that drives the page
relates to the end result that you can see on screen.</p>

hl <p=This is another paragraph, bv the wayv. Just to show how it
works.</p>
element =
</body>
</html>

~— The Most Basic Web Page in the World _ *

element

This is a very simple web page to get vou started. Hopefully vou will get to see how the
markup that drives the page relates to the end result that vou can see on screen.

This is another paragraph. by the way. Just to show how it works.

Do you see how the markup you’ve typed out relates to what you can see in the
browser? Figure 2.8 shows a direct comparison of the document displays.
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The opening <h1> and closing </h1> tags are wrapped around the words “The
Most Basic Web Page in the World,” making that the main heading for the page.
In the same way, the p elements contain the text in the two paragraphs.

There’s another point to note: the tags are all lowercase. All of our attribute
names will be in lowercase, too. Many older HTML documents include tags and
attributes in uppercase, but this isn’t allowed in XHTML.

Headings and Document Hierarchy

In the example above, we use an h1 element to show a major heading. If we
wanted to include a subheading beneath this heading, we would use the h2 ele-
ment. There are no prizes for guessing that a subheading under an h2 would use
an h3 element, and so on, until we get to h6. The lower the heading level, the
lesser its importance and, as a rule, the smaller (or less prominent) the font.

With headings, an important (and commonsense) practice is to ensure that they
do not jump out of sequence. In other words, you should start from level one,
and work your way down through the levels in numerical order. You can jump
back up from a lower-level heading to a higher one, provided that the content
under the higher-level heading to which you’ve jumped does not refer to concepts
that are addressed under the lower-level heading. It may be useful to visualize
your headings as a list:

[ First Major Heading
@ First Subheading
([ Second Subheading
@ A Sub-subheading
@ Another Major Heading
[ Another Subheading

Here’s the XHTML view of the example shown above:

<h1>First Major Heading</h1>
<h2>First Subheading</h2>
<h2>Second Subheading</h2>
<h3>A Sub-subheading</h3>
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<h1>Another Major Heading</h1>
<h2>Another Subheading</h2>

Paragraphs

Of course, no one wants to read a document that contains only headings—you
need to put some text in there. The element we use to deal with blocks of text is
the p element. It’s not difficult to remember: p is for paragraph! That’s just as
well, because you’ll almost certainly find yourself using this element more than
any other. And that’s the beauty of XHTML: most elements that you use fre-
quently are either very obvious, or easy to remember once you’re introduced to
them.

For People who Love Lists

Let’s imagine that you want a list on your web page. To include an ordered list
of items, we use the ol element. An unordered list—called “bullet points” by
the average person—makes use of the ul element. In both types of list, individual
points or list items are specified using the 1i element. So we use ol for an ordered
list, ul for an unordered list, and 1i for a list item. Easy!

To see this markup in action, type the following into a new text document, save
it as lists.html, and view it in the browser by double-clicking on the saved file’s
icon.

File: 1lists.html

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Lists - an introduction</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<h1>Lists - an introduction </h1>
<p>Here's a paragraph. A lovely, concise little paragraph.</p>
<p>Here comes another one, followed by a subheading.</p>
<h2>A subheading here</h2>
<p>And now for a list or two:</p>
<ul>
<1i>This is a bulleted list</li>
<1li>No order applied</1li>

Order the print version of this book to get all 500+ pages! 33



http://www.sitepoint.com/launch/81f2b9

Chapter 2: Your First Web Pages

<li>Just a bunch of points we want to make</li>
</ul>
<p>And here's an ordered list:</p>
<0l>
<1i>This is the first item</1li>
<li>Followed by this one</1i>
<1li>And one more for luck</li>
</ol>
</body>
</html>

How does it look to you? Did you type it all out? Remember, if it seems like a
lot of hassle to type out the examples, you can find all the markup in the code
archive, as I explained in the preface. However, bear in mind that simply copying
and pasting markup, then saving and running it, doesn’t really give you a feel for
what’s happening—it really will pay to learn by doing. Even if you make mistakes,
it’s still a better way to learn (you’ll be happy when you can spot your own errors
and fix them for yourself). When displayed in a browser, the above markup should
look like the page shown in Figure 2.9.

There are many, many different elements that you can use on your web page,
and we’ll meet more of them as our web site development progresses. As well as
the more obvious elements that you’ll come across, there are others that are not
immediately obvious: what would you use div, span, or a elements for? Any
guesses? Don’t worry, all will be revealed in good time.
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Figure 2.9. Using unordered and ordered lists to organize
information

) Lists - an introduction - Mozilla Firefox
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Lists - an introduction

Here's a paragraph. A lovely. concise little paragraph.

Here comes another one, followed by a subheading.

A subheading here

And now for a list or two:

+ This is a bulleted list
+ No order applied
+ Just a bunch of points we want to make

And here's an ordered list:

1. This is the first item
2. Followed by this one
3. And one more for uck

Done

Commenting your Web Pages

Back in the garage, you're doing a little work on your project car and, as you
prepare to replace the existing tires with a new set of low-profile whitewalls, you
notice that your hubcaps aren’t bolted on: you’d stuck them to the car with super
glue. There must have been a good reason for doing that, but you can’t remember
what it was. The trouble is, if you had a reason to attach the hubcaps that way
before, surely you should do it the same way again. Wouldn’t it be great if you’d
left yourself a note when you first did it, explaining why you used super glue in-
stead of bolts? Then again, your car wouldn’t look very nice with notes stuck all
over it. What a quandary!

When you’re creating a web site, you may find yourself in a similar situation.
You might build a site, then not touch it again for six months. Then, when you
revisit the work, you might find yourself going through the all-too-familiar head-
scratching routine. Fortunately, there is a solution!
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XHTML—like most programming and markup languages—allows you to use
comments. Comments are perfect for making notes about something you’ve
done and, though they’re included within your code, comments do not affect the
on-screen display. Here’s an example of a comment:

File: comments.html

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Comment example</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<p>I really, <em>really</em> like this XHTML stuff.</p>
<!-- Added emphasis using the em element. Handy one, that! -->
</body>
</html>

Figure 2.10 shows the page viewed on-screen.

Figure 2.10. The comment remains hidden in the on-screen display

* Comment example - Mozilla Firefox

File Edit Wew Go Bookmarks Tools Help
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I really, really like this XHTML stuff.

Done

Comments must start with <!--, after which you’re free to type whatever you
like as a “note to self.” Well, you're free to type almost anything: you cannot type
double dashes. Why not? Because that’s a signal that the comment is about to
end—the - -> part.

Oh, and did you spot how we snuck another new element in there? The emphasis
element, denoted with the <em> and </em> tags, is used wherever ... well, do I
really need to tell you? Actually, that last question was kind of rhetorical. It was
there to make a point: did you notice that the word “really” appeared in italics?
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Read that part to yourself now, and listen to the way it “sounds” in your head.
Now you know when to use the em element!

Using Comments to Hide Markup from Browsers
Temporarily

There is no limit to the amount of information you can put into a comment, and
this is why comments are often used to hide a section of a web page temporarily.
Commenting may be preferable to deleting content, particularly if you want to
put that information back into the web page at a later date (if it’s in a comment,
you won’t have to re-type it). This is often called “commenting out” markup.
Here’s an example:

File: commentout.html

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Commenting out XHTML</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<hi1>Current Stock</h1>
<p>The following items are available for order:</p>
<ul>
<li>Dark Smoke Window Tinting</1li>
<li>Bronze Window Tinting</1li>

<!-- <1li>Spray mount</1li>
<li>Craft knife (pack of 5)</li> -->
</ul>
</body>
</html>

Figure 2.11 shows how the page displays in Firefox.
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Figure 2.11. The final, commented list items are not displayed

*J Commenting out XHTML - Mozilla Firefox
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Current Stock

The following items are available for order:

+ Dark Smoke Window Tinting
+ Bronze Window Tinting

Done

Remember, you write a comment like this: <!--Your comment here followed
by the comment closer, two dashes and a right-angled bracket-->.

Symbols

Occasionally, you may need to include the greater-than (>) or less-than (<) symbols
in the text of your web pages. The problem is that these symbols are also used
to denote tags in XHTML. So, what can we do? Thankfully, we can use special
little codes called entities in our text instead of these symbols. The entity for
the greater-than symbol is &gt ;; we can substitute it for the greater-than symbol
in our text, as shown in the following simple example. The result of this markup
is shown in Figure 2.12.

File: entity.html

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Stock Note</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<p>0ur current stock of craft knives &gt; our stock of spray
mounts, but we still need to get both of them in as soon
as possible!</p>
</body>
</html>
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Figure 2.12. The &gt; entity is displayed as > in the browser

3 Stock Note - Mozilla Firefox
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Qur current stock of craft knives > our stock of spray mounts, but we still need to get both of them in as soon as possible!

Done

Many different entities are available for a wide range of symbols, most of which
don’t appear on your keyboard. They all start with an ampersand (&) and end
with a semicolon. Some of the most common are shown in Table 2.1.

Table 2.1. Some common entities

Entity Symbol
&gt; >
&lt; <
&amp; &
&pound; £
&copy; ©
&trade; ™

Diving into our Web Site

So far, we’ve looked at some very basic web pages as a way to ease you into the
process of writing your own XHTML markup. Perhaps you’ve typed them up
and tried them out, or maybe you’ve pulled the pages from the code archive and
run them in your browser. Perhaps you've even tried experimenting for your-
self—it’s good to have a play around. None of the examples shown so far are
keepers, though. You won’t need to use any of these pages, but you will be using
the ideas that we’ve introduced in them as you start to develop the fictitious
project we’ll complete in the course of this book: a web site for a local diving
club.

The diving club comprises a group of local enthusiasts, and the web site will
provide a way for club members to:
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[ share photos from previous dive trips

[ stay informed about upcoming dive trips

@ provide information about ad-hoc meet-ups

[ read other members’ dive reports and write-ups

@ announce club news

The site also has the following goals:

@ to help attract new members

@ to provide links to other diving-related web sites

@ to provide a convenient way to search for general diving-related information

The site’s audience may not be enormous, but the regular visitors and club
members are very keen to be involved. It’s a fun site that people will want to
come back to again and again, and it’s a good project to work on. But it doesn’t
exist yet! You're going to start building it right now. Let’s start with our first
page: the site’s home page.

The Homepage: the Starting Point for all Web
Sites

At the very beginning of this chapter, we looked at a basic web page with nothing
in it (the car chassis, with no bodywork or interior, remember?). You saved the
file as basic.html. Open that file in your text editor now, and strip out the fol-
lowing:

[ the text contained within the opening <title> and closing </title> tags
@ all the content between the opening <body> and closing </body> tags
Save the file as index.html.

Here’s the markup you should have in front of you now:
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File: index.html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title></title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
</body>
</html>

Let’s start building this web site, shall we?

Setting a Title

Remembering what we’ve learned so far, let’s make a few changes to this docu-
ment. Have a go at the following:

[ Change the title of the page to read “Bubble Under — The diving club for the
south-west UK.”

@ Add a heading to the page—a level one heading (hint, hint)—that reads
“BubbleUnder.com.”

@ Immediately after the heading, add a paragraph that reads, “Diving club for
the south-west UK — let’s make a splash!” (This is your basic, marketing-type
tag line, folks!)

Once you make these changes, your markup should look something like this (the
changes are shown in bold):

File: index.html
<!DOCTYPE html "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Bubble Under - The diving club for the south-west
UK</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
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<h1>BubbleUnder.com</h1>
<p>Diving club for the south-west UK - let's make a
splash!</p>
</body>
</html>

Save the page, then double-click on the file to open it in your chosen browser.
Figure 2.13 shows what it should look like.

Figure 2.13. Displaying our work on the homepage

3 Bubble Under - The diving club for the south-west UK - Mozilla Firefox

File Edit ‘Wew Go Bookmarks Tools  Help

I}
<:| - I_l - @ @ || Ffile:} /i jDocuments % 20and%: 205ettings matt. magain/My ¥ 20Documents/ @ Go @,

BubbleUnder.com

Diving club for the south-west TE - let's make a splash!

Done

Welcoming New Visitors

Now, let’s expand upon our tag line a little. We’ll add a welcoming subheading—a
second level heading—to the page, along with an introductory paragraph:

File: index.html (excerpt)

<body>
<h1>BubbleUnder.com</h1>
<p>Diving club for the south-west UK - let's make a splash!</p>
<h2>Welcome to our super-dooper Scuba site</h2>
<p>Glad you could drop in and share some air with us! You've
passed your underwater navigation skills and successfully

found your way to the start point - or in this case, our
home page.</p>
</body>

Apologies to anyone who doesn’t get my hilarious puns on diving terminology.
Come to think of it, apologies to those who do ... they’re truly cringe-worthy!
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Hey! Where’d it All Go?

IMPORTANT You’ll notice that we didn’t repeat the markup for the entire page in the
above example. Why? Because paper costs money, trees are beautiful, and
you didn’t buy this book for weight-training purposes. In short, we won’t
repeat all the markup all the time; instead, we’ll focus on the parts that have
changed, or have been added to. And remember: if you think you’ve missed
something, don’t worry. You can find all of the examples in the book’s code
archive.

Once you’ve added the subheading and the paragraph that follows it, save your
page once more, then take another look at it in your browser (either hit the re-
fresh/reload button in your browser, or double-click on the file icon in the location
at which you saved it). You should be looking at something like the display shown
in Figure 2.14.

Figure 2.14. The homepage taking shape
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BubbleUnder.com

Diving club for the south-west UK - let's make a splash!

Welcome to our super-dooper Scuba site

Glad wou could drop m and share some air with us! You've passed your underwater navigation skills and successfully found your
way to the start point - of i this case, our home page.

Done

So, the homepage reads a lot like many other homepages at this stage: it has some
basic introductory text to welcome visitors, but not much more. But what exactly
is the site about? Or, to be more precise, what will it be about once it’s built?

What’s it All About?

Notice that, despite our inclusion of a couple of headings and a couple of para-
graphs, there is little to suggest what this site is about. All visitors know so far is
that the site’s about diving. Let’s add some more explanatory text to the page,
along with some contact information:
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[ Beneath the content you already have on the page, add another heading: this
time, make it a level three heading that reads, “About Us” (remember to in-
clude both the opening and closing tags for the heading element).

[ Next, add the following text. Note that there is more than one paragraph.

Bubble Under is a group of diving enthusiasts based in the
south-west UK who meet up for diving trips in the summer
months when the weather is good and the bacon rolls are
flowing. We arrange weekends away as small groups to cut
the costs of accommodation and travel, and to ensure that
everyone gets a trustworthy dive buddy.

Although we’re based in the south-west, we don’t stay on our
own turf: past diving weekends have included trips up to
Scapa Flow in Scotland and to Malta’s numerous wreck sites.

When we’re not diving, we often meet up in a local pub to
talk about our recent adventures (any excuse, eh?).

Save yourself Some Trouble
note

If you don’t feel like typing out all this content, you can paraphrase, or
copy it from the code archive. I've deliberately chosen to put a realistic
amount of content on the page, so that you can see the effect of several
paragraphs on our display.

O Next, add a Contact Us section, again, signified by a level three heading.
[ Finally, add some simple contact details as follows:

To find out more, contact Club Secretary Bob Dobalina on
01793 641207 or email bob@bubbleunder.com.

So, just to recap, we suggested using different heading levels to signify the import-
ance of the different sections and paragraphs within the document. With that in
mind, you should have something like the markup below in the body of your
document:

File: index.html (excerpt)

<h1>BubbleUnder.com</h1>
<p>Diving club for the south-west UK - let's make a splash!</p>
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<h2>Welcome to our super-dooper Scuba site</h2>

<p>Glad you could drop in and share some air with us! You've
passed your underwater navigation skills and successfully
found your way to the start point - or in this case, our home
page.</p>

<h3>About Us</h3>

<p>Bubble Under is a group of diving enthusiasts based in the
south-west UK who meet up for diving trips in the summer
months when the weather is good and the bacon rolls are
flowing. We arrange weekends away as small groups to cut the
costs of accommodation and travel and to ensure that everyone
gets a trustworthy dive buddy.</p>

<p>Although we're based in the south-west, we don't stay on our
own turf: past diving weekends away have included trips up to
Scapa Flow in Scotland and to Malta's numerous wreck
sites.</p>

<p>When we're not diving, we often meet up in a local pub
to talk about our recent adventures (any excuse, eh?).</p>

<h3>Contact Us</h3>

<p>To find out more, contact Club Secretary Bob Dobalina on
01793 641207 or email bob@bubbleunder.com.</p>

Clickable Email Links

note
It’s all well and good to put an email address on the page, but it’s hardly
perfect. To use this address, a site visitor would need to copy and paste the
address into an email message. Surely there’s a simpler way? There certainly
is:

<p>To find out more, contact Club Secretary Bob Dobalina
on 01793 641207 or <a
href="mailto:bob@bubbleunder.com. ">email
bob@bubbleunder.com</a>.</p>

This clickable email link uses the a element, which is used to create links on
web pages (this will be explained later in this chapter). The mailto: prefix
tells the browser that the link needs to be treated as an email address (that
is, the email program should be opened for this link). The content that follows
the mailto: section should be a valid email address in the format user-
name@domain.

Add this to the web page now, save it, then refresh the view in your browser.
Try clicking on the underlined text: it should open your email program
automatically, and display an email form in which the To: address is already
completed.
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Figure 2.15. Viewing index.html
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BubbleUnder.com

Diving club for the south-west TE - let's make a splash!

Welcome to our super-dooper Scuba site

Glad wou could drop in and share some air with us! You've passed your underwater navigation skills and successfully found your
way to the start point - or i this case, our home page.

Abhout Us

Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up for diving trips in the summer months
when the weather 12 good and the bacon rolls are flowing. We arrange weekends away as small groups to cut the costs of
accommodation and travel and to ensure that everyone gets a trustworthy dive buddy

Although we're based in the south-west, we don't stay on our ewn tutf’ past diving weekends away have included trips up to
Scapa Flow in Scotland and to Malta's numerous wreck sites.

TWhen we're not diving, we often meet up in a local pub to talk about our recent adventures (aty excuse, eh?)
Contact Us

To find cut more, contact Chib Secretary Bob Dobaling en 01793 641207 or email bob@bubbleunder com

Done

It’s still not very exciting, is it? Trust me, we’ll get there! The important thing to
focus on at this stage is what the content of your site should comprise, and how
it might be structured. We haven’t gone into great detail about document structure
yet, other than to discuss the use of different levels of headings, but we’ll be
looking at this in more detail later in this chapter. In the next chapter, we’ll see
how you can begin to style your document—that is, change the font, color, letter
spacing and more—but for now, let’s concentrate on the content and structure.

The page so far seems a little boring, doesn’t it? Let’s sharpen it up a little. We
can only keep looking at a page of black and white for so long—let’s insert an
image into the document. Here’s how the img element is applied within the
context of the page’s markup:

46
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File: index.html (excerpt)
<h2>Welcome to our super-dooper Scuba site</h2>
<p><img src="divers-circle.jpg" width="200" height="162"
alt="A circle of divers practice their skills" /></p>
<p>Glad you could drop in and share some air with us! You've
passed your underwater navigation skills and successfully
found your way to the start point - or in this case, our home
page.</p>

Whoa, hold up there. Let’s talk about all this img stuff (don’t worry; it’s pretty
simple). The img element is used to insert an image into our web page, and the
attributes src, alt, width, and height describe the image that we’re inserting.
src is just the name of the image file. In this case, it’s divers-circle. jpg, which
you can grab from the code archive. alt is some alternative text that can be dis-
played in place of the image if, for some reason, it can’t be displayed. This is
useful for visitors to your site who may be blind (they have web browsers, too!),
search engines, and users of slow Internet connections. width and height should
be pretty obvious: they give the width and height of the image, measured in
pixels. Don’t worry if you don’t know what a pixel is; we’ll look into images in
more detail a bit later.

Figure 2.16. Divers pausing in a circle

Order the print version of this book to get all 500+ pages! 47



http://www.sitepoint.com/launch/81f2b9

Chapter 2: Your First Web Pages

Go and grab divers-circle.jpg from the code archive, and put it into your
web site's folder. The image is shown in Figure 2.16.

Open index.html in your text editor and add the following markup just after
the level two heading (h2):

File: index.html (excerpt)
<p><img src="divers-circle.jpg" width="200" height="162"
alt="A circle of divers practice their skills" /></p>

Save the changes, then view the homepage in your browser. It should look like
the display shown in Figure 2.17.

Figure 2.17. Displaying an image on the homepage
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BubbleUnder.com

Diving club for the south-west UK - let's make a splash!

Welcome to our super-dooper Scuba site

Glad vou could drop in and share some air with us! You've passed your underwater navigation skills and successfully found
your way to the start point - or in this case, our hotne page.

About Us

Bubble Under is a group of diving enthusiasts based in the south-west TTE who meet up for diving trips in the summer months
when the weather is good and the bacon rolls are flowing, We arrance weekends awav as small arouns to cut the costs of b

Done
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Adding Structure

Paragraphs? No problem. Headings? You've got them under your belt. In fact,
you’re now familiar with the basic structure of a web page. The small selection
of tags that we’ve discussed so far are fairly easy to remember, as their purposes
are obvious (remember: p = paragraph). But what the heck is a div?

A div is used to divide up a web page and, in doing so, to provide a definite
structure that can be used to great effect when combined with CSS.

The strange thing about a div is that, normally, it has no effect on the styling of
the text it contains, except for the fact that it adds a break before and after the
contained text. Consider the following markup:

<p>This is a paragraph.</p>
<p>So is this.</p>

If you were to change those paragraph tags to divs, there would be very little
obvious change in the page’s appearance when you viewed it in a browser (as
Figure 2.18 shows).

<p>This is a paragraph.</p>

<div>This looks like a paragraph, but it's actually a div.</div>
<p>This is another paragraph.</p>

<div>This is another div.</div>

Figure 2.18. Paragraphs displaying similarly to divs
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This is a paragraph.

This looks like a paragraph. but it's actually a div.

This is another paragraph.

This is another div.

Done

“But they look exactly the same! What’s the difference between using a div and
a p?”7, you may protest. Well, the purpose of a div is to divide up a web page
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into distinct sections, adding structural meaning, whereas p should be used to
create a paragraph of text.

Use Elements as Intended

IMPORTANT Never use an XHTML element for a purpose for which it was not intended.
This really is a golden rule!

Rather than leaving the paragraph tags as they are, you might decide to have
something like this:

<div>
<p>This is a paragraph inside a div.</p>
<p>So is this.</p>

</div>

You can have as many paragraphs as you like inside that div element, but note
that you cannot place div elements inside paragraphs. Think of a div as a con-
tainer that’s used to group related items together, and you can’t go wrong.

If we look at our homepage in the browser, it’s possible to identify areas that
have certain purposes. These are listed below, and depicted in Figure 2.19. We
have:

[ a header area that contains:
[ the site name
O atagline

@ an area of body content

Figure 2.19 shows how the different segments of content can be carved up into
distinct areas based on the purposes of those segments.

Take the homepage we’ve been working on (index.html) and, in your text editor
of choice, add <div> and </div> tags around the sections suggested in Figure 2.19.
While you're adding those divs, add an id attribute to each, appropriately alloc-
ating the names header, sitebranding, tagline, and bodycontent. Remember
that attribute names should be written in lowercase, and their values should be
contained within quotation marks.
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Figure 2.19. Noting distinct sections in the basic web page
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BubbleUnder.com Site Branding
I Header
Diving club for the south-west UK - let's make a splash! Tagline
Welcome to our super-dooper Scuba site
Body
Content

Glad vou could drop in and share some air with us! You've passed vour
underwater navigation skills and successfully found vour way to the start
point - or in this case, our home page.

Done

No Sharing ids!
Tip@

id attributes are used in XHTML to identify elements, so no two elements
should share the same id value. You can use these ids later, when you’re
dealing with elements via CSS or JavaScript.

h1, header, and head
Tip@

An id attribute set to header should not be confused with headings on the
page (h1, h2, and so on); nor is it the same as the head of your HTML page.
The id= attribute could just as easily have been named topstuff or
pageheader. It doesn’t matter, so long as the attribute name describes the
purpose of that page section to a fellow human being (or to yourself 12 months
after you devised it, and have forgotten what you were thinking at the time!).

To get you started, I've done a little work on the first part of the page. In the
snippet below, that section has been changed to a div with an id attribute:

File: index.html (excerpt)
<div id="header">
<h1>BubbleUnder.com</h1>
<p>Diving club for the south-west UK - let's make a splash!</p>
</div> <!-- end of header div -->
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Now, try doing the same: apply divs to the parts of the content that we've
identified as “site branding” and “tag line.”

Nesting Explained

We already know that divs can contain paragraphs, but a div can also contain
a number of other divs. This is called nesting. It’s not tricky, it’s just a matter
of putting one div inside the other, and making sure you get your closing tags
right.

<div id="outer">
<div id="nested1">
<p>A paragraph inside the first nested div.</p>
</div>
<div id="nested2">
<p>A paragraph inside the second nested div.</p>
</div>
</div>

As Figure 2.19 shows, some nesting is taking place: the “site branding” and “tag
line” divs are nested inside the “header” div.

The Sectioned Page: all Divided Up
All things being well, your XHTMUL should now look like this:

File: index.html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
“http://www.w3.0org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Bubble Under - The diving club for the south-west
UK</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<div id="header">
<div id="sitebranding">
<h1>BubbleUnder.com</h1>
</div>
<div id="tagline">
<p>Diving club for the south-west UK - let's make
a splash!</p>
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</div>
</div> <!-- end of header div -->
<div id="bodycontent">
<h2>Welcome to our super-dooper Scuba site</h2>
<p><img src="divers-circle.jpg" width="200" height="162"
alt="A circle of divers practice their skills" /></p>
<p>Glad you could drop in and share some air with us! You've
passed your underwater navigation skills and
successfully found your way to the start point - or in
this case, our home page.</p>
<h3>About Us</h3>
<p>Bubble Under is a group of diving enthusiasts based in
the south-west UK who meet up for diving trips in the
summer months when the weather is good and the bacon
rolls are flowing. We arrange weekends away as small
groups to cut the costs of accommodation and travel and
to ensure that everyone gets a trustworthy dive
buddy.</p>
<p>Although we're based in the south-west, we don't stay on
our own turf: past diving weekends away have included
trips up to Scapa Flow in Scotland and to Malta's
numerous wreck sites.</p>
<p>When we're not diving, we often meet up in a local pub
to talk about our recent adventures (any excuse,
eh?).</p>
<h3>Contact Us</h3>
<p>To find out more, contact Club Secretary Bob Dobalina on
01793 641207 or
<a href="mailto:bob@bubbleunder.com">email
bob@bubbleunder.com</a>.</p>
</div> <!-- end of bodycontent div -->
</body>
</html>

Indenting your Markup
Tip@

It’s a good idea to “indent” your markup when nesting elements on a web
page, as is demonstrated with the items inside the div section above. Indent-
ing your code can help resolve problems later, as you can more clearly see
which items sit inside other items. Note that indenting is only really useful
for the person—perhaps youl—who’s looking at the source markup. It does
not affect how the browser interprets or displays the web page.3

3The one exception to this is the pre element. Pre is short for pre-formatted, and any text marked
up with this element appears on the screen exactly as it appears in the source; in other words, carriage
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Notice that, in the markup above, comments appear after some of the closing
div tags. These comments are optional, but again, commenting is a good habit
to get into as it helps you fix problems later. Often, it’s not possible to view your
opening and closing <div> tags in the same window, as they’re wrapped around
large blocks of XHTML. If you have several nested <div> tags, you might see
something like this at the end of your markup:

</div>
</div>
</div>

In such cases, you might find it difficult to work out which div is being closed
off at each point. It may not yet be apparent why this is important or useful, but
once we start using CSS to style our pages, errors in the XHTML can have an
impact. Adding some comments here and there can really help you debug later.

</div> <!-- end of inner div -->
</div> <!-- end of nested div -->
</div> <!-- end of outer div -->

How does the web page look? Well, we’re not going to include a screen shot this
time, because adding those div elements should make no visual difference at all.
The changes we just made are structural ones that we’ll build on later.

Show a Little Restraint
hote

Don’t go overboard adding divs. Some people can get carried away as they
section off the page, with <div> tags appearing all over the place. Overly
enthusiastic use of the div can result in a condition that has become known
as “div-itis.” Be careful not to litter your markup with superfluous <div>
tags just because you can.

Splitting Up the Page

We’ve been making good progress on our fictitious site ... but is a web site really
a web site when it contains only one page? Just as the question, “Can you have
a sentence with just one word?” can be answered with a one-word sentence
(“Yes”), so too can the question about our one-page web site. But it’s not really
ideal, is it? You didn’t buy this book to learn how to create one page, did you?

returns, spaces, and any tabs that you’ve included will be honored. The pre element is usually used
to show code examples.
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Let’s take a look at how we can split the page we’ve been working on into separate
entities, and how these pages relate to each other.

First, let’s just ensure that your page is in good shape before we go forward. The
page should reflect the markup shown in the last large block presented in the
previous section (after we added the <div> tags). If not, go to the code archive
and grab the version that contains the divs (/chapter2/web-
site_files/05_with_divs/index.html). Save it as index.html in your web
site’s folder (if you see a prompt that asks whether you want to overwrite the
existing file, click Yes).

Got that file ready? Let’s break it into three pages. First, make two copies of the
file:

@ Click on the index.html icon in Windows Explorer or Finder.
[ To copy the file, select Edit > Copy.

1 To paste a copy in the same location, select Edit > Paste.

@ Repeat the process once more.

You should now have three HTML files in the folder that holds your web site
files. The index.html file should stay as it is for the time being, but take a mo-
ment to rename the other two (select each file in turn, choosing File > Rename,
if you’re using Windows; Mac users, simply select the file by clicking on it, then
hit Return to edit the filename).

O Rename one file as contact.html (all lowercase).

O Rename the other one as about.html (all lowercase).

Where’s my File Extension?
Tip@

If your filename appears as just index in Windows Explorer, your system
is currently set up to hide extensions for files that Windows recognizes. To
make the extensions visible, follow these simple steps:

1. Launch Windows Explorer.

2. For Windows ME/2000/XP, select Tools > Folder Options... (on Win-
dows 98, this is View > Folder Options...).

3. Select the View tab.
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4. In the Advanced Settings group, make sure that Hide extensions for
known file types does not have a tick next to it.

We have three identical copies of our XHTML page. Now, we need to edit the
content of these pages so that each page includes only the content that’s relevant
to that page.

To open an existing file in Notepad, select File > Open..., and in the window that
appears, change Files of type to All Files. Now, when you go to your Web folder,
you’ll see that all the files in that folder are available for opening.

Opening a file in TextEdit is a similar process. Select File > Open... to open a
file, but make sure that Ignore rich text commands is checked.

In your text editor, open each page in turn, and edit them as follows (remembering
to save your changes to each before you open the next file):

index.html Delete the “About Us” and “Contact Us” sections (both the
headings and the paragraphs that follow them), ensuring that
the rest of the markup remains untouched. Be careful not to
delete the <div> and </div> tags that enclose the body content.

about.html Delete the introductory spiel (the level two heading and asso-
ciated paragraphs, including the image) and remove the
“Contact Us” section (including the heading and paragraphs).

contact.html  You should be getting the hang of this now (if you're not sure
you’ve got it right, keep reading: we’ll show the altered markup
in a moment). This time, we’re removing the introductory spiel
and the “About Us” section.

Now, each of the three files contains the content that suits its respective filename,
but a further change is required for the two newly created files. Open about.html
in your text editor and make the following amendments:

@ Change the contents of the title element to read “About BubbleUnder.com:
who we are; what this site is for.”

@ Change the level three heading <h3>About Us</h3> to a level two heading.
In the process of editing our original homepage, we’ve lost one of our heading
levels. Previously, the “About Us” and “Contact Us” headings were marked
up as level three headings that sat under the level two “Welcome” heading.
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It’s not good practice to skip heading levels—an h2 following h1 is preferable
to an h3 following an h1.

Next, open contact.html in your text editor and make the following changes:

O Amend the contents of the title element to read, “Contact Us at Bubble
Under.”

[ Change the level three heading to a level two heading, as you did for
about.html.

If everything has gone to plan, you should have three files named index.html
about.html, and contact.html.

The markup for each should be as follows:

File: index.html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Bubble Under - The diving club for the south-west
UK</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<div id="header">
<div id="sitebranding">
<h1>BubbleUnder.com</h1>
</div>
<div id="tagline">
<p>Diving club for the south-west UK - let's make a
splash!</p>
</div>
</div> <!-- end of header div -->
<div id="bodycontent">
<h2>Welcome to our super-dooper Scuba site</h2>
<p><img src="divers-circle.jpg"
alt="A circle of divers practice their skills"
width="200" height="162" /></p>
<p>Glad you could drop in and share some air with us! You've
passed your underwater navigation skills and
successfully found your way to the start point - or in
this case, our home page.</p>
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</div> <!-- end of bodycontent div -->
</body>
</html>

File: about.html

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"“http://www.w3.0org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>About Bubble Under: who we are, what this site is
for</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<div id="header">
<div id="sitebranding">
<h1>BubbleUnder.com</h1>
</div>
<div id="tagline">
<p>Diving club for the south-west UK - let's make a
splash!</p>
</div>
</div> <!-- end of header div -->
<div id="bodycontent">
<h2>About Us</h2>
<p>Bubble Under is a group of diving enthusiasts based in
the south-west UK who meet up for diving trips in the
summer months when the weather is good and the bacon
rolls are flowing. We arrange weekends away as small
groups to cut the costs of accommodation and travel and
to ensure that everyone gets a trustworthy dive
buddy.</p>
<p>Although we're based in the south-west, we don't stay on
our own turf: past diving weekends away have included
trips up to Scapa Flow in Scotland and to Malta's
numerous wreck sites.</p>
<p>When we're not diving, we often meet up in a local pub
to talk about our recent adventures (any excuse,
eh?).</p>
</div> <!-- end of bodycontent div -->
</body>
</html>
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File: contact.html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Contact Us at Bubble Under</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
</head>
<body>
<div id="header">
<div id="sitebranding">
<h1>BubbleUnder.com</h1>
</div>
<div id="tagline">
<p>Diving club for the south-west UK - let's make a
splash!</p>
</div>
</div> <!-- end of header div -->
<div id="bodycontent">
<h2>Contact Us</h2>
<p>To find out more, contact Club Secretary Bob Dobalina on
01793 641207 or <a
href="mailto:bob@bubbleunder.com">email
bob@bubbleunder.com</a>.</p>
</div> <!-- end of bodycontent div -->
</body>
</html>

Linking Between our New Pages

We’ve successfully created a three-page web site, but there’s a small problem:
there are no links between the pages! Try for yourself: open index.html and take
a look at the display. How will you get from one page to another?

To enable site visitors to move around, we need to add navigation. Navigation
relies on anchors, which are more commonly referred to as links. The XHTML
for an anchor, or link, is as follows:

<a href="filename.html">Link text here</a>

The a element might not be intuitive (it stands for “anchor”), but you’ll get to
know this one very quickly: it’s what the Web is built on! There are almost as
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many links in use on the Web as there are Elvis impersonators in Las Vegas. Al-
most.

@ The a element contains the link text that will be clicked (which, by default,
appears on the screen as blue, underlined text).

@ The href attribute refers to the URL to which you’re linking (be that a file
stored locally on your computer, or a page on a live web site). Unfortunately,
again, href is not immediately memorable (it stands for “hypertext reference”),
but you’ll use it so often that you’ll soon remember it.

Don’t Click Here!

hote
The link text—the words inside the anchor element, which appear underlined
on the screen—should be a neat summary of that link’s purpose (to “email
bob@bubbleunder.com,” for example). All too often, you’'ll see people asking
you to “Click here to submit an image,” or “Click here to notify us of your
change of address.” Never use “Click here” links—it really is bad linking
practice and is discouraged for usability and accessibility reasons.

Let’s create a simple navigation menu that you can drop into your pages. Our
navigation is just a list of three links. Here’s the markup:

<ul>
<li><a href="index.html">Home</a></1li>
<li><a href="about.html">About Us</a></1li>
<li><a href="contact.html">Contact Us</a></1li>
</ul>

We'll place all of this inside a div, so we can quickly and easily see what this
block of XHTML represents.

<div id="navigation">
<ul>
<li><a href="index.html">Home</a></1li>
<li><a href="about.html">About Us</a></1li>
<li><a href="contact.html">Contact Us</a></1li>
</ul>
</div> <!-- end of navigation div -->

Now, we just need to paste this markup into an appropriate place on each of our
pages. A good position would be just after the header has finished, before the

4VVhy ‘Click here’ is bad linking practice [http://www.cs.tut.fi/~jkorpela/www/click.html], Jukka Korpela.
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main body content starts. In the code below, the navigation block appears in
position on the homepage:

File: index.html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
“http://www.w3.0org/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Bubble Under - The diving club for the south-west
UK</title>
<meta http-equiv="Content-Type" content="text/html;
charset=utf-8" />
</head>
<body>
<div id="header">
<div id="sitebranding">
<h1>BubbleUnder.com</h1>
</div>
<div id="tagline">
<p>Diving club for the south-west UK - let's make a
splash!</p>

</div>
</div> <!-- end of header div -->
<div id="pavigation">

<ul>

<li><a href="index.html">Home</a></1li>
<li><a href="about.html">About Us</a></1li>
<li><a href="contact.html">Contact Us</a></1li>
</ul>
</div> <!-- end of navigation div -->
<div id="bodycontent">
<h2>Welcome to our super-dooper Scuba site</h2>
<p><img src="divers-circle.jpg" width="200" height="162"
alt="A circle of divers practice their skills" /></p>
<p>Glad you could drop in and share some air with us!
You've passed your underwater navigation skills and
successfully found your way to the start point - or in
this case, our home page.</p>
</div> <!-- end of bodycontent div -->
</body>
</html>

You should now be looking at a page like the one shown in Figure 2.20.
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Figure 2.20. Displaying simple navigation on the page
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BubbleUnder.com

Diving club for the south-west UK - let's make a splash!
+ Home

+ About TTs
* Contact Us

Welcome to our super-dooper Scuba site

Glad you could drop in and share some air with us! You've passed your underwater nawigation skills and successfully found your
way to the start point - ot in this case, our home page.

Dane

Add the links to contact.html and about.html, then try clicking on the links
that you've just added. It should be possible to flick between all three pages, as
shown in Figure 2.21.

This is a landmark: you’re now the creator of a working, navigable web site! Don’t
crack open the bubbly just yet, though: first, let's discuss a few more XHTML
elements that you can add to your pages.
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Figure 2.21. Navigating the web site
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Done

Dane

Although we are based in the South West. we don't stav on our own turf: past diving weekends i3

Dane

The blockquote (Who Said That?)

We’re going to add a sound-bite—well, a written quote, to be precise—to the
About Us page. Here’s the line:

“Happiness is a dip in the ocean followed by a pint or two of Old
Speckled Hen. You can quote me on that!”

We’ll add the quote after the final paragraph in about.html; here’s the markup
you’ll need:

<blockquote>
<p>"Happiness is a dip in the ocean followed by a pint or two of

0l1d Speckled Hen. You can quote me on that!"</p>
</blockquote>

Or is it? Who’s doing the talking? Well, it’s our dear (though fictional) Club
Secretary, Bob Dobalina.
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File: about.html (excerpt)

<p>0r as our man Bob Dobalina would put it:</p>

<blockquote>

<p>"Happiness is a dip in the ocean followed by a pint or two of

0ld Speckled Hen. You can quote me on that!"</p>
</blockquote>

The quotation can contain as many paragraphs as you like, as long as each one
starts and ends correctly, and the opening <blockquote> tag is closed off properly.

Displaying blockquotes

hote

In most browsers, your use of blockquote will see the quoted text indented
in the page display. This effect can be overridden if it’s not to your taste,
but that’s something we’ll cover in a later chapter. On the flip side, you
should never use the blockquote element for the purposes of indenting text.
This is very poor form. Only use blockquote for its intended purpose: to
present a quotation. There are other, better ways to create visual indentations.

Figure 2.22 shows how the blockquote above will appear on the page.

Figure 2.22. Displaying a quotation on the page

2 ibout Bubble Under: who we are, what this site is for - Mozilla Firefox

fle Edt Yew Go Bockmarks ook Hebp
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BubbleUnder.com
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+» Home
* About Us
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About Us

Bubble Under iz a group of diving enthusi basedin the south t K who meet up for diving trips in the summer months
when the weather is good and the bacon rolls are flowing, We arrange weekends away as small groups to cut the costs of
accommodation and travel and to ensure that everyene gets a trustworthy dive buddy.

Although we're based in the south-west, we don't stay on our own turf past diving weelkends away have included tnps up to
Scapa Flow in Scotland and to Malta's numerous wreck sites

When we're not diving, we often meet up in a local pub to talk about our recent adventures {any excuse, eh?)
Or as our man Bob Dobalina would put it

"Happmess is a dip m the ocean followed by a pme or two of Old Speckled Hen You can quote me on thatl”
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The cite Element

If the quote to which you’ve referred is written elsewhere—in a magazine, for
instance, or a book, or even your own web site—you can add some information
to communicate the quote’s source. One way is to use the cite element. A cita-
tion, by default, will style the text in italics. Here’s how the markup would look
for a citation:

<p>I remember reading <cite>Salem's Lot</cite> by Stephen King as
a child, and being very scared of the dark for days after.</p>

If the citation includes a web page to which you can refer, this information can
also be displayed. Strangely, the cite element has an optional cite attribute.
Weird. How did that one get through the approval process? Anyway, here’s how
it looks:

<p>0One of my favorite travel writers is Pete Moore. I particularly
liked <cite cite="http://www.petermoore.net/">Swahili For The
Broken Hearted</cite>.</p>

We’re not using the cite element in the diving web site, but you may find it
useful in your own web site projects.

strong and em

We mentioned the em element earlier in this chapter. It’s a fairly straightforward
element to remember. If you can imagine yourself adding some kind of inflection
as you say a word, then emphasis is probably what you need. If you're looking
to strike a slightly more forceful tone, then you should consider “going in strong.”

By default, adding em will style text in italics, while using strong makes the text
bold. You can combine the two if you want, but usually, one or the other will
suffice. The examples below should help you understand what these elements
are used for. Figure 2.23 shows how they appear in the browser.

<p>Although Jimmy was told to <strong>never</strong> put his hands
on the exhaust pipe, he <em>still</em> couldn't help
himself.</p>
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Figure 2.23. Displaying different emphasis styles in the browser
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Although Jimmy was told to never put his hands on the exhaust pipe. he s#ill couldn't help himself.

Done

Taking a Break

The chapter’s almost at an end, so why take a break? Well, this is just an excuse
for a headline pun! We have one more element to look at: the break element.

The break element (br) basically replicates what happens when you hit the carriage
return on an old typewriter. To create a paragraph on an old typewriter, you’'d
hit Enter twice to give the necessary spacing. In XHTML, the fact that you're
marking up a paragraph with <p> and </p> tags means the spacing is worked out
for you automatically. However, if you just want to signify the start of a new line,
rather thgm a new paragraph, the element you need is br, as demonstrated in this
limerick:

<p>The limerick packs laughs anatomical,<br />
Into space that is quite economical.<br />
But the good ones I've seen,<br />

So seldom are clean,<br />

And the clean ones so seldom are comical.</p>

@ Avoid Multiple Breaks

IMPORTANT It’s all too easy to resort to using multiple breaks in a web page to achieve
a visual effect. If you find yourself doing this, something’s wrong: you almost
certainly need to look for a more suitable technique (we’ll look at how this
visual affect should be achieved later). Be careful in your use of br.

Note that br is an empty element, just like meta and img, so it’s written as <br />.

> http://fen.wikipedia.org/wiki/Limerick_(poetry)
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Summary

Summary

Wow—what a great start we’ve made! In this chapter, you've built a single web
page gradually into three linked pages. You've become familiar with the most
commonly used XHTML tags, as well as some of the less common ones that you
can apply to your web pages. But, somehow, despite all your efforts, the web
pages are still looking a little on the bland side. We’re going to fix that very soon:
in the next chapter, we’ll start to add some splashes of color, and make the site
look a little more like a fun diving site and less like a boring old Word document.
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Adding Some Style

In Chapter 1 and Chapter 2, we stepped through the process of setting up your
computer so that we could develop web sites, and pulled together the beginnings
of a web site with which you could impress your friends and family! The trouble
is, when you came to show off your fledgling site to your nearest and dearest,
they weren’t impressed!

“That’s nice dear,” said your better half, then carried on doing the dishes. Even
Rover (normally your biggest fan), was singularly unimpressed, and decided it
would be better to curl up in a warm corner until you stopped waving the laptop
in his face. What have you done wrong?

The answer is: nothing. It’s true that the web site may look a little bland at present,
but the underlying structure on which it’s built is rock-solid. To return to our
automotive analogy, you now have a perfect chassis and some decent bodywork,
and, while your car’s not making people turn their heads just yet, it’s only a
matter of time. Just let them see what you can do with this rolling shell!

In this chapter, we’ll begin the process of adding that lick of paint to your other-
wise plain site. The tool for the job is Cascading Style Sheets—CSS to those
in the know (or with limited typing abilities). Let’s take a look at what CSS can
do for you.




Chapter 3: Adding Some Style

What is CSS?

As this chapter revolves almost exclusively around CSS, it’s probably a good idea
to begin with a basic discussion of what CSS is, and why you should use it. As
we’ve already mentioned, CSS stands for Cascading Style Sheets, but that’s too
much of a mouthful for most people—we’ll stick with the abbreviation!

CSS is a language that allows you to change elements such as text size, color,
bolding, background colors, border styles, and colors—even the position of ele-
ments on the page. Let’s take a look at some CSS in action; we’ll start by learning
about inline styles.

Inline Styles

If you’re familiar with Microsoft Word (or a similar word processing package),
you may well have created your fair share of flyers, advertisements, or personal
newsletters (as well as the more mundane letters to the local authorities and so
on). In doing so, you’ve probably used text formatting options to color certain
parts of your text. It’s as simple as highlighting the words you want to change,
then clicking on a color in a drop-down palette. The same effect can be achieved
in XHTML using a little bit of inline CSS. This is what it looks like:

<p style="color: red">The quick brown fox jumped over the lazy
dog.</p>

In the example above, we use a style attribute inside the opening <p> tag. Ap-
plying a style to a specific XHTML element in this way is known as using an
“inline style.”

The style attribute can contain one or more declarations between its quotation
marks. A declaration is made up of two parts: a property, and a value for that
property. In the example above, the declaration is color: red (color being the
property and red being its value).

If you wanted to, you could add another declaration to the example above. For
instance, as well as having the text display in red, you might want it to appear
in a bold typeface. The property that controls this effect is font-weight; it can
have a range of different values, but mostly you’ll use normal or bold. As you

might expect, you’d use the following markup to make the paragraph red and
bold:
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<p style="color: red; font-weight: bold">The quick brown fox
jumped over the lazy dog.</p>

Notice that a semicolon separates the two declarations. You could carry on adding
styles in this way, but beware: this approach can get messy! There are cleverer
ways to apply styling, as we’ll see very soon.

Adding Inline Styles

Open about.html in your text editor, and add an inline style. We want to make
the text in the first paragraph after the “About Us” heading bold and blue. Refer
to the previous example as you create the style.

Does the markup for your paragraph look like this?

<p style="color: blue; font-weight: bold;">Bubble Under is a group
of diving enthusiasts based in the south-west UK who meet up
for diving trips in the summer months when the weather is good
and the bacon rolls are flowing. We arrange weekends away as
small groups to cut the costs of accommodation and travel and
to ensure that everyone gets a trustworthy dive buddy.</p>

If the markup does look like that shown here, save about.html and take a look
at it in your browser. It should appear like the page shown in Figure 3.1.
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Figure 3.1. Content displaying with blue and bold styles
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Dane

The span Element

You can easily color a whole paragraph like this, but more often than not, you’ll
want to pick out just a couple of specific words to highlight within a paragraph.
You can do this using a span element, which can be wrapped around any content
you like. Unlike p, which means paragraph or blockquote, which signifies a
quotation, span has no “meaning.” A span is little more than a tool for hlghhght-
ing the start and end of something to which you want to apply a style Instead
of making that whole paragraph blue, we might want just the first two words,
“Bubble Under,” to be blue and bold. Here’s how we can use the span element
to achieve this:

<p><span style="color: blue; font-weight: bold;">Bubble
Under</span> is a group of diving enthusiasts based in the
south-west UK who meet up for diving trips in the summer
months when the weather is good and the bacon rolls are

! Applying a span also gives you the ability to do some other clever things to your web page with
scripting, but for our purposes, its scope is limited to the things it allows you to do with CSS.
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flowing. We arrange weekends away as small groups to cut the
costs of accommodation and travel and to ensure that everyone
gets a trustworthy dive buddy.</p>

When we view that markup in a browser, we see the display shown in Figure 3.2.

Figure 3.2. Using the span element to pick out specific words for
styling
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Done

Let’s take a quick look at other ways that we can apply inline styles (don’t worry;,
this isn’t part of our project site; feel free to experiment).

<p style="font-style: italic">The quick brown fox jumped over the
lazy dog.</p>

Not surprisingly, that CSS declaration will italicize all the text in the paragraph.
Here’s another example, in which span is used to highlight specific words:

<p>The quick brown fox <span style="font-style: italic;
font-weight: bold">jumped</span> over the lazy dog.</p>
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Embedded Styles

Inline styles are a simple, quick way to apply some “makeup” to specific sections
of a document, but this is not the best method of styling a page. Wouldn’t it be
better if you could set styles in just one place, rather than having to type them
out every time you wanted to use them?

Embedded style sheets are a logical step up. An embedded style allows you to
add to the start of a web page a section that sets out all the styles that will be
used on that page. To do this, you need to use the style element inside the head:

<head>
<title>Bubble Under - The diving club for the south-west
UK</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
<style type="text/css">

p {
font-weight: bold;

}
</style>
</head>

In the markup shown above, we’ve moved the inline style into an embedded style
sheet. The embedded style sheet starts with a <style type="text/css"> tag
and, predictably, ends with a </style> tag. The actual style declarations are en-
closed in a set of curly braces: { and }. The p that appears before the first curly
brace tells the browser what the style rules are for; in this case, we’re making the
text inside every p element bold. The p is called the selector, and it’s a great tool
for quickly and easily changing the appearance of lots of elements on your page.
The selector, curly braces, and declarations combine to make up what’s called a
rule.

In this case, our style sheet contains one rule: “Please style all the paragraphs on
this page so that the text appears in a bold font.”

If we wanted to, we could add more declarations to our rule. For instance, if we
wanted to make the text bold and blue, we’d add the declaration color: blue
to our rule:

<style type="text/css">

p {
font-weight: bold;
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color: blue;

}
</style>

Jargon Break

Okay, okay. There’s been an awful lot of jargon so far. Let’s recap: Figure 3.3
brings the theory into focus.

Figure 3.3. The anatomy of a rule

| Selector ‘ ‘ Curly Brace ‘

p i
font-weight: bold;

color: blue;

o

| Property ‘ | Value ‘

Why Embedded Styles are Better than Inline
Styles

In the example provided in Figure 3.3, text in all paragraphs will display in bold,
blue type. This is useful because it saves you having to type <p style="font-
weight: bold; color: blue"> every time you start a new paragraph—a clear
benefit over inline styles. If you wanted to change the color of all paragraph text
to red, you need only to change it in the style sheet at the top of the page. That’s
efficiency for you!

<style type="text/css">

p {
font-weight: bold;

color: red;

}
</style>

For this reason, an embedded style sheet is a marked improvement over inline
styles. But what if you have a web site that comprises many pages? If you want
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to make your changes across the whole site, using embedded style sheets in the
way I demonstrated above is still not quite the perfect solution. Why not? Because,
to make a site-wide change, you’d have to edit the embedded style sheet on every
single page of that site. The best solution is to use an external style sheet.

External Style Sheets

Why External Style Sheets are Better than
Embedded Styles

An external style sheet provides a location in which you can place styles that can
be applied on all of your web pages. This is where the true power of CSS lies,
and it’s for this reason that we haven’t spent too much time applying inline styles
or embedded styles to our diving club project site.

The Bad Old Days

In the past, or The Bad Old Days, as we’ll call them, people would create web
sites on a page-by-page basis, and style them on a page-by-page basis using all
manner of nasty elements of which I dare not even speak! Sometimes, these sites
grew beyond the webmaster’s wildest imagination. “Fantastic,” thought Mr or
Mrs Webmaster. “My web site now has over 200 pages! Soon I'll be bigger than
Microsoft.” A few months later, the webmaster decided to redesign the web site
and realized, with considerable horror, that he or she would have to alter each
and every single web page in order to redesign the site in a consistent manner.
Every page needed 20 or more different tweaks, and each tweak had to be applied
consistently to every page of the site. Inevitably, some pages were missed, and
eventually the redesign plan got unceremoniously dropped. In short, the ugly
web site remained ugly for a whole lot longer before dying a nasty death through
sheer negligence (indeed, there are many such “legacy” documents littered around
the Web today). This need not be the case, though.

CSS gives you the power to set styling rules in one place. When you want to
make changes to your web site, you make changes in that one place, and your
whole web site changes automatically to reflect those new styles.

76 Order the print version of this book to get all 500+ pages!



http://www.sitepoint.com/launch/81f2b9

Creating an External CSS File

Happy Days! CSS Support is Here!

The good news is that the large majority of web browsers in use today offer excel-
lent support for CSS (though this has not always been the case, which is why
some people have been slow to adopt CSS-based design). Some browsers can
choke on a few of the more advanced CSS techniques, but, by and large, you can
style your web pages with CSS and be confident that what you see on your screen
is the same view that 99.5% of your intended audience will see.

Creating an External CSS File

If you are to make use of all the benefits that an external style sheet can provide,
you’ll first need to create a CSS file that can be shared among all the pages of
your web site. Open your text editor and enter the following:

File: stylel.css
/*
CSS for Bubble Under site
*/

p {
font-weight: bold;

color: blue;

}

Save the file in the same folder as your HTML files, naming it style1.css; you
can save a CSS file in the same way you saved your HTML files.

Note that the first few lines we typed into our CSS file will not actually do any-
thing. Like HTML, CSS allows you to add comments. It’s a shame that the tags
for HTML comments are different from those for CSS comments, but they do
exactly the same thing: they allow you to make notes about your work without
affecting the on-screen display. In CSS, a comment starts with a /* and ends
with a */; the browser ignores anything in between. Above, we used the comment
simply to make a note about the purpose of the file, namely that it is the CSS
for the Bubble Under site. We’ve also added a rule to turn the type in all our
paragraphs bold and blue.

Linking CSS to a Web Page

Before your CSS can have any effect, you need to link it to the web page, or
pages, to which you want the styles to apply. To do this, you need to add a 1link
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element to the head of each and every web page that will be styled with CSS.
Our site contains just three pages at the moment, so this will be nice and easy.
The 1ink element simply “links” a file to the page on which the element appears;
in this case, the linked file is a style sheet.

Below, the new line appears in the context of the homepage:

File: index.html (excerpt)

<head>
<title>Bubble Under - The diving club for the south-west
UK</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
<link href="stylel.css" rel="stylesheet" type="text/css" />
</head>

Let’s take a loolk at what the markup means.

The href attribute tells the web browser where the style sheet file (stylel.css)
can be found, in the same way that the href attribute is used in an anchor to
point to the destination file (e.g. <a href="home.htm">Home</a>).

The rel="stylesheet" and type="text/css" parts of the link tag tell the browser
what kind of file is being linked to, and how the browser should handle the con-
tent. You should always include these important attributes when linking to a
.css file.

Empty Element Alert!

hote
The 1ink element is another of those special empty elements we discussed
in Chapter 2: it has no start or end tags. 1ink is a complete element in its
own right, and ends with the space and forward slash required by XHTML.

Now that we know how to link our pages to our CSS file, let’s try it out on our
project site:

@ Open each of your web pages—index.html, about.html, and con-
tact.html—in your text editor. Add the following line just before the closing
</head> tag in each of those files.

<link href="stylel.css" rel="stylesheet" type="text/css" />

@ Be sure to save each page. Then, try opening each one in your web browser.
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All of your paragraphs should now display in bold, blue text. If so, congratula-
tions—you’ve now linked one style sheet to three separate pages. If you change
the color specified in your . css file from blue to red, you should see that change
reflected across your pages the next time you open them.

Now, using blue, bold text might be a good way to make sure your style sheets
are correctly linked, but it’s not necessarily the design effect we want to use. Re-
move the p rule from your style sheet, but leave the comment, and let’s start
building our style sheet for real.

Starting to Build our Style Sheet

The style sheet is ready to be used: it’s saved in the right location, and all of your
web pages (all three—count ’em!) are linked to it correctly. All we need to do,
then, is set some styles!

One of the first changes that people often make to a web site’s default styling is
to alter the font (or typeface) that’s used. On Windows, most browsers will opt
for Times New Roman—the font that has been used in all the screen shots we’ve
seen so far. For many people, though, it’s a little bit dull, probably because this
font is used more than any other. It’s very easy to change fonts using CSS’s font -
family property. The best place to use this is within the body element, as shown
below.

File: stylel.css
/*
CSS for Bubble Under site
*/

body {
font-family: Verdana;

}

Here, I've chosen to use the Verdana font. It’s applied to the body element because
body contains every element that you will see on the web page. The nature of
the way in which CSS is applied means that every element contained in the body
element will take on the same font (unless another font is specified for a given
element or elements within body—but more on that a little later).

Great: Verdana it is! But ... what if some people who view your site don’t have
Verdana installed on their computers? Hmm, that’s a tricky one. The short answer
is that the browser will make its best guess about which font it should use instead,
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but we don’t have to make the browser do all the guesswork. The font-family
property allows us to enter multiple fonts in the order in which we’d prefer them
to be used. So, we could type something like this:

body {
font-family: Verdana, Helvetica, Arial, sans-serif;

}

This translates as: “Please style everything in the body of my web page so that
the text appears as Verdana. Failing that, please try using Helvetica and, failing
that, Arial. If none of the above are installed, just use whatever sans-serif font is
available.”

We'll use this selection of fonts in our diving site, so let’s open the style sheet
file and play around with some CSS.

@ Type the above CSS into stylet.css.
@ Save the file, then open the homepage (index.html) in your browser.

If everything went to plan, your web page (all three of them, actually) should
display slightly differently than they did before. Figure 3.4 shows the appearance
of our newly-styled homepage.

Sans-serif Fonts: Better for On-screen Viewing
Tip@

A serif font is one that has all those fancy extensions and flourishes at the
ends of each letter. These “flourishes,” which are shown in Figure 3.5, are
known as serifs. They’re great for reading printed material, as they give a
little shape to the words, making them easier to read.

However, on the screen, serif fonts can become a little messy, especially when
they’re used for smaller type—there simply aren’t enough pixels on the screen
to do these little flourishes justice. For this reason, you'll notice that many
web sites use sans-serif fonts (French words that literally mean “without
serif”) when the font size is set quite small.

Note that when you refer to a sans-serif font in CSS, you must hyphenate
the two words, i.e. sans-serif.
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Figure 3.4. A font change in the style sheet affects the body of
our web pages
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About Us

Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up
for diving trips In the summer months when the weather 1s good and the bacon rolls are
flowing. We arrange weekends away as small groups to cut the costs of accommodation
and travel and to ensure that everyone gets a trustworthy dive buddy,

Although we're based in the south-west, we don't stay on our own turf, past diving
weekends away have Included trips up to Scapa Flow in Scotland and to Malta's numerous
wrack sites,

When we're not diving, we often meet up in a local pub to talk about our recent
adventures (any excuse, h?).

Cr as our man Bob Dobalina would put it:
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Figure 3.5. Highlighting the serifs of a serif font (Georgia)
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Stylish Headings

The first element that we’ll style is our level 1 headings, denoted by the h1 ele-
ment. Let’s add some rules to our CSS file to see what’s possible when it comes
to those headings. In your text editor, add the following to stylet.css:

h1 {
font-family: "Trebuchet MS", Arial, Helvetica, sans-serif;

}

Save the CSS file and refresh your view of the homepage in your browser. Can
you see what’s changed? All the first-level headings now display in the Trebuchet
MS font, while everything else displays in Verdana.

The font we’ve chosen is another sans-serif font, but it’s different enough to
provide plenty of contrast with the paragraphs, as Figure 3.6 illustrates.

Figure 3.6. h1 headings displaying in one font (Trebuchet MS)
while other text displays in another (Verdana)
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Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up
for diving trips in the summer months when the weather is good and the bacon rolls are
flowing. We arrange weekends away as small groups to cut the costs of accommodation
and travel and to ensure that everyone gets a trustworthy dive buddy.

Although we're based in the south-west, we don't stay on our own turf. past diving
weekends away have included trips up to Scapa Flow in Scotland and to Malta's numerous
wreck sites.

wWhen we're not diving, we often meet up in a local pub to talk about our recent
adventures (any excuse, eh?).

Or as our man Bob Dobalina would put it:
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Some Font Names Deserve Quotes
hote

In the example above, “Trebuchet MS” appeared in quotation marks. You
don’t need to bother wrapping quote marks around font names, unless the
font comprises several words, such as “Courier New” or “Times New Roman.”
A single-word font name, such as Arial or Verdana, does not need to be
wrapped in double quotes.

Have a quick look around all three pages of the web site and you’ll see that your
new styles have been applied to all your web pages. Let’s go a step (or two) further.

What’s Going On? Nothing’s Changed!
Tip@

If you try refreshing your browser’s view of a page and nothing appears to
change, first check that you saved the changes you made to the CSS file. If
you have saved the altered file, check that you typed the CSS exactly as de-
scribed. If you did, you may be experiencing a caching problem with your
browser.

‘Web browsers “cache” some content. What this means is that, to save having
to download files each and every time you visit a given web page, your browser
uses versions of the files that it saved to the hard drive previously. This re-
duces the time it takes to display a web page that has been loaded once before.
Unfortunately, your cache can get out of date, and when that happens, the
page you visit (i.e. you enter the URL, and the browser pulls the page stored
in its cache) might not display the most recent data.

This happens most frequently with images, but it can also occur with CSS
files. The good news is that you have control over your browser’s cache set-
tings and the amount of space the cache takes up on your hard disk before
previously cached content gets replaced with newer data. You can poke
around your browser’s settings for words like “Cache” or “Temporary Internet
Files” to change these settings; however, most users opt to leave their caches
to the default settings.

If you're positive that you’ve made the necessary changes to your CSS file
(and saved them) correctly, you may need to “force-reload” the CSS file in
your browser.

To stop the caching problem and force the browser to get the most up-to-
date version of your CSS file, simply hold down the Shift key and click on
the Refresh (or reload) icon on your browser’s toolbar.
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A Mixture of New Styles

Let’s change the look of the site a little more: we’ll add more styles to the body;,
and change the look of the navigation. Copy the CSS below into your stylei.css
file (or copy it from the book’s code archive):

File: stylel.css

/*

CSS for Bubble Under site
*/

body {

font-family: Verdana, Helvetica, Arial, sans-serif;
background-color: #e2edff;
line-height: 125%;
padding: 15px;
}

h1 {
font-family: "Trebuchet MS", Helvetica, Arial, sans-serif;
font-size: x-large;

}

1i {
font-size: small;

}

h2 {
color: blue;
font-size: medium;
font-weight: normal;

}

1i {
font-size: small;

}

p{
font-size: small;

color: navy;

}

Save the CSS file, then click Reload in your browser. Hopefully, you’ll be looking
at a page like the one shown in Figure 3.7.
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Figure 3.7. Applying subtle changes to the CSS that affects font
display
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A New Look in a Flash!

We’ve introduced quite a few new style declarations here. Let’s examine a few
of them in the order in which they appear in the CSS file.

Example 3.5. style1.css (excerpt)

body {
font-family: Verdana, Helvetica, Arial, sans-serif;
background-color: #e2edff;
padding: 15px;
line-height: 125%;
}

The background-color property can be applied to most elements on a web page,
and there are many different ways in which you can specify the color itself. One
is to use recognized color names? such as navy, blue, red, yellow, and so on.
These are easy to remember and spell, but you are limited somewhat by the range.
Another way of referencing colors is to use a hexadecimal color specification.
Yes, you're right: that does sound a little scary. I mean, just look at it:

% http:/Awww.w3schools.com/html/html_colornames.asp
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background-color: #e2edff;

It’s hardly intuitive, is it? This obscure-looking reference translates to a light
shade of blue. You could not, as a beginner, begin to guess that this would be a
light blue, but thankfully there are numerous tools on the Web that let you
choose a color from a chart, then give you the code to match. Take a look at some
of these tools,? and you'll soon be able to find the hexadecimal numbers you
need to create your ideal color schemes.

What the Heck’s Hex?

hote
Colors in HTML are often written as a hexadecimal color specification. You
might remember the hexadecimal counting system from your high school
math class. Or maybe you were asleep up the back of the room. Never mind.
Hexadecimal is that weird counting system that goes up to 16 instead of 10;
the one you thought you’d never have any practical use for. Well, you do
now!

That’s right: when you count in hexadecimal, there are not ten, but 16 digits.
The hexadecimal sequence looks like this:

o, 1, 2,3, 4,5, 6, 7,8, 9, A, B, C, D, E, F, 10, 11,
12, 13...

Eh? What’s happening here? Well, as you can see, after we get to 9, instead
of going straight to 10 (as we do when counting in decimal) we go through
A, B, C, D, E, and F before we finally hit 10. That gives us six extra digits
to use when we count! Sound confusing? Well, it is. But as it so happens,
computers can count in hexadecimal far better than humans can.

The key here is that all of those numbers that we know and love in the
decimal system, like 2,748, 15,000,000 and ... er ... 69, can be represented
in hexadecimal. Look, Table 3.1 proves it!

3 A good selection of links to color scheme tools is available at http:/www.clagnut.com/blog/260/.
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Table 3.1. Decimal to hexadecimal conversion

Decimal Hexadecimal
7 7

15 F

2,748 ABC
15,000,000 E4EI1CO

69 45

When a color is expressed as a hexadecimal number, such as ££0000, that
number actually comprises three values that are joined together. The values
represent the proportions of red (the ff part), green (the first two zeros),
and blue (the second two zeros) that are mixed to create the specified color.
Those three primary colors can be combined to display any color on the
screen, similar to the way a television set uses different intensities of red,
green, and blue to create a single dot on its screen. In this example, T is the
value for red, while the green and blue values are zero. It may not surprise
you, then, to learn that #ff0000 will give you the color red.

The padding property is used to provide space between the outside edge of the
element in question and the content that sits inside it. Because we’re referring
to the body element, you can think of the outside edge as being the top, bottom,
and sides of the browser’s viewport (that being the part of the browser where the
web page is viewable, not including any of the browser’s tool bars, menus, or
scroll bars). We’ll take a look at padding in more detail in Chapter 4.

The value we’ve given to this property specifies how much space must exist
between the edge of the viewport and the content. In this case, we’ve specified
15px, or 15 pixels. We mentioned pixels before, when we specified the size of an
image, but what is a pixel? Basically, one pixel is one of the tiny dots that make
up what you see on the computer screen. The screen itself is made up of hundreds
of thousands of these pixels, so a 15-pixel border isn’t going to take up too much
space on your screen!

The line-height property is an interesting one. By increasing that value (we
used 125% in our example), you can increase the space between lines of
text—something that can greatly increase legibility. Try tweaking this value, save
your CSS file, and see how the new value affects the text on your web page.

Now, to the paragraph styles:
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File: style1.css (excerpt)
p {
font-family: Times, "Times New Roman", serif;
color: navy;

}

We’ve already shown that it’s possible to change the color of text in a paragraph;
now, we're going to settle on the sensible (and appropriate!) color of navy.

Let’s see what’s changed with the list item style:

File: stylel.css (excerpt)
1i {
font-size: small;

}

The size of the list items has changed ever so slightly through our application of
the font-size property. Here, we’ve decided to set the font size using the small
keyword, but we could just as easily have used the percentage or pixel methods
we’ve already seen—there are many ways to skin a cat with CSS! Font size
keywords range from xx-small to xx-large and offer a quick way to style text.
Unfortunately, different browsers implement font size keywords slightly differ-
ently, and unfortunately you can’t be guaranteed that an xx-large font will
render at the same size in all browsers. However, unless you're extremely worried
about precise sizing, these keywords make a good starting point.”*

Next, we introduced a new rule, this time for the h1 element (the main heading
on our web pages, which displays the site name) and, once again, used a font-
size property to specify the size of the text (extra large is the answer!).

File: stylel.css (excerpt)
h1 {
font-size: x-large;

}

The h2 element also gets a minor makeover:

“For more reasons than we have space to discuss, text sizing in CSS is a topic that causes heated debate
in some circles. As you become familiar with CSS, you may want to learn more about the other text-
sizing techniques that it offers. A good place to start would be SitePoint’s CSS discussion forum at
http://www.sitepoint.com/launch/cssforum/.
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File: stylel.css (excerpt)
h2 {
color: blue;
font-size: medium;
font-weight: normal;

}

Browsers usually display headings in bold type, but we can have them display in
standard type by giving the font-weight property a value of normal.

A Beginner’s Palette of Styling Options

We’ve looked at some examples of styles that can be applied to your web pages
through CSS, but the examples we’ve seen have been a mixed bag (deliberately
so). There are so many more from which you can pick and choose—too many
possibilities, in fact, for us to be able to list them all here. However, this section
lists some of the basic properties and values with which you might like to exper-
iment. Feel free to try any of these in your CSS file. Note that we’ll be adding
to this list in subsequent chapters; it’s by no means exhaustive!

color As we’ve seen, both of these properties can take color
background-color keywords (e.g. red, blue, green, or yellow) or hexadecim-
al color specifications such as #ff0000.

font-family This property takes a list of fonts, containing any fonts
you choose in order of preference. Be sure to provide op-
tions that users are likely to have on their computers (e.g.
Arial, Verdana, etc.). This list should end with one of the
“generic” CSS fonts such as serif or sans-serif, which
any browser that supports CSS will recognize.

font-size This property can be any one of the following:
font size keywords
] xx-small
J x-small
4 small

] medium
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) large
4 x-large
4 xx-large

a relative unit
such as a percentage (e.g. 140%)

fixed font sizes
O pixels (e.g. 20px)

[ points (e.g. 12pt, as you may be used to using in
Microsoft Word)

Fixed font sizes are not always a great idea, as they
cannot easily be scaled up or down to suit the reader’s
needs. Relative font sizes are definitely the preferred

option.
font-weight bold or normal
font-style normal or italic
text-decoration none, underline, overline, or 1line-through

Backing it Up!
Tip@

Before you experiment with the CSS properties above, it might be an idea
to make a backup of your CSS file, just in case you run into difficulties. Re-
member that you can download all the examples used in this chapter from
the code archive if you accidentally mangle your CSS file. If this happens,
don’t worry! It’s all part of the learning process, and you can be sure that no
animals will be harmed in the process. Only a handful of poor CSS selectors
will be mistreated. Shed no tears!

Recap: the Style Story so Far

Let’s allow ourselves a moment to reflect. Our site now boasts a CSS file with a
selection of attractive styles. We’re in the enviable position of being able to change
the site at a whim by altering just that one CSS file. Let’s try styling some more
of the elements on our web pages.
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Changing the Emphasis
@ Open about.html in your text editor.

@ Find the paragraph about meeting up in a local pub and add an emphasis
element as shown here:

File: about.html (excerpt)
<p>And when we're not diving, we often meet up in a local pub
to talk about our recent adventures (<em>any</em> excuse,
eh?).</p>

@ Save the page, then view it in your web browser; it should appear as shown
in Figure 3.8. As you can see, emphasis elements appear in italics by default.
We’re going to use CSS to change that default style.

Figure 3.8. Using emphasis to set type to italics by default

3 ghout Bubble Under: who we are, what this site is for - Mozilla Firefox

File Edt Yiew Go Bookmarks Tools Help
<I| - L‘l - @ @ || File:j]IC: JDocuments%20and % 205ettings/Bob% 200obalina/My3200ocume | % @ Go @,
A
BubbleUnder.com
Diving club for the south-west UK - |et's make a splash!
* Home Italicized text
s Ahout Us
* Contact Us
About Us
Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up iving trips in
the summer months when the weather is good and the bacon rolls are flowing., We arrangel bekends away
as small groups to cut the costs of accommodation and travel and to ensure that everyone\ pts a
trustworthy dive buddy.
Although we're based in the south-west, we don't stay on our own turf. past diving weekend\| away have
included trips up to Scapa Flow in Scotland and to Malta's numerous wreck sites.
When we're not diving, we often meet up in a local pub to talk about our recent adventures {any excuse,
eh?).
Or as our man Bob Dobalina would put it:
"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen, You can quote
o bl M
Done
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[ Open stylei.css (if you haven’t already opened it for editing) and add the
following rule below the others:

File: stylel.css (excerpt)

em {
font-style: normal;
text-transform: uppercase;

@ Save the CSS file, then refresh your browser’s view of the About Us page.
Does your page look like Figure 3.9?

Figure 3.9. The emphasis appearing as capitalized text instead
of italics

' About Bubble Under: who we are, what this site is for - Mozilla Firefox [;l@l@
Ele Edt View Go pookmarks Jools Help {

@ = ¥ @ ‘/";] | files 1 C: fDocuments¥20and %205ettings/Bob%2000balina/My%:2000cume ¥ | @ 6o |(GL
~
BubbleUnder.com
Diving club for the south-west UK - let's make a splash!
s Homa Capitalized text
=» About Us

* Contact Us

About Us

Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up
the summer months when the weather is good and the bacon rolls are flowing. We arrange
as small groups to cut the costs of accommodation and travel and to ensure that everyone
trustworthy dive buddy.

iving trips in

Although we're based in the south-west, we don't stay on our own turf: past diving weekend\| away have

included trips up to Scapa Flow in Scotland and to Malta's numerous wreck sites.

When we're not diving, we often meet up in 2 local pub to talk about our recent adventures (ANY excuse,
eh?).

Or as our man Bob Dobalina would put it:

"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen. You can quote

oo an thatl®

K3

Now, whenever you add an em element to any web page of your site (assuming
that page is linked to stylei.css), the emphasized text will appear in capital
letters, not italics. But this raises an interesting point: when should you override
a browser’s default style for one of your own choosing? Presumably, the default
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styles that browsers use were selected carefully; how can you be sure that your
redefinition of the styles is a good idea? Weren't italics a suitable style for em-
phasis? They probably were. As Spiderman’s creators say, “With great power
comes great responsibility,” so be sure to exercise caution. Just because you can
change a default style does not always mean you should.

Perhaps a compromise is in order. Let’s change the emphasis so that it’s still italic,
but also appears in uppercase letters. All we need to do is remove the font-style
declaration; the em element will then revert to its default italicized appearance,
as depicted in Figure 3.10.

File: stylel.css (excerpt)

em {
text-transform: uppercase;

Figure 3.10. Emphasis displaying as uppercase italics

3 pbout Bubble Under: who we are, what this site is for - Mozilla Firefox

File Edit  Wew Go Bookmarks  Tools  Help
<::| - I_: - @ @ L1 File: [ jDocument s 20and %205t tings/Bob % 200abalinafMy %20Docume % @ Go @,
”~
BubbleUnder.com
Diving club for the south-west UK - let's make a splash!
* Home |ta'||CI?ed and
o AEmui Us capitalized text
* Contact Us
about Us
Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up iving trips in
the summer months when the weather is good and the bacon rolls are flowing. We arrange ekends away
as small groups to cut the costs of accommodation and travel and to ensure that everyonel ks a
trustworthy dive buddy.
although we're based in the south-west, we don't stay on our own turf: past diving weekendylaway have
included trips up to Scapa Flow in Scotland and to Malta's numerous wreck sites.
¥hen we're not diving, we often meet up in a local pub to talk about our recent adventures {ANY excuse,
eh?).
Or as our man Bob Dobalina would put it:
"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen. ¥ou can quote
v
Fr T L
Dane
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Emphasis vs Italics
Tip@

You might well be asking yourself, “If I want an italic font, can’t I use an it-
alic element?” In fact, HTML provides an i element for just this purpose,
but its use isn’t recommended. Why not? Well, marking something up as i
says nothing about its meaning; i only communicates how it should be
presented on the screen. Such elements are referred to as presentational
HTML elements, and they should be avoided. Likewise, the b element (for
bold), another old HTML element, should not be used. The preferred option
is to use strong or, if you just want to display headings in bold, to use CSS.

Why is this important? It mightn’t seem important to you, as you look at
the italicized text in your web browser. But imagine you were a blind user
of software that read web pages aloud to you, instead of displaying them on
the screen. Such a program (called a screen reader) would read text marked
up with an em element with slight emphasis, and text marked up with strong
in a slow, powerful voice ... but what would it do with text marked up with
i or b? Well, these elements say nothing about the meaning of the text, so
it would ignore them. The same is true of many programs that analyze web
pages, such as web indexing programs run by Yahoo! and Google—em and
strong tags tell these programs that the words inside them are important,
whereas i and b tell them nothing.

One other presentational tag that you might see others use, but should never
copy, is the u element. Wrap this around some text and you get needless
underlining that only serves to confuse users (because in web pages, under-
lined text normally signifies a link—something that the u element most
definitely does not).

Looking at Elements in Context

Pop quiz: which of these items is bigger? A pen or a sheep? Well, the answer is
either, depending on the context. If you were a farmer, you’d swear that the pen
is bigger. After all, you spend many hours a week rounding up herds of sheep
into a nice big pen. If, however, you're an office worker, you’d opt for the sheep
being the larger of the two—you’d find it a lot easier to pick up a pen and flip it
around your fingers.

Context can change things quite drastically, and context is something that can
be used to our advantage in CSS. We can style an element in a number of different
ways, depending on its position. Let’s head back to our example site for another
lesson. Don’t be sheepish, now!
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Currently, we have styled paragraphs so that they appear in a navy blue, sans-
serif font (Verdana, specifically), as does almost everything else on the page:

File: stylel.css (excerpt)
body {
font-family: Verdana, Helvetica, Arial, sans-serif;

}

p {
font-size: small;

color: navy;

}

This is all well and good, but there’s one paragraph on our site that’s a little dif-
ferent than the others in terms of its purpose. Can you spot which one it is? It’s
our first paragraph, the one in the tag line. Here’s the XHTML for that section:

File: index.html (excerpt)
<div id="tagline">
<p>Diving club for the south-west UK - let's make a splash!</p>
</div>

It’s different because it’s not really part of the document content and, as such,
it might benefit from some different styling. The fact that this particular paragraph
is contained within a specific div element—which has an id attribute of
tagline—is something that we can put to great use. Because it’s contained
within its own div, we can set a rule for this paragraph and this paragraph only.

@ Open the CSS file for editing, and add the following after the first paragraph

rule:

File: stylel.css (excerpt)
#tagline p {
font-style: italic;
font-family: Georgia, Times, serif;

}

[ Save the file, then refresh the About Us page (or any of the three, for that
matter) in your browser. Your page should now look something like the one
shown in Figure 3.11.
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Figure 3.11. The tag line appearing in italics

) about Bubble Under: who we are, what this site is for - Mozilla Firefox
Fle Edt View Go Bookmarks Tock Help

<:El T _| x @ @ | [ fieslfic:Docunents*2nand %205ettings/Bob20D0bainajiy2000cume | @ 6o |[GL
]
BubbleUnder.com

Diving club for the south-west UK - let's make a splash!

* Home \

gySboLtiUS | Italicized tagline |
* Contact Us

About Us

Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up for diving trips in
the summer months when the weather is good and the bacon rolls are flowing, We arrange weekends away
as small groups to cut the costs of accommodation and travel and to ensure that everyone gets a
trustworthy dive buddy.

Although we're based in the south-west, we don't stay on our own turf: past diving weekends away have
included trips up to Scapa Flow in Scotland and to Malta’s numerous wrack sites,

When we're not diving, we often meet up in 2 local pub to talk sbout our recent adventures (ANY excuse,
eh?).

Or as our man Bob Dobalina would put it:

"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen, You can quote

[ERees ]

What’s happening here? Perhaps a CSS-to-English translation is required. This
CSS rule means, “For any paragraph element that occurs inside an element that
has an id of tagline, set the text to italics and the font to Georgia, Times, or
some other serif font if you don’t have either of those.”

Getting a Positive ID

note
The # notation in the CSS refers to an element with a specific id attrib-
ute—in this case, tagline. We’ll learn more about selecting ids and manip-
ulating them in subsequent chapters.

Contextual Selectors

#tagline p is known as a contextual selector. Here are some other examples
(with their English translations):
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(4 #navigation a {
text-decoration: none;

}

Translation: for any link found inside the navigation area (an element with
an id of navigation), remove any decoration on that text; in other words,
remove the underline (any other links on the page will remain underlined).

[ #footer p {
line-height: 150%;
}

Translation: set the vertical height between lines of text contained in para-
graphs inside the footer area (e.g. a div element with an id of footer) to
150%. This would override the browser default of 100%, or other line-height
values that might be set, for example, on the body.

4 h1 strong {
color: red;

}

Translation: for any text inside a level one heading that’s marked up as strong,
set the color to red (any other instance of strong on the page will not be set
to red).

4 h2 a {

text-decoration: none;
}

Translation: don’t underline the text of any link inside a level two heading
(the default setting underlines all links, so any other links on the page will
remain underlined).

Grouping Styles

If you want to apply the same style to different elements on a web page, you
don’t have to repeat yourself. For example, let’s say that you want to set heading
levels one through three in yellow text with a black background. Perhaps you’d
do this:

h1 {
color: yellow;
background-color: black;

}
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h2 {
color: yellow;
background-color: black;

}

h3 {
color: yellow;
background-color: black;

}

That’s very messy, and once you have a lot of styles on the page, it gets even
more difficult to maintain. Wouldn’t it be great if you could reduce some of that
work? You can! Here’s how:

h1, h2, h3 {
color: yellow;
background-color: black;

}

Translation: if the element is a level one heading, a level two heading, or a level
three heading, set the text to yellow and the background to black.

Comma = “Or”
Tip@

Think of the commas in the selector above as the word “or.”

Let’s try grouping some styles in our project site. We don’t have any h3 headings
yet, but they’re coming:

@ Edit your CSS file (style1.css) by adding the following to the bottom of it:

File: style1.css (excerpt)
h1, h2, h3 {
font-family: "Trebuchet MS", Helvetica, Arial, sans-serif;
background-color: navy;
color: white;

}

@ Save the file, then refresh the “About Us” page in your browser (assuming it’s
still open from your last exercise). You should be looking at a page like the
one shown in Figure 3.12.
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Figure 3.12. Displaying the changed heading styles

%3 About Bubble Under: who we are, what this site is for - Mozilla Firefox

File Edit  Wiew Go Bookmarks  Tools  Help

C:l - - I% @ L1 file: }f 1 jDocuments#20and%205ettings/Bob % 2000balina/My %2 0Docum % @ Go @,

BubbleUnder.com

Diving club for the south-west UK - let's make a splash!

* Home
* About Us
* Contact Us

Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up for diving trips in
the summer months when the weather is good and the bacon rolls are flowing. We arrange weekends away

as small groups to cut the costs of accommodation and travel and to ensure that everyone gets a
trustworthy dive buddy.

Although we're based in the south-west, we don't stay on our own turf! past diving weekends away have
included trips up to Scapa Flow in Scotland and to Malta's numerous wreck sites.

¥hen we're not diving, we often meet up in a local pub to talk about our recent adventures {ANY excuse,
eh?).

Or as our man Bob Dobalina would put it:

"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen. ¥ou can quote

Done

That CSS really does kill several birds with one stone (and I said no animals
would be harmed! Apologies to ornithologists). Now, not only do you have the
convenience of being able to style many pages from one central location (your
CSS file), but you have the added convenience of being able to style many ele-
ments in one go. Your CSS file becomes easier to manage and—a nice little side-
benefit—smaller, and therefore quicker to download.

But something interesting is happening in our CSS file: it appears that we may
have a conflict in our rules. Or have we?

Which Rule Wins?

When we added the grouped declaration for the headings, we changed some
styles that we’d set previously. A look at the source shows that the level two
heading, h2, has been set to be blue and white in different places in our style
sheet:
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File: style1.css (excerpt)
h2 {
color: blue;
font-size: medium;
font-weight: normal;

}
em {
text-transform: uppercase;
}
h1, h2, h3 {

font-family: "Trebuchet MS", Helvetica, Arial, sans-serif;
background-color: navy;
color: white;

}

Because the declaration specifying that the h2 should be white comes later, it has
overridden the earlier one. It doesn’t matter if you've defined an h2 to be blue
100 times through your style sheet; if the last definition says it should be white,
then white it will be!

Filenames for your Style Sheets
Tip@

Although we’ve been working with style1.css for some time, you may be
wondering why we named the file this way. The name is deliberate. You
might want to add another style to your web site at a later date, and num-
bering is a basic way to keep track of the styles you can apply to a site.

You might be thinking, “Why not name it something like marine.css be-
cause it uses marine colors, references to under-sea animals, and so on?”
That’s a fair question, but the important thing to note about CSS is that
you can always change the styles later, and your naming convention might,
at a later date, bear no relevance to the styles a file contains. For example,
you can edit marine. css such that all the colors in your web site are changed
to ochres, browns, and sandy yellows. This ability to change the web site’s
design in one action is the whole point of CSS! With the new design, your
web site might have an earthy/desert feel to it, yet you could still have 200
or more pages referring to a style sheet by the filename of marine.css.
Something’s not right there, is it? This is why I've chosen an abstract name
for the CSS file, and I recommend that you do the same for the web sites
you develop.
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Recapping our Progress

Time for another breather. What have we learnt? Well, we’ve learned some more
styles that you can apply in CSS, we’ve seen how you can style certain elements
depending on their context, and more recently, we’ve discussed how you can
group elements that need to be styled in the same way. There’s one thing that
we’ve touched on only briefly, yet it demands more attention because it’s so
fundamental to the way the Web functions. That topic is links.

Styling Links

Links are everywhere on the Web: they truly are the basis of everything you see
online. Nowadays, we’re used to seeing highly decorative web pages adorned by
a wealth of different images and features. Take a step back in time, though, and
you’ll find that the World Wide Web was little more than a collection of linked
documents. Go back to the earliest browsers and you’ll find that those links were
underlined, which remains the case today. By default, a browser uses the following
color scheme for links:

blue an unvisited link
purple alink to a web page that you’ve previously visited

red an active link (one you're clicking on, but, for whatever reason, the
next page hasn’t quite appeared; we don’t see this much in these days
of widespread broadband usage, because pages load much faster than
they used to!)

This color scheme isn’t to everyone’s taste, but it’s what we’re stuck with now.
At least, it’s what we would be stuck with if we couldn’t use CSS to redefine those
colors.

At its most basic, a CSS style for links might look like this:

a {
font-weight: bold;
color: black;

}

Now, instead of being blue and having a normal font weight, your links appear
in bold, black type. Try adding that to your style1.css file; save it and see how
it affects your web pages—Figure 3.13 illustrates.
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Figure 3.13. Styling all the links in our navigation to bold and
black

%3 About Bubble Under: who we are, what this site is for - Mozilla Firefox

File Edit  Wiew Go Bookmarks  Tools  Help
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BubbleUnder.com
Diving club for the south-west UK - let's make a splash!
* Home
* About Us
* Contact Us
Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up for diving trips in
the summer months when the weather is good and the bacon rolls are flowing. We arrange weekends away
as small groups to cut the costs of accommodation and travel and to ensure that everyone gets a
trustworthy dive buddy.
Although we're based in the south-west, we don't stay on our own turf! past diving weekends away have
included trips up to Scapa Flow in Scotland and to Malta's numerous wreck sites.
¥hen we're not diving, we often meet up in a local pub to talk about our recent adventures {ANY excuse,
eh?).
Or as our man Bob Dobalina would put it:
"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen. ¥ou can quote
v
e min e el
Done

Link States

As I mentioned previously, there are different types of links (unvisited, visited,
active) that you’ll come across on a web page. There’s one other state that I
haven’t mentioned, but it’s one with which you’re probably familiar: the hover
state (which occurs when you pass your cursor over the link). In CSS, you can
change the styling of all of these link states using something that sounds complic-
ated but is really fairly straightforward: pseudo-classes. Here is some CSS that
shows the color/style scheme for the different link states:

a {
font-weight: bold;
}

a:link {

102 Order the print version of this book to get all 500+ pages!



http://www.sitepoint.com/launch/81f2b9

Styling Links

color: black;

a:visited {
color: gray;

a:hover {
text-decoration: none;
color: white;
background-color: navy;

a:active {
color: aqua;
background-color: navy;

}

The different states are addressed within the CSS through the use of the a element
selector, and by applying (with the aid of a colon) the pseudo-classes of link,
visited, hover, and active.

Getting your Link States in Order
Tip@

Browsers usually aren’t fussy about the order in which you specify rules in
your CSS file, but links should always be specified in the order shown above:
link, visited, hover, and active. Try to remember the letters LVHA.
The more bitter of us might find it easier to remember this mnemonic with
the phrase, “Love? Hal” We can thank Jeffrey Zeldman for that little gem.S

Let’s change the styles for different link states in our project site:

@ If it’s not already open, open the project site’s CSS file (stylel.css), and
add the above CSS at the bottom of the file.

[ Save the CSS file.

@ Open any of the three web pages in your browser (or hit Reload) to see how
the styled links display.

Figure 3.14 shows the three different link states: the home link is unvisited, the
link to the About Us page shows that it has been visited previously (shown in

5Designin(gf With Web Standards, Jeffrey Zeldman, New Riders.
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gray), and the link to the Contact Us page is being hovered over by the user’s
Cursor.

Figure 3.14. Styling three different link states using CSS
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Although we're based in the south-west, we don't stay on our own turf! past diving weekends away have
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¥hen we're not diving, we often meet up in a local pub to talk about our recent adventures {ANY excuse,
eh?).

Or as our man Bob Dobalina would put it:

"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen. ¥ou can quote
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Feel free to experiment in the CSS file with the different foreground and back-
ground colors, and other text formatting styles that were detailed in the table
earlier in this chapter.

Clearing your History
Tip@

Your browser automatically stores a certain amount of your browsing history,
and uses this information to decide whether a link has been visited or not
(and, hence, how the link should be displayed). If you’re building a site and
testing links, you might want to check how an unvisited link looks but, be-
cause of your browsing history, they may all show as having been visited.
This is almost certainly the case with our three-page project site—the links
in your navigation list are probably all gray. To reset this, you can clear your
browser’s history. In IE, select Tools > Internet Options. You'll see a button
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that reads Clear History, as shown in Figure 3.15; click it, then reload the
web page. Any links you may have visited will now appear as unvisited.

Figure 3.15. Clearing the history in IE displays unvisited
link styles again

Internet Options

General | Security | Privacy | Cortert | Connections | Programs | Advanced

Home page
Iﬁ You can change which page to use for your home page
Address: bout:blank]

[ Use Cument ] [ Use Default ][ Use Blank

Temporary Intemet files

<y Pages you view on the Intemet are stored in a special folder
@&\ for quick viewing later

[Delehe Cookies.. ] [ Dielete Files... ] [ Settings...

Histary

The History folder contains links to pages you've visited, for
quick access to recently viewed pages.

Days to keep pages in history: 20 |3 Clear History

[ Colors... ] [ Fonts.. ] [ Languages... ] [Accgssibil'rty..]

Other browsers have similar options, which may be found in locations such
as Tools > Options or Preferences > Privacy. I won't list all the different
methods for deleting your history from various browsers here, but if you
rummage around, you should be able to find them without too much diffi-
culty.

Class Selectors

To date, we’ve discussed the ways in which we can style various elements, such
as paragraphs and headings; we’ve also seen how we can style elements in specific
areas of the page using the id attribute. However, implementing broad-brush
styles, such as coloring the text in all p elements navy, is very much a blanket
approach to design. What if you want some of those paragraphs (or any elements,
for that matter) to look a little different than the rest? Class selectors are the
answer.
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A class selector lets you define a style that can be used over and over again to
style many different elements. So, for example, let’s say you wanted to make
some parts of your text stand out—to make them look slightly more appealing
or fun than other parts of the document. You could do so in your CSS like this:

.fun {
color: #339999;
font-family: Georgia, Times, serif;
letter-spacing: 0.05em;

}

Here, we’ve created a style rule for a class called “fun.” The fact that it’s a class
selector is denoted by the period at the beginning of the class name. We’ve slipped
another property into this rule: letter-spacing defines the space between each
of the letters. We've set a spacing of 0.05em here. 1em is the height of the M
character in any font, so 0.05em is 5% of that height. It doesn’t sound like much
of a difference, but when it comes to typography, subtle changes are usually more
effective than extreme ones.

In order to make use of the style, all you need to do is add the class="fun" at-
tribute to an element:

<p class="fun">A man walks into a bar; you would've thought he'd
see it coming!</p>

Let’s apply some classes to our project site. First, we’ll need to add the style rule
shown above to the style sheet we’re working on:

O Open stylei.css and add the CSS from the above block to the bottom of
that file.

[ Save stylet.css, then open about.html.
[ Find the paragraph that’s contained inside the blockquote element.
[ Add the class="fun" attribute to the paragraph’s opening tag.
This is how your markup should look right now:
File: about.html (excerpt)
<blockquote>

<p class="fun">"Happiness is a dip in the ocean followed by a
pint or two of 0ld Speckled Hen. You can quote me on
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that!"</p>
</blockquote>

Note that the class attribute was applied at the paragraph level. If there were a
few paragraphs in our man Bob’s quotation, you’d end up with something like
this:

<blockquote>
<p class="fun">"Happiness is a dip in the ocean followed by a
pint or two of 0ld Speckled Hen. You can quote me
on that!</p>
<p class="fun">"Join us for a weekend away at some of our
favorite dive spots and you'll soon be making new
friends.</p>
<p class="fun">"Anyway, about time I got on with some
<em>proper</em> work!"</p>
</blockquote>

There’s a lot of repetition in there. Surely there’s a tidier way to apply this style?
There sure is!

<blockquote class="fun">
<p>"Happiness is a dip in the ocean followed by a pint or two of
0ld Speckled Hen. You can quote me on that!</p>
<p>"Join us for a weekend away at some of our favorite dive
spots and you'll soon be making new friends.</p>
<p>"Anyway, about time I got on with some <em>proper</em>
work!"</p>
</blockquote>

In this example, we apply that class of fun to the blockquote element, so
everything contained in that element inherits the style of the parent container.
This saves us from having to apply these different classes all over our pages (an
affliction that has become known as class-itis—a not-too-distant relation of div-
itis, which we discussed in Chapter 2).

class vs id
Tip@

So far, we’ve looked at both class selectors (which involve periods) and id
selectors (which involve pound signs). Are you confused by them? It’s true
that these selectors are similar, but there is one important difference: a specific
id can only be applied to one XHTML element. So, for example, on any web page,
there can only be one element with an id of mainnavigation, and only
one with an id of header. A class, on the other hand, can appear as many
times as required.
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Limiting Classes to Specific Elements
Tip@

Imagine you want to italicise any blockquote element that has a class
attribute with the value fun, but not other elements with that class value.
Think it sounds tricky? Not with CSS!

.fun {
font-family: Georgia, Times, serif;
color: #339999;
letter-spacing: 0.05em;

}

blockquote.fun {
font-style: italic;
}

Now, any text inside a pair of <blockquote class="fun"> and
</blockquote> tags will appear in italics.

By prefixing our normal class selector with an element name, we’re telling
the browser to apply the following declarations to that element-and-class
combination only. It’s as simple as element.class, but make sure you
don’t leave any spaces!

Specifically Speaking
Tip@

Those with an eagle eye will have noticed that not all of the fun styles in
the previous example are actually applied to the quotation. The font-family
and letter-spacing declarations take effect, but the color change does
not! The reason for this can be explained with the concept of specificity.

Specificity simply means the rule that is the most specific is the one that is
applied. “Most specific” really means “most deeply-nested in the document’s
structure.” In our markup, the p element appears inside the blockquote
element, so any style applied to the p is deemed to be the more specific of
the two and, therefore, will always win out. We have such a rule in our project
site—the one that states that all paragraphs should be navy-colored—so this
is the one that takes effect:

File: style1.css (excerpt)

p {
color: navy;
}
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Note that, unlike the conflicting rules we encountered in the section called
“Which Rule Wins?”, this battle between style rules has no relation to the
order in which they appear in the style sheet.

Specificity can get confusing, so don’t lose too much sleep over it—for now,
it’s enough just to be aware of the concept, as this may be the reason why
one of your styles doesn’t take effect when you’re convinced it should. Spe-
cificity is covered in greater depth in the SitePoint book HTML Utopia:
Designing Without Tables Using CSS,(’ if you’d like to explore it further.

Styling Partial Text Using span

So, a class can be applied in many different places—perhaps to a specific para-
graph, or to a block of several paragraphs contained in a blockquote, or to a div
that holds many different types of content. But what would you do if you wanted
to apply the style to a very small section of text—maybe just a couple of words,
or even just a couple of letters, within a paragraph? For this, once again, you can
use the span element.

Earlier in this chapter I showed how you could use the span element in conjunc-
tion with inline styles to pick out and style specific words within a paragraph.
The exact same technique can be used with classes: we simply place an opening
<span> tag at the point at which we want the styling to begin, and the closing
</span> tag at the point at which the styling should end. The advantage of this
technique over the inline style demonstrated earlier is, of course, that with this
technique, the style is defined in a single location, so you could potentially add
the “fun” class to many different elements on many different pages with a min-
imum of hassle. When you decide that you want to have a different kind of fun
(so to speak), you need only change your style sheet (style1.css) for that new
style to be reflected across your site.

<p><span class="fun">Bubble Under</span> is a group of diving
enthusiasts based in the south-west UK who meet up for diving
trips in the summer months when the weather is good and the
bacon rolls are flowing. We arrange weekends away as small
groups to cut the costs of accommodation and travel and to
ensure that everyone gets a trustworthy dive buddy.</p>

Try applying the span element to your “about” page as suggested in the above
code. If you save the changes and check them in your browser (remember to hit
Reload), your page should look like the one shown in Figure 3.16.

® http:/sitepoint.com/books/css 1/
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Figure 3.16. Applying the “fun” class to two specific words

%3 About Bubble Under: who we are, what this site is for - Mozilla Firefox

File Edit  Wiew Go Bookmarks  Tools  Help
C:l - - I% @ L1 file: }f 1 jDocuments#20and%205ettings/Bob % 2000balina/My %2 0Docum % @ Go @,|
N
BubbleUnder.com
Diving club for the south-west UK - let's make a splash!
N .
* Home Isn’t this fun?
* About Us
* Contact Us
Bubble Under is a group of diving enthusiasts based in the south-west UK who meet up for diving trips in
the summer months when the weather is good and the bacon rolls are flowing. We arrange weekends away
as small groups to cut the costs of accommodation and travel and to ensure that everyone gets a
trustworthy dive buddy.
Although we're based in the south-west, we don't stay on our own turf! past diving weekends away have
included trips up to Scapa Flow in Scotland and to Malta's numerous wreck sites.
¥hen we're not diving, we often meet up in a local pub to talk about our recent adventures {ANY excuse,
eh?).
Or as our man Bob Dobalina would put it:
"Happiness is a dip in the ocean followed by a pint or two of Old Speckled Hen. You can
v
PP PP S S Y T
Dane

Don’t Throw (Needless) spans into the Works

note
The span element is nearly always used with a class attribute. There is not
normally a good reason to apply a span element to your XHTML on its
own, although you may see some web sites that do so.

Before you apply a span to any given element on your web page, take a
moment to think about whether there’s another element that’s better suited
to the task. For example, you should not use something like this:

<p>Do it <span class="shouty">now</span>!</p>
A more appropriate choice would be to use the strong element:
<p>Do it <strong>now</strong>!</p>

Think of the meaning of what you’re writing, and aim for an XHTML element
that suits the purpose. Other examples might be em, cite, and blockquote.
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Summary

It’s been another busy chapter, but my, how our site’s blossoming! A chapter or
two ago, we hadn’t even built a web page, but now we’re at the stage where we
know how to apply a (virtual) lick of paint to any type of XHTML element on
a page, to a specific section of a web page depending on its id, or to arbitrary
portions of a page—sometimes in several different places—using class selectors.

The web site is starting to look a little more colorful, but the layout is still fairly
basic. In the next chapter, we’ll look at how it’s possible to change the layout of
elements on a page—their position, shape, size, and more—using CSS. Styling
text? Been there, done that. Let’s move to the next level!
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Pimp my Site: Cool Stuff you can
Add for Free

Your web site looks great, everything seems to be going tickety-boo, and maybe
you’ve even got regular news updates happening thanks to a group of budding
bloggers who contribute regularly. Your work’s done, right? Well, no. There’s
always something else to do!

When you first set up your web site, you probably had a good idea of the audience
you were building it for (at least, I hope you did), and you may well have catered
admirably to that audience. But within a couple of weeks of launching your web
site and promoting it to the world (using some of the suggestions I made in
Chapter 8), you’'ll start to receive emails from people you don’t know asking
questions about the site that you really hadn’t expected:

“Can you tell me where I can get my air regulators serviced in
North Devon?”

“I can’t find details of your training courses—do you offer any?”

“My name is Abdul Akinbobola and I am the son of the recently
deposed president of Burkino Faso and...”

Okay, so that last message has nothing to do with your web site, but trust me,
you'll certainly get emails like this! The point I'm making is that no matter what
sort of planning you’ve undertaken, people beyond your expected audience will
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find your web site one way or the other, and you’ll likely need to be able to cater
to them, too. This is where you should consider some add-ons to your site—extras
that will:

Q let you discover how people are arriving at your web site (e.g., through a search on
Google, or via a referral—or link—from another web site in which you’ve
promoted your own site)

@ reveal which search terms people used to get to your web site, and provide some
statistics about the most common ones

@ let the visitor search the contents of your web site (rather than click around the
navigation in the hope of finding what they need)

@ allow the visitor to search a group of related web sites from the comfort of your
web site

[ provide a way for you to manage a list of your favorite web sites related to the
topic in your own web site, and provide them as a links resource for others

[ let your visitors become part of your web site community by providing a discus-
sion forum

All of these goals can be achieved using free services, and in this chapter, I'm
going to provide step-by-step instructions to help you add these services and truly
pimp your site!

Getting the Low-down on your Visitors

How can you be absolutely sure that what you’ve got on your web site is the right
content for your audience? Well, the truth is that you can’t know for
sure—everyone’s different, after all, and each person’s needs are unique. However,
you can get some indication about whether your web site is serving the audience’s
needs through some simple statistics.

Some hosting companies will provide statistics software as part of your hosting
package, so be sure to check. If your package includes a statistics service, you can
safely skip over this next section—instead, make use of the tools your host has

"For those who don’t get the reference, Pimp My Site is my little pun based on the MTV show Pimp
My Ride, [http:/www.mtv.com/onair/dyn/pimp_my_ride/series.jhtml] in which old, neglected cars
are renovated (or “pimped”) for their owners.
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already provided. However, most free hosting services, and many of the cheaper
hosting plans, will not provide statistics for you. It’s up to us to fill that gap.

Choosing a Statistics Service

As with a number of services I’ve mentioned elsewhere in this book, there are
two ways that you could introduce a statistics service to your site:

@ You could install and configure a statistics service on the web server that hosts
your site. The web server keeps detailed records of every visit to your web
site: it records the time of the visit, which pages were viewed, which browsers
were used, how visitors found the site, and much, much more. There are many
programs you can install onto your web server that will produce easy-to-read
graphs based on this data. Installing this software is no easy feat, though, and
is not really something I’d recommend for beginners.

@ Thankfully, the second option is much easier—you can sign up for a third-
party solution that collects and stores the data on your behalf. All you're re-
quired to do is add a link to an image or script file (hosted by the service
provider) into your web pages.

Many third-party statistics services are available, but to narrow things down a
little, I advise you to look for one that offers the following features:

list of referring web sites (recent referrers and totals)
This information will tell you how your visitors found your web site.

number of visitors
You should be able to view a count of the numbers of visitors your site receives
each day and each month, as well as the total number of visitors who have
stopped by since the site launched.

information about your visitors’ computer setups
This data will tell you whether your visitors are using PCs or Macs, which
browsers they’re using, and so on.

Any information beyond that is probably overkill for a small-scale web site (as
you can probably imagine, too many statistics can end up muddying the wa-
ters—there’s a lot to be said for simplicity!). Some of the hosted services you
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might want to consider using include StatCounter,” Extreme Tracking,® and
AdFreeStats.*

In the past, I've always used the Extreme Tracking service—it’s easy to set up
and does its job. However, I'm going to break with my own habits and show you
the process for setting up an account with StatCounter. Why? Because the report-
ing looks good, there’s lots of additional help on each report page that will lead
you to discover more, and—a real selling point for me—the service generates
standards-based markup for its visitor tracking code (most services are not all
that thoughtful, and it would be a shame to undo the good work you’ve completed
on your web site so far by introducing invalid markup).

Registering an Account with StatCounter

There are just a few forms to fill in—soon, you’ll be ready to add a statistics service
to your site! Here’s what you need to do:

O Head over to StatCounter’s home page5 and click on the Register Now link.

@ Fill in your account and personal details into the registration page shown in
Figure 10.1. Be sure to make your username and password easy to remember.

% http:/www.statcounter.com/
3 http://www.extreme-dm.com/tracking/
* http://www.addfreestats.com/
> httpy//www.statcounter.com/
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Figure 10.1. StatCounter’s registration page

ACCOUNT DETAILS

Username |b0bd0ba|ina

Ernail |b0b@bubb|eunder‘com

Password [case sEnSitive) |*M*M**

Confirm Password

|********

PERSOMNAL DETAILS

First Name |Bnh

Last Marmne |Dnha||na

Company Mame {optional) |

|
|
|
Country United Kingdom v|

Diate Format 21st December 2005w
Time Forrnat 23:18:39 A

O accept the terms and conditions,

REGISTER MY ACCOUNT >>

[ You'll be asked to select your time zone before proceeding to the project setup
process—Figure 10.2 shows how it’s done. A StatCounter Project is a single
web site whose statistics are collected by StatCounter. You can collect statistics
for multiple web sites, but each web site must have its own separate project.

Figure 10.2. Selecting a time zone

Congratulations! Your account has been created successfully!

Please select vour timezone:

| GMTO:00 Europe/London {GMT) v|

The next step toward tracking your wisitors is to create a StatCounter Project for your
websita, A Project relates to one website - if you have multiple websites you can create a
Project for each, and manage them all from your account. Click the button below to set your
timezone and start creating a StatCounter Project:

PROCEED & ADD A PROJECT >>

If you don't wish to create a project now, you can simply log in again at a later time to
continue the process,

@ The first step in setting up a project is to select the type of project you want
to create. At the time of writing, only one project type is available—the
Standard StatCounter Project—but that’s all we need anyway. Select the
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Standard StatCounter Project, as shown in Figure 10.3, and click the Next >
button.

Figure 10.3. Only a standard StatCounter project is available

STANDARD STATCOUNTER PROJECT

Traffic Summary

Location stats (Country/City/Region/ISP)

Search Engine Keyward Analysis

Systern Stats (browserfos/resolution) ®
Visitor Path Reports -
Popular Pages

Wisible counter/Invisible tracking

100% Free!

ADVYANCED STATCOUNTER PROJECT [IN DEVELOPMENT]

Exit link tracking
Download tracking
Unlimited log sizes
Upgrade Reguired
Coming Soon!

E-COMMERCE STATCOUNTER PROJECT [IN DEYELOPMENT]

Campaign Tracking
Overture/Adwords Tracking
Upgrade Required

Coming Soon!

@ On the project setup page illustrated in Figure 10.4, you’ll need to provide

details such as the web site’s name, the web address (URL), the site’s category,
and so on. You'll also be asked whether you want these statistics to be available
to others. The choice is yours, but personally, I'd choose to hide the statistics,
just because the link tends to look a little ugly on the page. Fill in the necessary
details, then press the Next > button.
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Figure 10.4. Selecting your project settings

PROJECT SETTINGS

Website Title Bubble Under

Website URL http:/Awww bubbleunder.com/
Category Sports v
Timezone GMTD0:00 Europe/London (GMT) w

Maximum Yisit Length

Used to calculate your unique and returning

visitors from a cookie, If this amount of

time or more has elapsed since a wvisitar

last visited a page on your website, then 30 mins W
that visitor is considered unique. We

recarnmend setting it between 1 and &

hours, We don't recommend setting it to 24

hours and above,

Log Size
Resources are limited, so we can only keep
a detailed log of your most recent visitors, 100

Unless you upgrade your account the
maximurm log size you can hawve is 100,

1P Blocking

If you have a fixed ip address, you can
specify to have this blocked, so you won't
artifically inflate your own count, Put each
IP address on a new line with no spaces if
you want it blacked. ©r empty the box if
you want to count all your visits.

Current IP address: 215.214.21.210

NON-ADMIN USER ACCESS TO THIS PROJECT
Public Stats O

Allow anyone to view your stats,

@ You'll receive a confirmation message to tell you that your project has been
created. The next step is to get the XHTML that you need to put onto your
web site. Click Configure & Install Code to continue.

[ As Figure 10.5 indicates, you’ll be asked to choose a display style for the
counter—do you want people to see how many visitors you’ve had, or do you
want to keep that information hidden? Once again, I'd choose to hide it
(showing your visitor numbers is so 1998!). Besides, until your web site has
been running for a while, the visitor figures may be quite low, and there’s no
need to advertise the fact. Make your choice, then continue once again.
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Figure 10.5. Selecting the counter type

VISIBLE COUNTER

This code will place a small, customisable

number on your pages indicating to you

and your visitors how many pecple have

visited each page. The counter's O
appearance can be adjusted using further

options in this wizard.

Example: BB00689EASY

INVISIBLE COUNTER

The code generated by this option will

make the counter invisibe, and no

indication to your visitors as to how ®
popular a particular page is.

VISIBLE COUNTER ON HOMEPAGE ONLY

This option will generate two pieces of

code - one for your homepage that will

display the counter there, and one for your o}
other pages which will make it invisible.

BUTTON ONLY

This option will generate code that simply
dizplays a StatCounter button - a great

Next =

@ Next, you're asked about the make-up of your web site through the form
shown in Figure 10.6. Do you use frames? If you've followed my advice so
far, the answer should be No, unless you're using a web forwarding service.
This page also gives you the option of making the counter W3C- and XHTML-
compliant. Ignore the overly fussy warnings about compatibility and check
both options—we don’t need to worry about these warnings because everything
we’ve covered in this book follows W3C recommendations.
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Figure 10.6. Settings relating to your web site’s technical
make-up

USE FRAMES?

Does your website use frames? Yzm, i wes s O
Most users do not have frames on their
website. Mo, my website does not uze frames ®

HTML ONLY COUNTER

If you web host does not allow you to

insert javascript inte your webpage then

you can use this option. Your stats will be O
extremely limited so we recommend you

move to a web host that will give you

proper FTF access to your website.

W3C COMPLIANT

Maintaining correct line breaks in your

code are crucial if you want to use W3C

valid HTML. If you are just worried about
your counter working all the time then

don't tick this box.

XHTML COMPLIANT

999 of users will not need this option.

Unless you are specifically familiar with
XHTML code don't tick this option as you

may get unintended validation errors.

If you are getting a pop up on your

webpage about displaying insecure items

with secure items you can use the secure

tracking option. But please note this puts i
an extra strain on our server and if you

receive a large number of secure hits we

may need to get in contact to charge

more.

If you wish you may disable the link back

to StatCounter in your code - however we [F]
would really appreciate it if you left it in!

Next >

@ The next page asks you if you use a (by which is meant a simple web page
builder offered by the likes of AOL, or a program like Dreamweaver or
FrontPage). Answer No and carry on.

@ On the next page, depicted in Figure 10.7, you’ll be given the code that you
need to insert into your web pages so that StatCounter can keep track of your
site’s traffic.
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Figure 10.7. The final markup is easily copied and pasted into
your web pages

% Bubble Under StatCounter Code Setup Wizard

Congratulations - Here is your Code!

You can configure many options relating to your counter again using the Configure Counter
page. If you need to change something that is not available on that page, you can come back
to the Install Code page to generate new code for your pages.

wWhat follows is your StatCounter code - simply copy & paste it exactly as it is into your pages
to start tracking your visitor datal Make sure you insert it after the <body> tag and before the
«/body> tag.

Your StatCounter code:

<1-- Start of StatCounter Code -->
< soript type="text/javascript’>
-
var sc_project=1232067;
var sc_invisible=0;
war sc_partition=11;
var sc_security="bfb3caed";
var sc_https=1;
var sc_remove_link=1;
=

</script>

< soript type="text/javascript"
src="https:/fsecure statcounter comy/counter/counter_xhtrml.js" =< /s
class="statcounter"==img class="statcounter"

sre="https//c12 statcounter.com/counter.php?sc_project=1232067¢
alt="counter statistics" />« /div></noscript>

«!-- End of StatCounter Code --=

That’s it for the sign-up process. Now all you need to do is put the generated
code into your web pages.

Adding the Statistics Code to your Web Pages

Your statistics code should look something like this (though specific details relating
to your account will differ):

<!-- Start of StatCounter Code -->
<script type="text/javascript">
<l--

var sc_project=1143403;

var sc_invisible=1;

var sc_partition=10;

var sc_security="bb4d77e9";

[]-->

</script>
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<script type="text/javascript"
src="http://www.statcounter.com/counter/counter_xhtml.js">
</script>
<noscript>
<div class="statcounter">
<a class="statcounter" href="http://www.statcounter.com/">
<img class="statcounter" src="http://c11.statcounter.com/cou
nter.php?sc_project=1143403&java=0&security=bb4d77e9&invisible=1"
alt="web statistics" />
</a>
</div>
</noscript>
<!-- End of StatCounter Code -->

To get yourself up and running, simply paste this code in your web page just
before the closing </body> tag (because we’ve chosen a tracker that’s invisible,
we needn’t concern ourselves with its position on the page). Here’s how it looks
in the context of the “About” page (which I've truncated somewhat):

File: about.html (excerpt)

<p>
Or as our man Bob Dobalina would put it:</p>
<blockquote>
<p class="fun">"Happiness is a dip in the ocean followed
by a pint or two of 0ld Speckled Hen. You can quote
me on that!"</p>
</blockquote>
</div> <!-- end of bodycontent div -->

<!-- Start of StatCounter Code -->
<script type="text/javascript">
<!--
var sc_project=1143403;
var sc_invisible=1;
var sc_partition=10;
var sc_security="bh4d77e9";
[[=-=->
</script>
<script type="text/javascript"
src="http://www.statcounter.com/counter/counter_xhtml.js">
</script>
<noscript>
<div class="statcounter">
<a class="statcounter" href="http://www.statcounter.com/">
<img class="statcounter" src="http://c11.statcounter.com
/counter.php?sc_project=1143403&java=0&security=bb4d77e9&invisible
=1" alt="web statistics" />
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</a>
</div>
</noscript>
<!-- End of StatCounter Code -->
</body>
</html>

Add the code to all of the pages in your web site, and save them all. If you've
created a Blogger template, you’ll need to update that with the statistics code,
too.

Now, try moving around the site, clicking on the links in the navigation, and
generally replicating the behavior of a “real” visitor to your site. Also, try refreshing
one of the web pages a few times—what we’re doing here is building up a bit of
dummy traffic to test things out.®

Next, log in to the StatCounter web site (using the details you provided at regis-
tration). Look for the little icon that looks like a bar chart—this is your way in
to the statistics display. Click the icon and you'll see a chart that shows a summary
of statistics. Perhaps you’d like to see which are the most popular pages on your
web site? Take a look at the navigation options and you’ll see a link to “Popular
Pages”—that looks like a sensible choice. The resulting display should look
something like Figure 10.8.

Figure 10.8. Pages ranked by popularity

Bubble Under {(Popular Pages) 26th January 2006

a1l This stat is based on your log of the last 100 pagelnads. Increase vour log size today!

TIP ¥ Click the little drill down arrow next to each webpage to show the users that visited

Webpage
25 fCi/Documents%20and% 208 ettings/Tan% 20Lloyd My % 2000cumentsWeb/about.bhtml
9 /fCi/Documents20and%20Settings/Tan%20Lloyd/My % 20Documents/ Web/svents html
9 fCi/Documents%20and% 205 ettings/Tan% 20Lloyd/My % 2000cuments Web/gallery html
& /fC:i/Documents%20and%203ettings/Tan%20Lloyd/My %20Documents/ Web/contact.htrml
& fCi/Documents%20and%205ettings/Tan% 20Lloyd/My % 20D0curments/ Web/index . htrnl

LI |

You can see from above that the system was able to track popular pages stored
on my hard drive (a web site address would be prefixed with http:/), and my

®Note that you must be online for this exercise to work. Although you are only making changes to
files on your hard drive at this point, the way this statistics system—and most others of this nature—
works is that it requests a file (usually a graphic) from the server, and appends to the filename a
bunch of data that links the file to your account. That request is what causes the system to keep a
record, so if you don’t have an Internet connection, it won’t work.
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brief clicking around the site has revealed that the “About Us” page was my most
popular choice.

There are many other useful statistics here—too many to go into in more detail,
in fact. My advice is to sign up, apply the statistics code, and upload your
amended pages to your web server. Then, simply leave it for a few days before
logging back in to check the statistics. By that time you might have enough data
to see some patterns beginning to form.

Getting a Bigger Log File

hote
You can see in Figure 10.8 that the logs created by StatCounter are based
on the last 100 page loads. On a popular web site, it won’t take long to reach
that number. This doesn’t mean that, once you reach 100 page loads, the
system stops reporting; instead, newer information effectively shunts the
older information into oblivion. It is possible to increase the log size, but
predictably, this will come at a cost. If you decide that the information you're
getting is not rich enough, you might want either to try increasing the log
size or trying out one of the other services I mentioned earlier—the process
for setting them up will be almost identical to the process I explained here.

What to Look for—a Summary

The most revealing statistics that will be available to you through StatCounter
include:

Exit pages: From which pages are people leaving your site to go somewhere
else?
If you can see a pattern forming, you can focus on these problem pages and
try to work out what it is that’s “turning people off.” Is the page too wordy?
Is it loading too slowly?

Browser and System Stats: What tools do people use to access your web
site?
IKnowledge is power. If you learn that 99% of your visitors are using one kind
of web browser, you might not spend quite so much time worrying about
display issues for the other 1% of users. This kind of information helps you
prioritize any bugs you might need to fix.

Came From: Through which web pages do visitors arrive at your site?
If another site has linked to your web site, and a user follows that link to
your web site, that information will be recorded on the Came From page. It’s
good to be aware of other web sites that have linked to you (if for no other
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reason than to give you an ego boost!), and why they’ve linked to you—lt s
easy enough to take a look at the “referring site” from these reports.’

A Search Tool for your Site

This one’s a cinch! We’ll have you set up in minutes. In times gone by, I would
have suggested registering for a service such as Atomz,® then configuring it pre-
cisely to fit your needs. However, now I use Google almost exclusively and find
the search results to be very good. If only it were possible to use Google to search
just your web site... Hang on—you can! And it’s a walk in the park to set up!

Here’s the basic markup you’ll need to get Google to provide search results based
on the content of your web site only:

<!-- SiteSearch Google -->

<form method="get" action="http://www.google.com/search">

<label for="q">Search:</label>

<input id="q" name="q" size="20" maxlength="255" value=""
type="text" />

<input name="domains" value="http://www.bubbleunder.com/"
type="hidden" />

<input name="sitesearch" value="http://www.bubbleunder.com/"
checked="checked" id="mysite" type="radio" />

<label for="mysite">Just this site</label>

<input name="sitesearch" value="" id="www" type="radio" />

<label for="www">WWW</label>

<input name="btnG" value="Go" type="submit" />

</form>

<!-- SiteSearch Google -->

All you need to do is change the parts in bold so that they match your web site’s
address. It’s so easy!

Here’s that same code implemented the Bubble Under web site (at least, on a
portion of the events page):

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"“http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">

’Sometimes, web site managers talk about “checking their referrer logs.” This is what that term
means—Ilooking through the lists of sites who have sent traffic to your web site, including search
engines (reviewing the search phrases users entered into search engines to find your site).

8 http://www.atomz.com/
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<head>
<title>Forthcoming club diving events and trips with Bubble
Under</title>
<meta http-equiv="Content-Type"
content="text/html; charset=utf-8" />
<link href="stylel.css" rel="stylesheet" type="text/css"
media="screen" />
</head>
<body>
<div id="header">
<div id="sitebranding">
<h1>BubbleUnder.com</h1>
</div>
<div id="tagline">
<p>Diving club for the south-west UK - let's make a
splash!</p>
</div>
<!-- SiteSearch Google -->
<div id="search">
<form method="get" action="http://www.google.com/search">
<label for="q">Search:</label>
<input id="q" name="q" size="20" maxlength="255" value=""
type="text" />
<input name="domains" value="http://www.bubbleunder.com/"
type="hidden" />
<input name="sitesearch" value="http://www.bubbleunder.com/"
checked="checked" id="mysite" type="radio" />
<label for="mysite">Just this site</label>
<input name="sitesearch" value="" id="www" type="radio" />
<label for="www">WWW</label>
<input name="btnG" value="Go" type="submit" />

</form>
</div>
<!-- SiteSearch Google -->
</div>
<!-- end of header div -->

Note that we need to position the search form in an appropriate location, and
format the text somewhat. I've used CSS to achieve this, using absolute positioning
to place the search box in the top, right-hand corner of the page. To do so, I
wrapped a div around the form and gave it an id. That way, I have some way of
referencing the form in the CSS, as shown below:

#isearch {
position: absolute;
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top: 77px;

right: 10px;
font-size: x-small;
font-weight: bold;

}

Figure 10.9 shows how the search box looks on the page itself.

Figure 10.9. The Bubble Under site with integrated search

3 Forthcoming club diving events and trips with Bubble Under, - Mozilla Firefox

File Edit ‘Wew Go Bookmarks Tools  Help

y. I, >
\::I - I_V’ - l@ 2.9 @ ||_| File:: i€ : [Dacuments % 20and%s20%ettings Bob % 2000halina My a2 00ocum V| @ 6o “Q,

BubbleUnder.com

Diving club for the south-west UK - let's makeaspfash" search: l:l @ Just thi

Home )
About Us Forthcoming Club Events

Club Events
Contact Us

Bubble Under members love meeting up for dive trips around the country. Below are
all the dive trips that we currently have planned. For more information about any of
them, please get in contact with that event's organizer.

Club events/dive trips for the next six months

Date Event Description b Approximate Cost Contact
Committee meeting, deciding an Bob
12 July WA .
next year's trips Dobalina
2 Tl 7-day trip to Hurghada (package |£260 pp {all inclusive), Bob
u
v deal) - limited spaces departing Luton Dobalina |
L O 2 Sports D Th Jeff
cean ports Diver Theory call for details =
August | Course Edgely
12 Murdear Mystery Weekend, £65 pp {accommodation il Smith
ill Sri
August | Cotswolds (no diving!) included) v
Done
p Google Scoped Search Limitations
nhote

Using Google’s service in this way is certainly easy, but you should be aware
of this solution’s limitations:

[ Google will only show search results if it knows about your web 51te—and
it will only know about it if you’ve submitted your web site’s address’ to

“You can notify Google of your web site’s existence at http:/www.google.com/addurl/.
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Google in the past (and Google has indexed it), or Google has found your
web site by following a link from some other site.

[ The search results may not be completely up-to-date. If you make changes
to your site, then upload those changes, Google may not recognize that
a change has been made for days or even weeks—it really depends on
when the search engine re-indexes your site.

[ The search results cannot be customized. The results page will look like
a standard Google search results page, but the linked search results will
all be pages from your web site (aside from sponsored links). However,
people are familiar with Google, so this view of the search results also has
its benefits.

Searching By Genre

At the time of writing, a new service called Rollyo (a “roll-your-own” search en-
gine) had just been launched. What this service allows you to do is to create a
custom search interface—one that lets you pick and choose what web sites you
want to search. So, if you're the caring, sharing type, why not try out Rollyo?

Note that these screenshots were taken just after the Beta launch, and as such,
they may differ slightly from the final version.

1 Click on the Register link and complete the scant details requested of you by
the registration page shown in Figure 10.10.
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Figure 10.10. The Rollyo registration screen

ROLLYO Roll Your Own

Register

Already a member? dick here to login

Username: bubbleunder Shhaoroas;;.;lsername between 5-20
Password:  wwwsvses (c:hhaoroas;;splassword between 5-20
Remember Me: Check this box to autarmatically login.
Emell: bob@bubbleunder.com o o e e

Register

[ Next, you'll be asked for profile information, and you’ll see a big red arrow
with the words, Skip this for now written on it. You know what to do!

[ On the following page, select the Create a custom searchroll link, as illustrated
in Figure 10.11.

Figure 10.11. Choose Create a custom searchroll

ROLLYO nextup.
@ Mow that you're all signed up, what do you want to do next?:

* Create a custom searchroll

Build a new searchroll from scratch by entering up to 25 Web
Roll your own search engine,  Sife addresses.

or...

* Explore Searchrolls

Browse through the hundreds of searchrolls that other users
have already created
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[ Next, in the page shown in Figure 10.12, you're asked to provide names for
your “Searchroll”—a list of web sites that you want to include—and also to
identify “tags” (keywords that describe your search facility’s purpose) that
you’d like to assign to your searchroll.

Figure 10.12. Adding sites that you want to search

Searchrul! BubbleUnder Choagse a name far your searchrall,

Be as descriptive as possible. (Limit 25
characters)
Sources: wuw.bubbleunder.com Enter up to 25 Web site address [URLs) -
ww . padi . com one per line.
wywyw.hsac.co.uk
wyw. subacgua. co. uk Rollyo searches entire sites such as
T G tiE] . @ L www.cnn.com or support.apple.com,

but not parts of sites, such as

AT o B E o e www.cnn.com/fpoliticsf.

Everything after the slash will be ignored.

® Need inspiration? Explare
searchrolls created by others,

Choose a category where you would like

Cateqgory: H
(Opgnn:;) Recreation & Spor‘ts W your Searchroll listed in the Raollyo
directory.
Tags: B o Enter any number of keywards, separated
(Optiogal) dl\l"e, lelng, scuba by commas, to help other user; find your

searchroll,

With that done, you can create your searchroll. At the time of writing, Rollyo
had not yet provided a simple method for grabbing the source code required to
place the search functionality on your own web site. However, it’s possible to
view the source of a web page, take what you need, then adapt it slightly. I've
done just that to show how Rollyo could be used on any web site. Here’s the
source code for the Rollyo search I created for Bubble Under:

<!-- SiteSearch Rollyo -->
<div id="search">
<form id="searchform" name="searchform"
action="http://www.rollyo.com/search.html" method="get">
<input type="input" name="qg" value="" id="search-box" /> in
<select id="searchmenu" name="sid">
<option value="6170">Bubble Under</option>
<option value="web">The web</option>
</select>
<input type="submit" value="Search" />
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</form>
<!-- SiteSearch Rollyo -->

Figure 10.13 shows how the search functionality displays on the web page (I
placed it in the absolutely positioned div, the same position we gave the Google
search box in the earlier example).

Figure 10.13. Adding a Rollyo search to the Bubble Under web
site

3 Forthcoming club diving events and trips with Bubble Under, - Mozilla Firefox

File Edit ‘Wew Go Bookmarks Tools  Help

<Z| - I_L:’ - l@ |_| @ ||_| file:/{ /! iDocuments%:20and%.205ettings/Bob % 2000balina /My % 200ocum V| @ Go “Q, |
® s éfiﬂ’ i, = i

BubbleUnder.com o Lt

PR - B r i AT B, St &
Diving club for the south-west UK - let's make a splash! |dive training |in| Bubhle Under + l Search .
Home .
About Us Forthcoming Club Events
Club Events

Bubble Under members love meeting up for dive trips around the country. Below are
all the dive trips that we currently have planned. For more information about any of

Contact Us

them, please get in contact with that event's organizer.

Club events/dive trips for the next six months

Date Event Description b Approximate Cost Contact
Committee meeting, deciding an Bob
12 July \ WA .
next year's trips Dobalina
2 Tl 7-day trip to Hurghada (package |£260 pp {all inclusive), Bob
u S h .
v deal) - limited spaces departing Luton Dobalina |
5 COcean % Sports Diver Theor Jeff
P ¥ Call for details
August | Course Edgely
12 Murdear Mystery Weekend, £65 pp {accommodation il Smith
- . ill Smi
August | Cotswolds (no diving!) included) v

Done

The next step is to submit your site to Yahoo! for indexing,'® if you haven’t
already. As with most search engines, it may take days or weeks before Yahoo!
visits your site and adds your pages to its database. Your Rollyo searchroll will
still work during this time, it just won’t include your site in the results it displays.

Finally, Figure 10.14 depicts the search results displayed on the Rollyo web site.

19 http://search.yahoo.com/info/submit.html
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Figure 10.14. Displaying the search results on Rollyo

3 Rollyo: Roll Your Gwn Search Engine - Mozilla Firefox

File Edit Wiew Go EBookmarks

Tools  Help

P,
C] = LL,‘ ~ @ @ ||_| hitp: ffws rollyo,comysearch.html?g=dive+tr aininglsid=6170

This is a beta of Rallyo. Please use our contact form to send us any feedback.

. dive training Iin: Bubbleunder
BAOLLYO Bubbleunder

BUBBL EUNDER
Add to my Rallyo

Brought to vou by
bubblzunder

SOURCES

Searching
Bubbleunder

bubbleunder....
padi.com
bsac.couk
subaqua.couw...

diveaid.cou..,

s | Tools

Search

Link to Searchroll Add to Firefox Search

Searchroll Web Results: Matched 2760, showing 1 to 15

Bubble Under - The diving club for the south-west
UK

Dive Rescue Training Simon and [ would like to plan a
Rescue Weekend (at Babbacombe) to enable all you
budding divers to practice the old skills, For those of you not
already Rescue Divers, no worries! we'll give you ...
http:/Awww bubbleunder.comydindesx . htrml

P&DI

Official site for the Professional Association of Diving
Instructors,
http: v padi.com,’

Divemaster
Guick find. Divernaster. Take the first step in your dive

powerad by YAHOO! SEARCH

Firefox 1.5

Rediscover the web

TOOLS

&dd to Firefo

Dane

This is a novel way of adding search functionality to your site—but it’s one that
could potentially send people in another direction! However, if your web site is
more of a fun venture, than focused on making cold hard cash, this could be the
ethical way to go. Believe me when I say it’ll be good for your karma—you’ll see!

Caution: Contents May have Shifted in Transit

hote

As I mentioned at the beginning of this section, Rollyo was new at the time
of writing (in fact, it was still in “beta” phase—it hadn’t been released to the
world at large). As such, the service may have changed a little, or even a lot,
by the time you read this—heaven forbid, it may even have disappeared al-
together! The latter is unlikely (because it’s a great service), but please be
aware that you may need to adapt some of the steps above if Rollyo’s service
does change slightly.
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Adding a Blogroll to your Web Site

What’s a blogroll? A blogroll11 is a list of links that’s included on your web site
(or blog), and which is easily updated from a central point. A blogroll is often a
better option than creating a specific page on your site just for links (which can
easily turn stale), and provides you and your visitors with an easy route to fresh
content on other web sites.

A range of tools are available for this purpose, but perhaps the simplest one to
try is Blogrolling. Here’s the process for setting up a Blogroll (once again, I've
used the Bubble Under web site as an example).

Signing Up for a Blogroll
O Go to the Blogrolling'? web site.

@ Follow the link to “Create Account”—you’ll be asked for an email address
and password, as Figure 10.15 shows.

Figure 10.15. Setting up a Blogrolling account

E-mail Address

[an email will be sent to this address with your account activation
information. )

lbob@bubbleunder.com

Password
(between § and 12 characters, letters and numbers only.)

Once you’ve submitted the form, Blogrolling will send you an email. Open it
and click on the activation link.

@ Once you've activated your account, you can create a new Blogroll (in fact,
you can create several different Blogrolls with just one account).

l,I http://en.wikipedia.org/wiki/Blogroll
12 http://www.blogrolling.com/
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Figure 10.16. Creating a new Blogroll

Roll name: [Bubble Under |

Enter the URL of your website where the blogroll will be displayed. This is used for
calculating the Top 100 links and the link search function.

If wou don't want your links or URL to be public set this blogroll as a PRIVATE in your
preferences, & valid URL iz still required but will not be included in the community
functions for private blogralls,

URL:|http:,ffbubb\eunder.cum,-’index.htm\ |

Simply enter a name and the web address of the page on which you’ll be dis-
playing the links, as shown in Figure 10.16.

[ Most of the tools you’ll need to manage your blogroll links are available from

the Blogrolling homepage.'® Figure 10.17 shows the Blogrolling “control
panel.”

Figure 10.17. All your Blogrolling options are available here

Bubble Under
@ Preferences G Add Links

© EditiDelete Links @ Get Code

©  Sidebar & Gockup
&) Dalets Blogroll &) Empiy Blogrolt
©  RecipRoll © Import OFML

& Get 4 Domain Name For Your Blog.
© Total Links: 0
& Total Displays: 0

© Public Roll

[ Select Add Links. You’ll be presented with a small form that looks like the one
in Figure 10.18.

]3By “homepage,” I mean the page that’s linked to by the word HOme in the left-hand navigation

menu that you see when you’re logged in to Blogrolling. I don’t mean the Blogrolling web site’s main
homepage.
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Figure 10.18. Adding a link to your Blogroll

ADD A LINK
ADDING LINK TO "BUBBLE UNDER"

BASIC OPTIONS
Title ®4 [Divernet @
URL [rittpn: ffwwews divernet.com @
Description [Diver Magazine onling @
Targetl | (7]
[] Set as default target (2]
Prority | 50 % E

Show advanced options

Return to
C members hame
@ add anather link

You could keep on adding links to this list until you run out of interesting web
site addresses, but bear in mind that if you add too many links, your web page
is going to start to resemble Yahoo! gone mad.

@ Once you’ve added links to your favorite web sites, you need to do just one
more thing: determine the order in which you’d like the links to display on
your web site. Select Preferences and scroll down to the section that says
Sorting your links, as illustrated in Figure 10.19.

Figure 10.19. Setting the order in which your links appear on
the page

Sorting your links

These option: control the order in which the links in your BlogRoll are shown.
(> Random
() Alphabetically
() Priority

() Recent

[ Now all you need to do is get the code required for this feature to function
on your web site. Go back to the Control Panel’s homepage and click on the
Get Code link. You should see something like this:
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<script language="javascript" type="text/javascript"
src="http://rpc.blogrolling.com/display.php?r=ad7cab20d092c
2ee809d009e26ffcc11"></script>

Integrating the Blogroll with your Web Site

Usually, people add blogrolls to their sites’ homepages, where it’s often tucked
away to one side. I'm going to do the same with the Bubble Under blogroll.

As with the other sections on your web site, it’s a good idea to wrap the blogroll
in a div with an id. This approach will allow you to reference the div in a style
sheet, and makes it easy to find the blogroll when you look through the markup
at a later date. Here’s the markup for the Bubble Under home page (index.html),
once the blogroll has been added:

File: index.html (excerpt)
<div id="navigation">
<ul>
<li><a href="index.html">Home</a></1i>
<li><a href="about.html">About Us</a></1li>
<li><a href="events.html">Club Events</a></1li>
<li><a href="contact.html">Contact Us</a></1li>
<li><a href="gallery.html">Image Gallery</a></1li>
</ul>
</div>
<div id="bodycontent">
<div id="blogroll">
<h2>Recently updated Diving Sites</h2>
<script language="javascript" type="text/javascript"
src="http://rpc.blogrolling.com/display.php?r=ad7cab20d092c2
ee809d009e26ffcc11"></script>
</div>
<h2>Welcome to our super-dooper Scuba site</h2>
<p><img src="divers-circle.jpg" alt="A circle of divers practice
their skills" width="200" height="162" /></p>
<p>Glad you could drop in and share some air with us! You've
passed your underwater navigation skills and successfully
found your way to the start point - or in this case, our
home page. </p>

Without any further intervention, your list may look a little on the dull side.
Let’s suppose you wanted to style your blogroll. This code will do the trick:
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#blogroll {

float:

margin-
margin-
margin-
margin-

width:

border:

right;

top: 55px;
left: 10px;
bottom: 10px;
right: 10px;
130px;

1px solid #006;

font-size: x-small;

}

#blogroll h2 {
font-size: x-small;
background: #006;

color:

#HEFF;

padding: 5px;

margin:

}

0;

#blogroll div {
padding: 5px;

}

Note that I've used contextual selectors (remember them from Chapter 3 and
Chapter 4?) to style the heading as well as the links themselves. Although you
can’t see it from the code extract that Blogrolling provided to us (all that’s visible
is a link to a JavaScript file), each link that we add is wrapped in a div. I've added
a little padding to each div inside the blogroll container, like so:

#blogroll div {
padding: 5px;

}

Also note that I've floated the blogroll div, and given it a specific width. This
will place the list on the right-hand side of the screen (to the right of the previously
floated feature image). Figure 10.20 shows how all this fits together on the page.
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Discussion Forums

Figure 10.20. The blogroll in place

¥3 Bubble Under, - The diving club for the south-west UK - Mozilla Firefox
File Edit  Wiew Go Bookmarks  Tools  Help

CEI - |:> - @ |:| @ | hitp: ffwwes bubbleunder .com) v| 0© = “Q' |

BubbleUnder.com © i & ki
Diving club for the south-west UK -let's make a splash! | |in| Bub

c -, ¥ .
hle Under Vl Search .

Home i
About Us Welcome to our super-dooper Scuba site
Club Events
l:lntal:t Us

Glad you could drop in and
share some air with us!
You've passed your
underwater navigation skills
and successfully found your
way to the start point - or in

Scuba Diving

¥acation
Divermnet

BSALC

this case, our home page. Subagua

Powered b
Tuesday, January 24, slototiins
2006

New Legislation Around the Corner

Just a quick heads-up -- there's new legislation on the harizon that will affect what
you can and can't fill {as in tanks). I don't have all the details right now, but T'll be ha

Dane

We’ve added a blogroll! Now, any time you add a good web site to your book-
marks, if it is related to your own web site’s theme, you might consider adding
it to your blogroll, too. All you need to do is head over to the Blogrolling site,
log in, and add a link as we did above.

Discussion Forums

Arguably one of the best ways to create a virtual community around your web
site—and to ensure that people come back time and time again—is to provide a
chat forum. There is one small problem with this, though—forums aren’t partic-
ularly straightforward to set up, and once you start to get regular posts appearing,
you’ll face the issue of moderating the forum’s content. Will you moderate it
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yourself? Will you just let things take their own course?'* Will you empower
other regular visitors to moderate the forums?

Most of the fully featured (and free) forum software products that you could use
have some prerequisites that basically rule out my covering them in this book.
For example, many packages require your hosting company to support PHP (a
“scripting language”) and to make a MySQL database available to you. At this
stage, this is probably still something of a foreign language to you.

A simple solution for creating a community is to use Yahoo! Groups.ls Signing
up for the service is as simple as registering for an email account with Yahoo!
Then, you can invite people to take part by registering for the discussion group
themselves.

The beauty of using Yahoo! Groups is that many people will already be familiar
with the mechanics of the Yahoo! services, and they may already have sign-in
details that they can use (from their Yahoo! mail accounts). Also, the service is
provided by a company that you know and can trust and, as such, it’s unlikely
to disappear overnight—taking your new virtual community with it.

The downside of using Yahoo! Groups is that this option takes users away from
your web site. The best that you can do is to provide a link from your web site
to the group that you set up. From that point forward, your community is entirely
in the hands of Yahoo! (capable though they are), which could also present
problems if you ever wanted to move the forum content to another location.

Summary

In this chapter I've shown that no matter how much work you’ve put into
building your web site, there’s always something else that you could do to add a
finishing touch or two. I've focused on some add-ons that, I believe, really do
improve a web site and encourage you—as well as others visiting the site—to use
it more. However, I would like to sound one note of warning at this point, and
it is this:

Know when to stop!

"4The short answer to that one is: no! If you give people the option to run wild, they may well do
just that, which could even get you into hot water, legally speaking. For example, someone could
slander someone else on your forum, or link to copyrighted material for others to download, and you
as the web site owner could be responsible for those people’s actions. Moderation is a great idea.

15 http://groups.yahoo.com/
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Summary

There are many web sites still kicking around today that were built in the mid-
to-late 90s, when the motto seemed to be “the more flashing/spinning/bouncing
widgets on the page, the better the web site.” Thankfully, as the art of web design
has matured, people have come to realize that “less is more.” Please bear this in
mind when adding features. Otherwise, before you know it, the “bells and whistles”
will have taken over completely!

f Don’t Be too Reliant on Third-party Services
nhote

There’s one other reason not to go overboard adding to your web site features
provided by a third party. If that third party’s web server is running slowly
for some reason, and your web page is trying to access something from that
provider’s server, your web page may appear to load slowly. Also, you need
to be careful about “putting all your eggs into one basket.” If the service you
use is free, be prepared for the eventuality that one day, the owners may
decide to close the service down, or charge for it. Would your web site be
able to function properly if this happened?

At this point, your web site should have all the features that it needs. You've
followed the advice I've given in this book, and you have a well-formed, standards-
based web site that you can be proud of. If you've enjoyed designing and building
your web pages, you might want to improve your skills even further. Instead of
me leaving you to fend for yourself at this point, I'm going to make some sugges-
tions about where you can go to get the skills you need, because, frankly, there
are an awful lot of bad web sites and books out there, and you could easily pick
one up by mistake. The last thing I want is for you to undo any of the good work
you’ve done so far! So, let’s continue on to the final chapter, in which we’ll explore
the possibilities that now lie before you.
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What’s Next?

If you've enjoyed these chapters from Build Your Own Web Site The Right
Way Using HTML & CSS, why not order yourself a copy?

Build Your Own Web Site The Right Way Using HTML & CSS is the most
easy-to-understand, fun, and comprehensive guide to learning the building
blocks of web development—HTML and CSS. In these sample chapters,
you've so far learned the basics of HTML, and played with some CSS—and
you've seen the end of the book where you get to add some really cool stuff
to your site, like a search facility. In the rest of the book, you'll get a much
better grounding in more complex CSS (like using CSS for positioning),
you'll get up to speed with other important web development concepts, like
accessibility, and you won't pick up any bad habits along the way!

Join guru web developer, Ian Lloyd, as you build a complete, fully-featured
web site together.

Build Your Own Web Site The Right Way Using HTML & CSS includes
download access to all of the best practice code samples and graphics used
in the book—so you can follow along without any retyping, and easily
adapt the code for use on your own web sites.

In the rest of the book, you’ll:

Layout your web site using CSS

Create images and other graphics

Use tables correctly

Build forms to interact with your visitors

Find a web host

Get your site online

Make sure your site is accessible to those with disabilities
Promote your site

Add a blog to your site to make updating it easy

Get a complete XHTML reference, complete with examples
And a whole lot more!

[y iy oy oy Sy S Wy

On top of that, order direct from sitepoint.com and you’ll receive a free
17" x 24" poster of your choice!

Order now and get it delivered to your doorstep!
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A

<a> element, 45, 59, 424
A List Apart web site, 408
“About Us” sections, 44, 56
about.html file, 56, 58
<blockquote> example, 64, 106
<em> modification example, 91
external style sheet linking, 78
inline style example, 71
absolute positioning, 147-161
text resizing and, 163
accessibility, 178-181
order of form controls, 287
tables, 227, 232-241, 244-246
validating, 331
action attribute, <form> element,
253,270
action attribute, Response-O-Matic,
296
add-ons, 375-403
blogrolls, 396-401
discussion forums, 401-402
search tools, 388-395
statistical reports, 376-388
address bar, appending input, 252-253
alignment, relative positioning, 163
(see also text-align property)
alpha channel transparency, 183
alt attribute, <img> element, 47, 176
equivalent for tables, 234
guidelines, 180
ampersands, introducing entities, 38—
39
anchor element, 45, 59, 424
Apache web server, 315
assistive devices (see screen readers)
attributes, XHTML, 24-25, 421
Audion media player, 183

B

<b> element, 94
background colors
background images and, 207, 211
Bubble Under navigation area, 135-
136
background images, 207-220
Bubble Under web site, 216-217
fixed size, 214
horizontal repeats, 209, 241
non-repeating, 212
table captions and, 239
table cells, 241
vertical repeats, 211
background property, 213
background-color property, 85, 89
background-position property, 213
background-repeat property, 209, 211-
212
bandwidth, 305, 313
BareBones Software, 9
block-level elements, 114-116
adding padding, 139
borders, 124-132
box model, 142
<div>s as generic, 437
fixed size, 214
forms, 250
IE width bug, 412
inline distinguished from, 114, 119
positioning, 144-171
sizing, 120-124
styling, 119-132
<blockquote> element, 63, 106, 427
Blogger, 338, 340
Advanced Setup options, 343
markup, 354
registration, 341




Index

styling and validating the templates,
362-370

updating templates for statistics, 386
Blogger-generated markup, 351, 372
blogrolls, 396
blogs, 337-374

anonymous comments, 362

management services, 338

self-hosting services, 339

soliciting contributions, 372

test postings, 348, 370

validating markup, 367, 370
<body> element, 29, 428

borders, 133

styling, 79
bold text, 65, 94
boolumarks

blogrolls and, 401

Cyberduck FTP client, 323

“get” method and, 253

<title> element display in, 27

web forwarding services and, 310
border property, 130

absolute positioning and, 148

styling links as buttons, 172
border-bottom property, 130
border-collapse property, 231, 237
borders

adding padding, 138

adding to block-level elements, 124—

132

bold effects, 127

Bubble Under <body> element, 133

Bubble Under header area, 157

CSS properties for, 125

image galleries, 189

styling, 129, 131

table styling with, 230

temporary, as layout aids, 144, 155
Box Model Hack, 413
box model, CSS, 142
<br> element, 66, 429

broadband internet, 1, 101, 305
browser window resizing, 219
browsers, xv

(see also Firefox; Internet Explorer;

Safari)

caching problem, 83

checking appearance in, 2, 264, 317

clearing browser history, 104

client-server model, 303

content overflows and, 123

CSS hacks and, 413

CSS support, 77

hiding markup in comments, 37

statistics on visitors’, 387

table rendering by, 227

viewing source markup, 20, 31, 393
Bubble Under web site, 39

area styling, 157

block-level element styling, 133-144

blog functionality, 357

blogroll for, 399

contact page using a form, 268

drop-down list example, 281

events diary, 224, 234-241

full layout, 158

header area styling, 218

heading styling, 137, 140

homepage, 40-66

image gallery, 185, 206

linking pages, 59

multi-page version, 55

navigation area sizing, 135

navigation styling, 171, 215

padding, 140

radio button and checkboxe example,

285

Rollyo search functionality, 393

search tool integration, 388-391

submit button example, 287

tag line styling, 136, 141, 217

textarea example, 283
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bullet points (see list-style-type prop-
erty)
buttons, 172, 287
submit buttons, 252, 263, 287

C

caching problem, 83
calendar of events, 224
capitalized text, 92
<caption> element, 191, 234, 236,
239,431
captions, image, 191-196
case sensitivity, XHTML, 32, 50, 296
cell spacing, 231
Centricle.com, 413
character sets, 28
character verification, 345
chat (see discussion forums)
checkboxes, 258, 285
<cite>element, 65
class attributes, 106, 232, 372, 421
alternative approaches, 194
styling forms, 270
class selectors, 105, 107, 232
classes, naming, 125
“Click here” links, 60
client-server model, 303
client-side scripting, 415-416
closing tags, 26, 54
code
archive, xix, xxiii
distinguished from markup, xviii
examples within markup, 53
color names, 88
color picker tools, 86, 135
color property, 70, 74, 89
colored borders, 126
colors
link states, 101
specifying, 85, 88
colspan attribute, 243, 246

column-based layouts, 415
columns, XHTML and, 228
comma separator, CSS selectors, 98
comment spam, 362
comments, CSS, 77, 156
comments, XHTML, 35-38, 54, 422
common attributes, 421
conflict resolution, CSS rules, 99, 108
“Contact Us” sections, 44, 56
contact.html file, 56-57, 59, 78
containing elements, 114,117, 119
content areas
absolute positioning, 153
dividing, using bottom borders, 130
overflowing their <div>s, 123
context-sensitive styling, 94
contextual selectors, 96, 400
cropping images, 196
CSS, xix, 69
browser support, 77
context-sensitive styling, 94
current version, 410
design examples, 408
discussion lists, 411
embedded styles, 74-76
external style sheets, 76-79
grouping styles, 97
inline styles, 70-73
layout and positioning use, 113
resources, 408-415
style sheet filenames, 100
style sheet web addresses, 365
table-based layouts and, 226
validation, 331
CSS box model, 142
CSS hacks, 413-414
CSS Zen Garden, 408
CSS-Discuss, 411, 414
curly braces, 74-75
Cyberduck tool, 323, 349
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D
Dashboard, Blogger, 353
dashed borders, 127, 129
database support, 315, 317
declarations, style attribute, 70
default value setting
checkboxes, 259, 262
radio buttons, 261
text boxes, 257
disabilities, users with, 176, 178
discussion forums, 401-402
(see also SitePoint forums)
distinguished from lists, 412
promoting your site, 334
discussion lists, 411-412
display property, 280
<div> elements, 49, 437
content overflows and, 123
context-sensitive styling, 95
fixed background images, 214
form controls, 275
image gallery, 191
nesting, 52, 160
site navigation, 60
using with restraint, 54
Dive Into Accessibility site, 178
diving club site (see Bubble Under)
dock, Mac OS X, 6, 26
doctype switching, 143
doctypes, 22, 328, 423
domain names, 305, 307, 317
dotted borders, 127-128
double borders, 129
double dashes, 36
download speeds, 227, 240
drag and drop uploading, 322, 325
Dreamweaver, Macromedia
creating tables with merged cells,
244
difficult markup, 28
FTP facilities, 326

validation functionality, 329
drop-down lists, 261, 281
drop-shadow effect, 184
DTDs (see doctypes)
dynamic content, 315, 418

E

editors (see image editors; text editors)
elastic web design, 164
elements, HTML, 94
elements, XHTML, 19, 23
(see also empty element notation)
alphabetical list, 424-476
applying class selectors to, 108
Blogger-specific tags and, 351
common attributes, 421
context-sensitive styling, 94
forms and, 250
HTML Dog and, 408
inline and block level, 113-120
intended purposes, 50, 64, 110
positioning, using CSS, 144-171
symmetry requirement, 118
tables and, 228
<em> element, 36, 65, 91-92, 439
em measurements, 140, 164
email
clickable links to addresses, 45
folders, 412
preferred discussion list styles, 412
signatures as promotional devices,
334
web hosting services and, 314
email forwarding, 315
embedded styles, 74-76, 191
empty element notation, 24
<br> element, 66
<img> element, 176
<link> element, 78
<meta> element, 28
entities, 38
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events diary example, 224
example web sites

(see also Bubble Under web site)

features, xvii, xix

hard drive file locations, 14-17

multi-page sites, 54

Turkish Shaving Stories, 162
external style sheets, 76-79
Extreme Tracking service, 378

F
fade effects, 211, 217
favorites (see bookmarks)
<fieldset> element, 253, 269, 271-
272, 440
file extensions
displaying in Windows Explorer, 55
image formats, 181
XHTML files, 30
file sizes, 311, 313
filenames, style sheets, 100
files, storing locally, 14-17
FileZilla for Windows, 319-323, 349
Firefox browser, xv, 8
basic web page display, 31
Bubble Under homepage display,
42-43, 46
forms appearance, 264
image display, 48, 183
list display, 35
Fireworks, Macromedia, 10-11
flexible design through CSS, 226
Flickr photo-sharing service, 207
float property, 165, 280, 400
floated positioning, 164-171
font sizing, 414
(see also text resizing)
font-family property, 79-80, 89
font-size property, 88-89, 237
font-style property, 90, 92-93
font-weight property, 70, 89-90

footers, 97, 415
for attribute, <label> element, 256
forced reloads, 83
<form> element, 250, 252, 269, 441
forms, 249-301
accessibility, 287
appearance in different browsers,
264
Bubble Under contact page, 268
controls, 255
elements of, 250
email feedback, 299
grouping elements, 254
processing the data, 269, 290-301
search form styling, 389
styling controls, 272
forums (see discussion forums)
frames, 308, 382
FTP, 2, 305, 311, 318

G

“get” and “post” methods, 253

GIF image format, 181-182, 203
Google bookmarking, 253

Google search tool, 388, 390
GraphicConverter, 13, 199, 201, 203
graphics (see images)

greater-than symbol, 38

grouping content with <div>s, 50

H

<hl> element, 31-32, 82, 442

hacks, CSS, 413-414

<head> element, 25-29, 443
as code location, 29
links to style sheets, 77
<meta> element and, 27
<style> element location, 74

header area styling, 218

headers attribute, 246
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headings
(see also <hl> element)
levels, and splitting pages, 56
sequence within documents, 32, 56
space around, 150-151
styling, 82, 137, 140
height property, 121
hexadecimal color, 85-87, 240
hidden inputs, 258, 296-297
hierarchy of headings, 32, 56
highlighting submit buttons, 289
holiday booking forms, 249
horizontal background repeats, 209,
241
hosting (see web hosting)
hover link state, 102
HTML, xviii, 94
(see also XHTML)
HTML Dog, 408, 410
<html> element, 24, 444
HTTPS protocol, 258
hyperlinks (see links)

<i> element, 94

id attributes, 421
context-sensitive styling, 96
<div> elements, 50
<input> element, 257, 260
merging table cells, 246
uniqueness requirement, 51

id selectors, 107

image editing, 196-204

image editors, 10-14, 197-204
GraphicConverter as, 13
iPhoto as, 13
Picasa, 11, 197, 200, 202
special effects, 200

image formats, 181-182

image galleries, 185-196, 204-206

images, 175-221

(see also <img> element; background
images)
alternative text, 176, 180
captioning, 191-196
resizing, 202
sourcing, 206-207
transparency, 182-185
visual appeal and, 10
<img> element, 46, 176, 446
floating individual images, 169
web address for, 365
indenting, 53, 64, 354
inline elements, 116
block-level distinguished from, 114,
119
converting to block-level, 280
styling options, 119
inline images, 175-181, 207
inline styles, 70-73, 75
<input> element, 255, 447
<label> element and, 256
submit buttons as, 263
inset borders, 126
interactivity (see forms)
internationalization, 421
Internet Explorer, xv, 4
block element rendering in Win-
dows, 412
box model problems in IE 6, 143
clearing the browser history, 104
empty <fieldset>s, 271
forms appearance, 265
Mac support, 6
PNG image support, 182-183
iPhoto image editing, 13, 204
ISPs (Internet Service Providers), 304,
307
italics, 36, 65,91, 94

J

JavaScript, 384, 400, 415-416
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JPEG image format, 181, 202-203

K
keyword-based settings, 88

L
<label> element, 256, 278, 449
languages
(see also scripting languages)
internationalization and, 421
layers, image editing, 10
layout
(see also positioning)
use of tables, 226
<legend> element, 253, 269, 272,451
legibility (see readability)
less-than symbol, 38
letter-spacing property, 106
<li> element, 33, 451
limericks, 66
line feeds, 66
linearizing tables, 227, 233
line-breaks, 275
line-height property, 87, 97
<link> element, 77, 364, 452
link exchange, 335
link states, 101, 103, 136
links
(see also < a> element)
Bubble Under web site pages, 59
checking, on uploaded pages, 326
clickable email links, 45
images as, 180
removing underlining, 97
statistics on inward, 387
style sheets to web pages, 77
styling as buttons, 172
links pages, blogroll alternative, 396
Linux operating system, 9
list items (see <li> element)
List-O-Matic tool, 173

lists, 33, 171

list-style-type property, 171
LiveJournal service, 338
location.href attribute, 367, 369
logos as backgrounds, 212

M
Mac OS X
browser checks recommended for,
317
file properties in, 313
Firefox and, 9
forms appearance in, 266
FTP clients, 323
Sites folder, 16
software tools available, 5, 8, 12
margin property, 142, 148, 193
margins, 150, 274
marketing, 332
markup, xviii
(see also CSS; HTML; XHTML)
commenting out, 37
comparing with browser views, 31
examples, xxv, 22, 33, 43
generated by Response-O-Matic, 292
image gallery, 204
indenting, 53, 64
site navigation, 60
validation, 328
viewing source code, 20, 31, 393
maxlength attribute, <input> element,
257
measurement units, 140, 165
media types, 412, 415
<meta> element, 27, 454
method attribute, <form> element,
252,270
mouseless form submission, 264
Movable Type service, 339
MSN Spaces service, 339
multiple checkbox selections, 262
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My Documents folder, 15, 321

N
name attribute, <input> element, 256,
260
name attribute, Response-O-Matic,
298, 301

navigation areas
absolute positioning, 153
background images, 215
expanding relative addresses, 365
markup location, 60
multi-page sites, 59
sizing, 121, 135
styling lists, 171

nesting
absolute positioning and, 159
<div> elements, 52, 160
<fieldset> and <legend> elements,

254

inline elements, 117, 119
revealing, using borders, 146

new lines, starting, 66

Notepad, 3, 30, 56

NoteTab editor, 7

o

<ol> element, 33, 456

Open Directory Project, 333

operating systems (see Mac OS X;
Windows)

<option> element, 261, 457

ordered lists, 33, 456

overflow property, 124

P

<p> element, 31-33, 458
<div> elements compared to, 49
styling, 74, 120

padding property, 87, 138
avoiding text wrapping, 167

margin property and, 142
removing for absolute positioning,
148

table headings, 231, 237-238
padding, Bubble Under layout, 140
padlock icon, HTTPS, 258
page ranks, 386
page reloads, 310
Paint Shop Pro, 10-11, 204
paragraphs (see <p> element)
password input controls, 257
percentage measurements, 140
period class selectors prefix, 106
photographs (sec images)
Photoshop, Adobe, 10-11, 200, 204
PHP language, 418

(see also server-side scripting)
Picasa image editor, 11, 197, 200, 202
pixel sizing, 87

borders, 128

image resizing, 203

images, 47

suitability, 140
plain text editing, 5, 30
PNG image format, 182-183
popularity page rank, 386
popup ads, 306
positioning elements using CSS, 144-

171

absolute positioning, 147-161

floated positioning, 164-171

relative positioning, 161
“post” method, form submission, 253
pound sign, id attribute prefix, 96
<pre> element, 53, 459
preselecting (see default values)
presentational HTML, 94
print style sheets, 412
project (see Bubble Under web site)
promoting your site, 332
properties, CSS, 70, 89
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pseudo-classes, CSS, 102

Q

Quickconnect feature, FileZilla, 322
quirks mode, 143
quotation marks, 50, 83
quotations
<blockquote> element, 63
<cite> element, 65
discussion list replies, 412

R

radio buttons, 259, 285
readability
backgrounds and, 208
font style and, 80
line-height and, 87
markup, 354
referrer statistics, 377, 387
refreshing pages, 83, 310
relative positioning, 161
reserved characters, 36, 38
resizing images, 202
resizing text, 163, 218
resources, 307
(see also SitePoint forums)
CSS, 408-415
image libraries, 206-207
image resizing tutorials, 204
XHTML, 406-408
Response-O-Matic service, 290
ridge borders, 126
Rollyo search engine, 391
row and column scopes, 245
rowspan attribute, 243, 246
rules, CSS, 74-75
grouping, 137
precedence, 99
specificity, 108
syntax, 237

S
Safari browser, 6, 267, 288
sans-serif fonts, 80
scope attribute, 244
screen readers, 178
<em> and <strong> elements, 94
summary attribute and, 234
tables and, 227, 232
scripting languages
advanced forms processing, 301
client-side scripting, 415-416
discussion forums, 402
server-side scripting, 315, 416-418
search engines
(see also Google; Rollyo; Yahoo!)
<em> and <strong> elements, 94
submissions to, 333
search tools, 388, 390-391
“Searchrolls”, Rollyo, 393
security, 253, 258
<select> element, 261, 281, 463
selectors, CSS, 74-75
class and id compared, 107
class selectors, 105
contextual selectors, 96, 400
grouping styles, 98
self-closing elements (see empty element
notation)
semicolons
CSS declaration separator, 71
entity terminator, 39
serif fonts, 80
servers
uploading files to, 318-326
web hosting and, 304
server-side scripting, 315, 416-418
client-side and, 416
discussion forums, 402
languages, 417
SFTP, 345
shorthand properties, 130, 213
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sidebar, Mac OS X, 16
single-pixel borders, 128
SitePoint forums, 17
CSS, 332
promotional techniques, 333
scripting languages, 416, 418
web hosting and, 307
size attribute, <input> element, 257
software requirements, 1-9
(see also code)
source code views, 20, 31, 393
spacing
between characters, 106
cell spacing, 231
negative margins, 274
<span> element, 72-73, 109, 464
special characters, 36, 38
specificity and CSS rules, 108
src attribute, <img> element, 47, 176,
188
SSIs (Server Side Includes), 315
StatCounter service, 378-388
statistical reports, 306
adding StatCounter code, 384
choosing and adding a service, 376
key statistics, 387
log file limits, 387
storage space, web hosting, 311
<strong> element, 65, 94, 465
style attribute, 70, 73, 421
<style> element, 74, 465
style rules (see rules, CSS)
style switching, 414
submit buttons, 252, 263, 287
summary attribute, <table> element,
233-234, 236
symbols and entities, 38
symmetry, XHTML tags, 118

T
<table> element, 228, 236, 468

table-based layouts, 226
tables, 223-247
advanced techniques, 242-246
default appearance before styling,
229, 236
elements of, 228
merging cells, 242, 246
styling, 241
tag line styling, 136, 141
tags in XHTML elements, 24, 26, 54
Taskbar, Windows, 26
<td> element, 228, 236, 470
templates, Blogger
customizing, 351
editing, 354
selecting, 346
styling and validating, 362-370
updating for statistics, 386
writing, 352
templates, Response-O-Matic, 291
temporary borders, 144, 155
text
(see also paragraphs)
alternative to images, 177
styling fragments, 72-73, 109
text editors, 2, 77
Notepad, 3
NoteTab, 7
TextEdit, 5, 30, 56
TextWrangler, 9
text input controls, 256, 275
text overlay effects, 214
text resizing, 163, 218
text sizing (see font-size property, CSS)
text wrapping, avoiding, 167
text-align property, 231, 238
<textarea> element, 262, 283, 470
text-decoration property, 90
TextEdit, 5, 30, 56
Textpattern service, 339
text-transform property, 92
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TextWrangler editor, 9

<th> element, 228, 236, 238, 472
third-party services, 377, 403
thumbnail images, 205

time zones, 379

<title> element, 25-26, 56, 473
tools, software, 1-9

top-down formatting, 412

<tr> element, 228, 236, 474
transparent images, 182-185

Turkish Shaving Stories, 162, 165, 169

TV listings example, 233

type attribute, <input> element, 255-

256

typefaces (see font-family property,
CSS)

typographic conventions, xxv

U

<u> element, 94

<ul> element, 33, 475

underlining, 90, 94, 97

units of measurement, 140, 165

unordered lists, 33, 475

uploading to the Internet (see web
hosting)

uppercase, 92

URLSs (Uniform Resource Locators), 23

(see also web addresses)

web forwarding services and, 309
user interaction, 249
UTE-8 character set, 28, 30

\'
validation
CSS hacks and, 414
CSS of uploaded sites, 331
markup of uploaded pages, 328
value attribute, <input> element, 257,
260, 264
vertical background repeats, 211

visited links, 104
visitor counts, 377
(see also statistical reports)

w

W3C (World Wide Web Consortium),

23
CSS Specification, 410
CSS Validator, 331
Link Checker, 326
Markup Validator, 329, 367, 370
XHTML recommendations, 407
W3Schools, 407, 410, 415-416
WaSP (Web Standards Project), 20
web addresses, 305, 307-308, 365
web browsers (see browsers)
Web Design Group, 331
Web Design-L, 411
web development tools (se¢ Dream-
weaver)
web forwarding, 308-310
web hosting, 303-335
bandwidth allowance, 314
Blogger and, 343
free services, 306
jargon, 305
paid services, 310
server space, 306, 311
uploading files, 318-326
web page editors, 383
web page essentials, 19-39
web page examples (sece example web
sites; markup)
web server software, 315
web standards, xv, 20, 317, 405
weblogs (see blogs)
webmail, 314
width property, 120, 280
“wiki” pages, 414
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Windows
browser checks recommended for,
317
file locations, 14
file properties in, 311
forms appearance in, 264
FTP clients, 319
software tools available, 3, 7, 11
XP use within this book, xv
Windows Explorer, 55
word verification, 345
‘WordPress service, 339

X
XHTML, xviii, 19
(see also elements, XHTML)
resources, 406-408
Response-O-Matic markup and, 296
XHTML 1.0 recommendation, 407
XHTML 1.0 Strict doctype, 23, 329

Y
Yahoo! Groups, 402
Yahoo! search engine, 394

488 Order the print version of this book to get all 500+ pages!



http://www.sitepoint.com/launch/81f2b9

	Build Your Own Web Site The Right Way Using HTML & CSS
	Table of Contents
	Preface
	What is a Browser?
	Who Should Read this Book?
	What you’ll Learn from this Book
	How you’ll Learn to Build your Web Site
	HTML, Markup, CSS… Welcome to your First Bits of Jargon!
	Building the Example Site
	What you Can Expect from the Example Web Site

	What this Book Won’t Tell You
	What’s in this Book?
	The Book’s Web Site
	The Code Archive
	Updates and Errata

	The SitePoint Forums
	The SitePoint Newsletters
	Your Feedback
	Acknowledgements
	Conventions Used in this Book

	Setting Up Shop
	Tooling Up
	Planning, Schmanning

	The Basic Tools you Need
	Windows Basic Tools
	Your Text Editor: Notepad
	Your Web Browser: Internet Explorer

	Mac OS X Basic Tools
	Your Text Editor: TextEdit
	Your Web Browser: Safari


	Beyond the Basic Tools
	Windows Tools
	NoteTab
	Firefox

	Mac OS X Tools
	TextWrangler
	Firefox


	Not Just Text, Text, Text
	Windows Tools
	Picasa

	Mac OS X Tools
	GraphicConverter
	iPhoto


	Creating a Spot for your Web Site
	Windows
	Mac OS X

	Getting Help
	Summary

	Your First Web Pages
	Nice to Meet you, XHTML
	Anatomy of a Web Page
	Viewing the Source
	Basic Requirements of a Web Page
	The Doctype
	The html Element
	The head Element
	The title Element
	meta Elements
	Other head Elements
	The body Element
	The Most Basic Web Page in the World
	Analyzing the Web Page

	Headings and Document Hierarchy
	Paragraphs
	For People who Love Lists
	Commenting your Web Pages
	Using Comments to Hide Markup from Browsers Temporarily

	Symbols

	Diving into our Web Site
	The Homepage: the Starting Point for all Web Sites
	Setting a Title
	Welcoming New Visitors
	What’s it All About?
	Adding Structure
	Nesting Explained
	The Sectioned Page: all Divided Up

	Splitting Up the Page
	Linking Between our New Pages
	The blockquote (Who Said That?)
	The cite Element
	strong and em
	Taking a Break

	Summary

	Adding Some Style
	What is CSS?
	Inline Styles
	Adding Inline Styles
	The span Element

	Embedded Styles
	Jargon Break
	Why Embedded Styles are Better than Inline Styles

	External Style Sheets
	Why External Style Sheets are Better than Embedded Styles
	The Bad Old Days
	Happy Days! CSS Support is Here!

	Creating an External CSS File
	Linking CSS to a Web Page

	Starting to Build our Style Sheet
	Stylish Headings
	A Mixture of New Styles
	A New Look in a Flash!
	A Beginner’s Palette of Styling Options
	Recap: the Style Story so Far
	Changing the Emphasis

	Looking at Elements in Context
	Contextual Selectors
	Grouping Styles
	Which Rule Wins?
	Recapping our Progress
	Styling Links
	Link States

	Class Selectors
	Styling Partial Text Using span

	Summary

	Pimp my Site: Cool Stuff you can Add for Free
	Getting the Low-down on your Visitors
	Choosing a Statistics Service
	Registering an Account with StatCounter
	Adding the Statistics Code to your Web Pages
	What to Look for—a Summary


	A Search Tool for your Site
	Searching By Genre
	Adding a Blogroll to your Web Site
	Signing Up for a Blogroll
	Integrating the Blogroll with your Web Site

	Discussion Forums
	Summary

	What's Next?
	Index



